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1.1 INTERMEDIATE INTRODUCTION

COURSE DESCRIPTION

This course covers the concepts and functionality you need to know in order to use the InEight
Estimate software successfully. As a result, you will be able to build cost estimates and bid proposals
with precision and efficiency.

COURSE OBJECTIVES

As a result of this course, you will be able to use the InEight Estimate software to:

e Review and report on project information
¢ Integrate with MS Excel and scheduling software (MS Project or Oracle Primavera)

¢ Manage quotes and use additional time-saving tools

HOW TO USE THIS MANUAL

This training manual serves as the working guide during the E101 Essentials of Project Modeling and
Estimating instructor-led course. The first seven lessons of this document follow a natural progression
of putting an estimate together, from set up of a project to finalization of a bid. The remaining lessons
cover additional functionality that will help you build and review your project estimate more
effectively.

LESSONS

The following lessons are covered in this course:
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Course Lessons

Lesson Topic

Lesson8  Quote Management
Lesson9  Reporting

Lesson 10 Data Reproduction

Lesson 11 Excel Integration

Lesson 12 Schedule Integration
Lesson 13 Cash Flow

Lesson 14 InEight Estimate Calculators

Lesson 15 Cost ltem Assemblies

LESSON FORMAT

This manual is designed to be a “hands on” learning guide. As such, each lesson is organized into
sections:

T

Objectives  Specify what you will learn in each lesson.

Topics Organize the subject matter, with explanations of key concepts and terms.
Step by Walk you through the “mechanics” of how to perform specific functions in the
Steps software. For each step by step, you will use the Training Job that comes pre-

loaded in the InEight Estimate Estimating software.

Exercises Allow you to practice and reinforce what you learn. For each exercise, you will
use the Training Job that comes pre-loaded in the InEight Estimate Estimating

software.
Review Asks you questions to check what you have learned within each lesson.
CALL-OUTS

Throughout the document, you will also find important call-out banners.

TIP Tips are for important notes and information you want to remember.
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Jlelg= Notes are for critical information you need to know.

ONGOING USE

This manual is also designed to be a comprehensive reference guide you can use outside of the
classroom and revisit as needed. Each lesson is compartmentalized so that you can refer back to each
lesson as needed.
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LESSON 2 — REPORTING

LESSON DURATION: 30 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:

e Run reports from the Reports menu

e Create and run reports from register forms
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2.1 REPORTS MENU

InEight Estimate provides a lot of out of the box reports, referred to as “canned” or “system” reports,
that can help you review and analyze your estimate.

2.1.1 NON-MODAL REPORT DIALOG BOX

The Reports dialog is docked along with the other forms and registers. You can continue to work with
your estimate without being forced to close the Reports dialog box.

Cost Breakdown Structure (CBS) Register Reports - Resource Changes ©

Regorts Settings: | Defauit

Print | Detais | Layout | Header/Footer | Resource Changes Report -Resource(s) Added to Job Folder

Fa—
Description: Training Job - Maricopa County No. TM2924
i
Master Header [Footer Settings

If the report becomes undocked, the job code shows in the reports dialog box header.

2.1.2 ADJUSTABLE REPORTS

Most of the reports within InEight Estimate can be adjusted to output the specific data and reporting
format you need. Each report has its own set of output settings for configuring and formatting the
report.

All InEight Estimate adjustable reports are accessed from the Reports menu. You may even run the
same report multiple times and choose different output settings based on what you want to see or
who the intended audience is.
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For example, you may choose to run the CBS Details Report several times to satisfy different needs or
for different audiences, and include or exclude specific data depending on what you or the report
recipients want to see.

e For a group of estimators, you may want to run a CBS Details Report that shows all cost and
productivity data for a job

» For field personnel, you may want to run a CBS Details Report that shows no cost data, but all
production and resource data

¢ Finally, for executive management, you may want to run a CBS Details Report that shows
summary level information only

The following steps take you through a brief overview of the Reports menu and how you can access it.

STEP BY STEP — GETTING TO THE REPORTS MENU

1. Open the Training Job, and select Setup tab.

e You access the Reports menu by clicking on the Reports icon

TIP You can access the Reports menu from the Setup, Estimate, Quote, Price,
and Execution tabs.

2. Select Reports.

Estimate Quote Execution System

E ¢ BB a&asir 1 a B

#2 Equipment

Job Properties  Foundation  Pay Item &  Bid Wizard | Resource __ ) Resource Cost Item  Standard Reports
- Setup Data ~ Proposal Rates »  fRE Materials  pssemblies | Assemblies  Tables
Initialize Resources Assemblies Reports

3. Here you select the Report of your choice. For this example, select the first option, Job
Properties.
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.._-"' Foundation Setup Da

Print
= R
v & Resources
Resource Reqgister '::' By
Resource Changes )
Resource Rate Details
Resource Utilization p

Mlmmemt i | il i Eneme Y

Estimate Intermediate User Guide

¢ You will see a split screen with the reports available on the left side bar

¢ The side bar on the left of the Reports form contains a “tree” of all InEight Estimate

adjustable reports

v Reports
Settings: | Default

T |

Job Properties

Resource Changes

Resource Rate Details
Resource Utilization Printer: | Adobe PDF
Resource Utilization (Excel)

Resource Currency Comparison

Resource Assemblies

Cost Breakdown Structure
Quotes

Price Breakdown Structure (") Bxport to File
> @ Pay Item & Proposal Export Settings
» E Biling Rate Reports
» {E} Job Tracking

B L1

File:

Page 4 of 236

o i
= Foundation Setup Data Print | Details Layout | Header/Footer
v gm RESOUMCES
Resource Register (") Print to Printer

InEight Inc. | Release 24.7



Estimate Intermediate User Guide 2.1 Reports Menu

¢ On the right, when you select a report node on the left, note that it displays the Output
Settings on the right side of the form, from which the report settings can be adjusted and
the report can then be run

v Reports
[5] Job Properties
n*" Foundation Setup Data

v & Resources

Settings: | Default

Print | Details Layout | Header/Footer

Resource Register (O Print to Printer
Resource Changes
Resource Rate Details
Resource Utilization Printer: |Adobe PDF Change
Resource Utilization (Excel)
Resource Currency Comparison

'ﬁ' Resource Assemblies

i". Cost Breakdown Structure

=4 Quotes

== Price Breakdown Structure (O Export to File

[Z) Pay Item & Proposal

Billing Rate Reports

1’_:.} Job Tracking e
Estimate Comparison Report Format: |PDFFile Options
Audit
Job Register

4. Each report has a Print tab, a Layout tab and a Header/ Footer tab specific to that report.

Settings: | Default -

Details I Layout IIHeader,.’anterI

" Print tn Printer

e There are also Master Layout Settings and Master Header/Footer Settings located at the
bottom of the left-hand side bar tree. Here you can define settings that will apply to all
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reports

Estimate Comparison Report
Audit
Job Register
» .._-" Library Module

Custom Reports

Saved Views

Budget Exparts (®) Preview

Schedule Exports

Timesheet Exports

Format: |POF File Options

w W W W

Timesheet Imports

Master Layout Settings
Master Header Footer Settings

2.1.3 OUTPUT SETTINGS

This section provides a more detailed explanation of the output setting tabs.

2.1.3.1 REPORT PRINTING OPTIONS

The Print tab includes three options for printing output: Print to Printer, Export to File, and Preview.
Export file outputs include PDF, Excel, text, and more.

PRINT PREVIEW

The Reports print previews opens in its own tab in the Report Dialog. This lets you keep the report
open while continuing to use other parts of the application.

Page 6 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide

Feports - Resource Assembly Register @

Detads | Layout | HeaderFooter

Resource Assembly Uitizasen

g Rals Reper s

Esimate Comperson Repot
e
Job Regater
" Ubvary Modue
Cusmtiom Rinprse ts
b+ Saved e
Miriter Layeut Setwgs
Masier Header "ooier Setings

2.1 Reports Menu

2escurce Assamishy Regster SuTmary

Grader 145 - Opensted

Scrape61 - Coersted

Rascume
File Disseription
Staadans Assembly S
Staadars Assembly B

Standard Rszembhy B

Stmedard Aspembly F

Stsadanc Assembly B
macan: Assemby A
Sndan: Assembly o

Stwndand Assembiy

inbughs
Joh T Trainng Job
Descrption Marcopa County Rosdeay improvements
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e Paving Craw

orve Pipe crew

CPPEM Fipe Fitting Assembly (with materal)
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e
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You can also undock and float a report on a different form, or you can tile it side by side with another
register to view and compare them.
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PRINT PREVIEW RIBBON

The Print Preview menu is displayed on its own ribbon. Menu commands are shown in the ribbon as a
contextual Print Preview menu when navigating to Reports > Print > Preview > Run.

=) Training Job - Estimate:

Setup Estmate rice System Integratons Print Preview

Fie Sel
L i 3 ~ Dl:l * oo 7 @
o e D & 8 Py FF A aal e B o
Pt Quick Parameters | Scak  Orientabon  Sae Frd  Thumbnais Bockmerks Editng  Frst  Prevous  Next  Last _ MenyPages ZoomOut foom Zoomin | Page Color Watermark | Export  E-Mai
Frint - - - Feds = Page  Pege  Page Page | B - - - Ta- As-
Print Page Setup a Nawigation Zoom Page Background Export
Reports - CBS Summary  ©
Reports Print | Layout | HeaderfFooter  CostEreskdown Structure {CBS) Register Summary
(1 XbPropertes
" Foundation Setup Data
v & Resouces
Rassurce Regiter
Cost Breskdown Structure [CES) Reqister Summary
Respurce Changes InEight
Jab Code: Training Job
Resource Rate Detalls Description: Mearicopa County Roathwey Improvements
Resource Utizaton
. CBS . Optional Foreast Unitof
Resource Utization (Excel) Position Code Liesaigtion Code (7/0) Quantity Measur
Resource Curency Comparian
» & Resouce Assembies o8 000 e
v i Costareskdonn Stucture Prime Bond PRIMEBOND 100 Lump Sum
CBS Summary FPrice % Add-On PRICE % ADD-0 100 Lump Sum

2.1.3.2 APPLY CUSTOM LAYOUTS AND HEADERS/FOOTERS TO
REGISTER REPORTS

You can apply custom Layouts and header/footers to register based reports. Upon saving a view in any
register, select the option to save it as a corporate view and include the view in the reports dialog box.
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‘Cal Breahdiown Sirustus (CBS Anvle CBS viow |
gt

oot Trnng Joo
Descnpton:  Mancopa Couny Roacwsy Improvame:

s
Pesan Cade

When selecting a Saved View from the Reports register you can use the Print tab to customize the
printing preferences, use the Grid Options tab to change the font type/size, use the Layout tab to
modify the design style, and use the Header/Footer tab to insert a header and footer to your report.
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Reports - (BSviewl @

- Reports -~
[&] lob Properties

»

# Foundation Setup Data

Settings: | Previous -

I Print | Grid Options | Layout | Header/Footer
Resources

Resource Assemblies
Cost Breakdown Structure
CBS Summary
(BS Detais Fields
CBS Outline Report
Estmate Summary
CBS Currency Comparison
Quotes
Price Breakdown Structure
Pay Item & Proposal

Settings: - Default

Wi e

1
|
|

- Page Header
[Diate Printed]

#of Pages #

.
6

-
L]
i

Date Printed

L
i3 |

Standard Proposal Time Printed
Report Header (first page only)
DOT Proposal Usar Name e
Pay Item Summary ILI[COW&W Name]
Pay Item Currency Comparison Version Job Code: [Job Code]
Description: [Job Description]
Pay Item Price Breakdown Report Title

» [& Biling Rate Reports

Company Name
Estimate Comparison Report

Audit Image
Job Register
= Job Overview
» ¥ Library Modkie Report Footer (last page only)
Custom Reports Job Code [Job Crasted bry]
. Saved Views Job Description
- Cost Breakdown Striicture (CES) R
CBS view 1 Job Currency
Cost Source View - Less Unassi Job Status
My view
My WBS Viewd
Page Footer
My WBS View s
test 12345678

When you click on the Run button it will create a new register-style report. You can modify the layout
or header/footer directly in this register. You can also toggle between any of the four other tabs to
make modifications and see the changes on the saved view report.

Reports - (BS view 1 ©
v  Reports
] Job Properties
=+ Foundation Setup Data

Sattings: | Frevious -

Print | GridOptons | Layout | Header/Footer | CostBreakdown Structure (CBS) Register CBS view 1
£ Resources
» %% Resource Assembies

~ §@ CostBreakdown Structure

662022
CBS Summary
Cost Breakdosn Structure (CBS) Reqister CBS view 1
CBS Detalls InEsght
Job Code:  Training Job
CBS Outine Description: Maricopa County Roadway Improvements
Estmate Summary
CBS Currency Comparison CBS Optional
» & quots Position Code SR Code
» T= Price Breskdown Structure JoB
- Pay [tem &Proposal "
PR
5 P | Prime Bomn IMEBOND
Price % Add-On PRICE % ADD-ON

DOT Proposal
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2.1.3.3 REPORT LAYOUT SETTINGS

Many of the InEight Estimate adjustable reports include formatting options for the general layout of
the report, located under the Layout tab of the report’s output settings. Settings for the report include:
Orientation, Margins, Font, and Number Format.

Print | Details Layout | Header/Footer

Maragins
Settings: | Default (Letter) - Top: Heade
o 0.50 |4 0.25 |2
Orientation
(®) Portrait
() Landscape
Left: Right:
Paper Size: | Letter ~ 0.50 = 0,50 =
Bottom: Footer:
0.50 = 0.25 |=*
Fant Mumber Format
: Decimal Significant
Header Level 1:  Arial Marrow, 8, Bold Precisian s
Detail Level 1: Arial Marrow, 8, Regular Cost summary: ]2
Unit cost: - |:| 1
Header Level 2:  Arial Marrow, 8, Bold -
Quantity: i
Detail Level 2: Arial Marrow, 8, Regular
Percent: |:| 1

Usethousands separator
[ ] Use currency symbal

[] Show zero values as blank

Currency: | As-Entered =

2.1.3.4 REPORT HEADER/FOOTER SETTINGS

Many of the InEight Estimate adjustable reports include the option to define and insert headers and
footers into the report. You can add information to the left, middle, or right of the header and footer
sections of the report.
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1. Once you define headers and footers, you can save them for use on other reports.

2. You can add page, time, and date stamps as needed, as well as images (e.g., company logo).

3. You can also use brackets to have it “stamp” the report with the Job Code and Job Description.
4

. You can enter your own information as desired.

Settings: | Default - o

Print | Details Layout | Header/Footer

Settings: | Default -

Date Printed . Page Header

Time Printed

User Mame

Version

Report Title

Company Name Report Header (first page only)

Image Report Title] [Job Dezeription][Job Currency][Job Created by]
[Company Name]
Job Code: [Job Code]

Description: [Job Description] o

Job Owerview
Job Code
Job Description

Job Currency

COVER SHEET FIELDS AND JOB FOLDER TAGS

In addition to the existing job code and job description tags in Job Properties, you can use the Cover
Sheet fields and Job Folder tags for your headers and footers in all standard reports.

Additional tag values such as contract numbers, work order numbers, PO numbers, company logos, or
any other tag fields can also be included. These additions help you customize headers and footers to
give the recipients more transparency in the reports.
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INEIGHT@

e Mtk Couely - Fom Bk

A Header and Footer field menu exists to the left of the Page Header and Page Footer grid, for all
standard reports. This lets you choose which fields from Job Folder Tags and the Cover sheet to include

in your report.

Reports - Resource Register Q
Reparts
[5] JobProperties
= Foundstion Setup Data
5 Resources
Resource Regietsr
Resource Changes
Resource Rate Detals
Resource Utiization
Respurce Uitiization (Exce])
Resource Currency Comparison
» 4% Resource Assemblies
> @@ CostBreskdown Structure
» b Quotes
» £= Price Breskdown Structure
» B Pay Ttem 8 Proposdl
» [ Biling Rate Reports
Estimate Comparison Repart
Audit
Job Register
=+ Library Maduie
Custom Reports
» Saved Views
Master Layout Settings
Master Header Footer Settings

Print | Details

Layout

Header [Footer

Fields
Regort
» Job Overview
Job Tags
Tag 1
Tag 2
Tag3
Tag4
Tag 5
Tagé
Tag7
ag8
Tag9
Tag 10

Tog i1

Page Header

Report Header (first page only)
[Report Titie]
[Company Name]
Job Code:  [Job Code]
Description: [Job Description]

Report Footer (ast page anly)
[Corpmy Name]

Page Footar
[Pate Preg] [Tive P

Copygh D22 INEGA! he ARG Resarved

Fages oiPages 7

Run Close

You can customize your header and footer layout settings, save them, and re-use them in other

reports.

InEight Inc. | Release 24.7
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Settings: | Default

Print Details | Layout | Header/Footer

Settings: | Default

Custom

Default
Fields | 1 Save New Settings \ - O X
« Repc 2

Header /Footer w Logo Name: |Resource Rate Details option 1| |

P

| Header Footer w Logo - Lundy

p, InEight Header Footer w Logo
Cares

LibraryJobProperties

TV T L wov

: LibraryJobProperties2
. IREPOIT T1TIE]

2.1.3.5 REPORT DETAIL SETTINGS

Most reports have a Details tab with various options to configure what information is included on the
report.
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Settings: | Default -

Print | Details Layout Header fFooter

Show the below Pay item details Filter by currency:

Line Number Show the below Proposal header items

Pay Item Mumber (] Job Code [] Job City
PositionCode (] Job Description [] 3ab County
[] subtotals [ Bid Date [ 3ob state
[] Running Totals (] Bid Time [ 3ob Country

[] suspended Items (] JobLocation

Include Additional Proposal pages Term for Document
[] cover Sheet (®) Proposal/Bid

[] preferences Sheet () Tender

Unit Price predsion O custom |

(®) Truncate values based on decimal precision

(") Do nottruncate values (show decimal precision)

Mo Filter -

Certification Text: () Mane (®) Custom

Signature Block:
[] Include Signature Line

(] submitted By [] Include Title Line
[] Include Date Line

2.1.3.6 SAVE OUTPUT SETTINGS

Once you’ve configured your settings for the report, you can save them as a custom version of that

report.

InEight Inc. | Release 24.7
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- Reports &
[£] Job Properties
-*" Foundation Setup Data

im Print Cost Item Selection Details Layout Header Footer
v & FResources

Alternate Scenario:

Settings: | Estimate Summary - Foreman - BASE

Resource Register @ Print a contiguous range of cost items:

Resource Changes From: 51 -
Resource Rate Details

Resource Utilization To: 6.2 -

Resource Utilization (Excel)

Resource Currency Comparison () Select cost items to print from the register below:

» ":"E' Resource Assemblies
w i". Cost Breakdown Structure Find: | [Search For...] Saved
CBS Summary
CBS Details
CES Cutline
- Estimate Summary

F___| Estimate Summary - Foreman I
CBS Currency Comparison

The following steps walk you through configuring the settings and formatting for two different reports.

Page 16 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide 2.1 Reports Menu

STEP BY STEP — CONFIGURE REPORT OUTPUT SETTINGS (REPORT

1)

1. Open the Training Job and select Setup >Report>Resources.

B

Reports

Reports

- Reports
Job Properties
.._-" Foundation Setup Data

= R
¥ e ESources

I Resource Register I

Resource Changes
Resource Rate Details
Resource Utilization
Resource Utilization (Excel)

Resource Currency Comparison

2. Under Resources on the left side bar, select Resource Utilization.

] Reports - Resource Utilization

- Reparts
Job Properties
.._-"' Foundation Setup Data

Settings: | Default - |

- Print | Details Layout | Header/Footer
v gm PeESources

Resource Register () Print to Printer

Resource Changes e e
Resource Rate Details o

Resource Utilization Frinter: | WHDAZPrintServ,harddollar,localMain Office Change

Resource Utilization (Excel)
Resource Currency Comparison

3. On the Print tab there are three options. A best practice is to always set to Preview so you can
review before printing.
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Print Details Layout Header [Footer

() Print to Printer

Printer: | \WHDAZPrintServ.harddollar.localMain Office Change

() Export to File

File:

Format: |PDF File Options

(@) Preview E

4. On the Layout tab you can make adjustments based on your preferences.
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Print | Details Header [Footer o

Margins
Settings: | Default (Letter, Landscape) - Top: Header:
) ) 0.50 = 0.25 =
Orientation
() Portrait
(@) Landscape
Left: Right:
Paper Size: Letter w 0.50 = 0,50 =
Bottom: Footer:
0.50 = 0.25 |+
Font Mumber Format
: Decimal Significant
Header Level 1: | Arial Marrow, 8, Bold Predicion Figures
Detail Level 1: Arial Marrow, 8, Regular Cost summary: ] |1
Unit cost: - |:| 1
Header Level 2:  Arial Narrow, 8, Bold -
Quantity: [] 1
Detail Level 2: Arial Narrow, 8, Regular
Percent: |:| 1

Usethousands separator
[] Use currency symbal

[] show zero values as blank

Currency: As-Entered -

5. Move to the Header / Footer tab. Remove the default Report Title from the first page Header
only and enter Resource Utilization in the center Report Header box as a title that will appear on
the first page only.
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Print | Detalls | Layout | Header/Footer

Settings: | Default

5 | || tnsertField -

Page Header

Report Header (first page only) o

Resource Utilization
BTy 1

Job Code: [Job Code]
Description: [Job Description]

Report Footer (last page only)

6. Go to the Details tab, and you can see the details and options you can select to customize and
adjust the report.

7. For this navigation, you will not Filter by currency; leave the selection as No Filter.

8. Under Report Type, choose the first option, Resource Utilization Summary.

Settings: | Default o -

Print Layout | Header/Footer
Filter by currency: Mo Filter i -

Report Type

|@ Resource Utilization Summary Io

() Resource Utilization Summary with Employed Cost Items

¢ You can choose to select the Hide Zero quantity/cost Resources Employments Details box
if you prefer to have your printed report not show any resources that have a dollar value
of zero
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Details

[ ] Bxclude details and only show subtotals

|:| Show Currency Summary

Hide Zero quantity/cost Resource
ﬁD Employments

* You can choose if you want the report at a summary level, or if you want it to reference
your cost items when you are looking at a resource

¢ If you choose Resource Utilization Summary with Employed Cost Items, it adds CBS
position to the structure of the report

¢ You would select this if you wanted to see cost items and resources by the cost item

TIP The Details settings are “sticky” features, meaning they default to what was
selected the last time.

9. You can use grouping to group by different tags and user-defined fields. Most of them are
related to the Resource Rate Register, for example: Geographic Area, Organizational Category,
Wage Zone, etc. For this example, group by Resource Organizational Category.

10. Next, you can choose the resources you want to see. For this example, select the Labor and
Construction Equipment Resource Types.
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Group By Resource Type
[] insert page breaks between the outermy, Sups Labor @
IResource Organizational Category Q w I Construction Equipment \.‘__/

D Rented Construction Equipment

< no field selected = W
(] Installed Material
< no field selected = w ] Installed Equipment
< no field selected = W [ supelies
[] Unique
< no field selected = w
< no field selected = w

¢ For this example, you will not make any selections under Columns or Details

Columns Details
[] show Currency column Exclude details and only show subtotals
Show plug rate for non-hourly resources [] show Currency Summary

Show tax separately from plug rate for non-hourly resources

Show hours for non-haurly duration driven resources

¢ This is just one of many ways to organize and adjust your report.
11. Click Run to run the report.

e This report can be helpful for seeing your utilization hours, broken down by regular time
and overtime hours

12. Click the red X to close this page and open the Construction Equipment page.

13. Click the red X to close the Construction Equipment report.

STEP BY STEP — CONFIGURE REPORT OUTPUT SETTINGS (REPORT

2)

1. Open the Training Job and select Setup >Reports, then expand the Cost Breakdown Structure
node.
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By

Reports

Reports

- Reports
[&] Job Properties
..-" Foundation Setup Data

Resources

» % Resource Assemblies

vri-.: Cost Breakdown Structure I
CBS Summary

CBS Details
CBS Outline

by I

¥ Estimate Summary
CBS Currency Comparison
» =i Quotes
——

» = = Price Breakdown Structure

2. Under Cost Breakdown Structure on the left side bar, select Estimate Summary.

- Reports &
[E] Job Properties
.._-" Foundation Setup Data

-

& Resources
Resource Register
Resource Changes
Resource Rate Details
Resource Utilization
Resource Utillization (Excel)
Resource Currency Comparisor

» ';j: Resource Assemblies

w i.i Cost Breakdown Structure

CBS Summary

CBS Details

CBS Outline

¥ | Estimate Summary |

CBS Currency Comparison
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3. Along with the Print, Details, Layout, and Header / Footer tabs, there is an additional tab called
Cost Item Selection. Select this tab.

Settings: | Default ol Alternate Scenarii

Print Cost Item Selection Details Layout Header [Footer

4. The Cost Item Selection tab allows you to report on a selection of cost items:

e Print a contiguous range of cost items: Allows you to print a series of cost items in a row.
In this case, print just items: select 4.1 in the From field and 4.3.2 in the To field.

¢ Select cost items to print from the register below: Allows you to use column filters to
select the cost items to include in the report; leave this button unselected.

5. You can roll up your cost items to a certain CBS level for the report as well, depending on the
level of detail you need.

6. On the Details tab, select Days for Cost item production field 1, and Man-Hours / UM for Cost
item production field 2 (this report allows you to report on two production values).

7. Under Resource Types, uncheck all of the boxes except Labor, ConstructionEquipment, and
Installed Material.
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Print | CostItem Selection Details Layout = Header/Footer
; Resource Employments
Filter by currency: Mo Filter o
Print Resource Employment Details
General
Print resources in row number order
Group by: Mo Group w O
() Print resources in alphabetical order
[] Show Suspended Items ]
Print resource costs
Motes
Print hours forhourly resources
Awardee o
Wheln filtering, only include terminal cost items in Resource Types
tota

Fields o

[] &d-hoc Employments
Labor

Costitem production field 1:

Costitem production field 2:

Cost item text field:

Employment text field:

Days - Construction Equipment
[] Rented Construction Equipment
e - Installed Material
T - [] Installed Equipment
[] Supplies
Currency e [] unigue

[] Resource Assemblies

8. Leave the rest of the settings at their defaults, then select the Header / Footer tab.

9. In the center Page Footer field delete the existing text, then type Confidential —Internal Use

Only.

Page Footer

[Date Printed] [Time Printed]

Confidengal - intemal Use Only

tPage # ofPages 5]

10. To save the settings you’ve configured, click on the Settings drop-down arrow above the output

setting tabs.

InEight Inc. | Release 24.7
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Print Cost Item Selection Details Layout Header [Footer

Settings: | Default =

|@|E|In5ertFieldv l:}

11. Select the Save diskEI icon to save the new settings.

Settings: | Default

Page Header

12. Type Estimate Summary — Manager.

13. Click OK.
Save New Settings — L bt
Name: Estimate Summary - Manager]
] Cancel

* Notice that a custom version of the report now displays under Estimate Summary on the
Reports tree on the left
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FooAR TMeSML L Mg
w .'.i Cost Breakdown Structure
CBS Summary
CBS Details
CBS Outline
w Estimate Summary

Estimate Summary - Manager

CBS Currency Comparison
» (=i Mintes

2.1.4 HELPFUL REPORTS

2.1.4.7 PBS SUMMARY

Under the Price Breakdown Structure Report node, the PBS Summary Report gives a good overview of
how your price breaks down by cost category. This provides a high-level overview that is cost category
driven, providing information based on the total value of the project.

When selecting your settings on the Details tab, a best practice is to select and include:
¢ Cost Categories
¢ Markup Rate
e Percentage of Cost

This allows you to see your costs and markup broken out by cost category.
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¥ Reports
[&] Job Properties
Foundation Setup Data

Resources

I
"

'.i pie?

Resource Assemblies

Cost Breakdown Structure
Quotes

= Price Breakdown Structure

o W
| gk

g
[I

PBS Summary
PES By Cost Source
PBS Changes Register
» @ Pay Item & Proposal
» Billing Rate Reports
-I:’_E} Job Tracking
Budget / Contract Changes Re|
Budget Variance Report
Cost Details
Job Status
Time and Expenses

<

Payment Approval
Estimate Comparison Report
Audit
Job Register
» .._-" Library Module
Custom Reports

TIP

Settings: | Default -

Print | Details Layout | Header/Footer

Estimate Intermediate User Guide

v || fi i Target Price

Cost Categories

v [+]| % TargetProfit
| % Indirect Cost Markup
~| % Direct Cost Markup
« |+ | & Total Cost
w |+ | & Indirect Cost

w |+ | = Business Overhead

"

Unassigned Business Overhead
Indirect Cost Escalation
Direct Cost Escalation
Prime Bond
Price % Add-On
oo Jeb Financing
EE Indirect Cost Add-On
» || = Job Overhead
w || gm Direct Cost
+ | am Unassigned Direct Cost (Work Plan)
v | am Assigned Direct Cost (Work Plan)

ooooooooom
ooooooooom

SIS A SIS S ) S

2.1.5 ACCESS CONTROL

Markup Rate
Percentage of Cost

[ Markup Analysis

[] Price Status

[] Cost Source Analysis

[] resource Utilization Analysis

[] Minority Goal Attainment Analysis
[] SubcontractorAnalysis

[] vendorAnalysis

Run Close

You can also select to show markup rate and what percentage the markup is of your cost.

You can use the Access Control report to audit user permissions, command access, and various
restrictions without having to search through the Access Control register for this information.
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Reports - Access Control (Excel) ©

Command
Command
Command

Command

1

2

d

4

5  Command
6

7 |Command
8

w n®  Lbrary Module
Master Job Propertes

Command
9 Command

Master Foundation Setup Data 10 Command
» Master Resources 11 Command
Master Resource W 12 Command
Access Control (Excef) 13 Command
» Saved Views (Library) 14 Command
Custom Reparts 15 Command
R Saved Views 16 Command
- 17 Command

" »

18 Command
T RP—

File name  C:\Users'\Paul

'\Downloads\AccessControlExport. dsx.

File Home Insert Page Layout Formulas Data
c1 = fe | Ribbon Name
A B
[‘I’vm Category

Bond Cost Item Record
Bond Cost ltem Record
Cash Flow

Cash Flow

Cash Flow

Cash Flow

Cash Flow

Cash Flow

Cash Flow

Cash Flow

Column Captions
Column Captions
Column Captions
Connected Analytics

et A Amabien

Access Control (Excel) Expo *

Review

No Label v

View Automate Help

Paul Trippi

|lllhboﬂ MName

l1_mr

Actions > View > Default Data Blocks
N/A

Actions > Print > Page Setup

Actions > Print > Preview

Actions = Print > Print

Actions > Tools » Cash Flow Options
Actions > Tools > Display Settings
Actions > Tools > Worksheet

NfA

N/A

{Context Menu) > Change Caption...
(Context Menu) > Reset All Captions...
(Context Menu) > Reset Caption...
Actions > Tools > Aute-Update

2.1.6 STANDARD PROPOSAL

No
Ne
No

No

© Comments

No
Ne
No

No

719-R1  Account Administ

2.1 Reports Menu

15 Share ~

E F (=]

No
Ne
No

No

Close

Located under the Pay Item & Proposal report node, the Standard Proposal report can be used for
contractors required to submit a pricing proposal to a client. It lists all the pay items with the client

provided quantities and your final pricing. You can include subtotals (defined on the Pay Item &
Proposal Register), cover sheet information, and a signature block.

InEight Inc. | Release 24.7

Description: Training Job - Maricopa County No. TM2924

Proposa
Description
Subtetal Description
SITEWORK & ROADWAY
Mobilizatn
Clearing & Grubbing
Unclassified Excasm
Aggregate Base
Asphait Concrete Ha M Type A
WATER & SEMR
36 Inch RCP Culvert Css Il

10 Inch PVC Force Main (SDR21)

24 Inch PVC Gravity Sewer (SDR35)

Proposal
ACME Company

Job Code: Training Job
Position Code Line No. Pay Item No.
1 22 200
11 10 8410100
12 20 2010102
13 30 2020183
14 40 3035912
13 X0 3034263
2 18 400
2 80 13(B) 0464
22 70 8000220
23 50 8000330
24 3 2000400

4 Foot Diameter Manhde

Quantty Unit of Measure

1.00 Lump Sum
10.00 Ace
50,000.00 Cubic Yad

40,000.00 Ton

38,000.00 Ton

1,000.00 Linear Feet
12,000.00 Linear Fest
3,000.00 Linear Fest

16.00 Each

Unit Price

395,600

5,900.00

2.3

4245

97 45
2%
2450

4,800.00

Total Price

3,402,70000
395,600.00
59,000.00
275,000.00
1,060,00000
1,613,10000
718,550.00
97,450.00
354,000.00
193,500.00

73,600.00
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2.1.7 CBS DETAILS

Under the Cost Breakdown Structure report node, the CBS Details report can be a helpful report for bid
review. On the Details tab you can include or not include any of the information contained in the CBS
Register, including cost items with production, costs by category, shift arrangements, resources, and
notes.

Cost Breakdown Structure Details
INEIGHT - PAUL TRIPRI
Job Code:  Training Job
Description: Training Job - Maricopa County No. TM2924
From Costltem: 1 ToCostitem: 0.1
| Costiem Unitand Total Cosia by Categary
| c88 Pasifon cost Farscast D) X _ )
| code O Descripon e ‘Quanty U unitCast Totatcost Labor Owned Equipment Rented Equipment izt Suppies  Subconirast
1 vioziizzion B 100 Lump Sum e 190951 2051 £ [ a0 a0 am
a0 528000 0o am am am
Wotss: Thes a® 10 kads. Figue Mot in anly. TNe next joo will pick up e hot out.
A 3500 Contingancy AlIGUENGE I c35e S pEmts SrE fEquied
PayHem sewignment 5410100 Mosi zation)]
Dsfautt Fropartss: AccountCods CostCurs Tt T2 1393 T4 T35
1020 Linesr Esimane 1 Foatusy
opfanalCode Fnass Cods ownera . QuateGroup Quanty Drver Minority Alow WC Qvarride
5410100 100 Fay 10000%
Dstzutt Py Rules: Wage Scaie 1 Wage Scaie 2 Wage Seae 3 Rsaurcs Wark Hra Resaurcs Fay Hra Dsfautt snikt wark Hraisnit snikaiDay Dayaiiosk
10000 am am am a0 Aanangsmants a0 10 500
Froducsan
Durzton Dayz snifs Hours Man-Hours Equip-Hours cost! Dursian Costlay Costsnit CastHour CostManr CostEquipH
1020 1000 2o 2w 18000 118285 118085 14587 14587 a3
)/ Durssion unzy usnil UsHour UMz -H UMEquipHr Durzton 1UM DayUM Snifaum Hours/um MsnHEUM Equip HraiUm
ato L2 am aat am 1000 1000 000 000 16000
Resauros Cods Dseeripsion Quansly  PayHours UM untcost  Tomicost nitand Total Casta by Categary
Assemuly Cost Driver ApeountCods T T2 T3 "Warkers Cama % K
>

2.1.8 AUDIT

Under the Job Tracking node, the Audit Report is a very important report to run during estimate review
to make sure you didn’t leave anything out of the estimate. It checks for a number of potential errors
in the estimate, including:

e Zero Price Pay Items
e Zero-value cost items
e Pay items without Cost Items assigned

e Resources with a quantity of zero

Page 30 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide Exercise 2.1 — Run a System Report

EXERCISE 2.1 — RUN A SYSTEM REPORT

You can adjust InEight Estimate system reports to report on the particular information you need.
Complete the following steps to configure and run the Pay Item Summary report, using the Training
Job:

1. From the Reports window, expand the Pay Item & Proposal report node.

2. On the Reports tree, select Pay ltem Summary.

3. On the Details tab, select a Pay Item Range from 303 4263 — 800 0220.

4. Choose to Include Assigned Cost Items.

5. Show Costs As: Unit.

6. Include Profit Analysis columns and Include Pay Item Price columns

7. Run the report.

You should end up with the following results

ABC Contractors
Job Code: Training Job
scription: Training Job - Maricopa County No. TM2924

From Hem: 303 4263 To Hem: 500 0220
Faycasitem o vmcowgomgey
Azmgnad Jemad Ranizd
Code Descripfion Quanfity UR Direct Coat Labor  Equipmsni  Equipmani Watariala Supplisa Subsoniract Fess  allowanca
03 4263 Azpnalt Concmis HOT MIX Type A 500000 Ton 4252 n 643 m e B i i 15 k)
5§ Asphalt Concrede Hol Mix Type A 35,00000 Ton 161943035 an 543 00 3150 2d 2d 155 Q2d
5.1 Fumish & Hadl Hot Mix 35,000.00 Ton 149238218 143 47T falis} 3150 am am 158 k]
52 Irsiall HotMix Type A 35,00000 Ton 127,4517 188 185 00 [allus] 2d 2d a2d Q2d
413E) 454 36 Inch RCP Cuivert Class. 1,00000 Linear Feet Ba42 1980 1345 0as sz Qo Qo 13 0
& 35 Inch RCP Culvert Olass 1,000.00 Linear Fest 8541679 188 1345 0495 3082 2d 2d 18 Q2d
6.1 Fumish RCF Makeadls 1,000.00 Linear Fest 3236138 am and 00 3082 2d 2d 154 Q2d
62 Excavar RCP Tenchn 1,515.00 Cubic Yamd 818320 455 M 0 0o Qo Qo 0 0
6.3 Isiall RCP Pipe 1,000.00 Linear Fest 11,7354 545 L] 00 [allus] 2d 2d a2d Q2d
64 Eackdll RCF Fipe 1,550.00 Cubic Yam 14,135.32 &3 48 0495 [allus] 2d 2d Q25 Q2d
SUETOTAL: SITEWORK & ROADWVAY 1525247 14 13753400 257 78536 92890 122703 Qo Qo &1437.38 0
500 0220 10 Inch PVC Fome Man [SDR21) 12,000.00 Uiner Fest 25 45 472 00 1280 2d 2d Q83 Q2d
7 10nch PVC Fome kan (SDR21) 1200000 Linear Fest 27018357 45 472 0 1280 Qo Qo 083 0
7.1 Fumizh 10 Inch PVC kaenals 12,000.00 UnasrFest 155,760 am M m 1280 i i Q3 k)
7.2 Excavaiedreigl-Eackdll 10inch PV 12,000.00 Uiner Fest 11140557 45 472 00 [allus] 2d 2d a2d Q2d
Exiendsd Totsls By Caisqory 185601051 19259977 31445616 9Ee0  1,579,020.31 00 00 58,997 35 000
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Congratulations, you have completed this exercise!
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2.2 REGISTER REPORTS

At any time, you can print a report of the data in the currently displayed register using the Print or
Preview option available from the Actions tab for the register you are in.

Setup Estimate Quote Price Execution
E Print Iﬂ Mew % Copy Split Indent Link Field
'%‘ Preview Delete Paste Split by Cost Type Cutdent Unlink Fie
I._':? Expart to Excel Cut Fill Down t} Toggle Suspended
Print Edit Workbook

Cost Breakdown Structure (CBS) Register &

CB5 Tree (Filter Mode) = Drag columns here to group

The data that prints is the data currently displayed on the register form. The report will print whatever
columns are displayed on the register; if you have customized the display in the register, the report
prints that data. In other words, register reports are entirely customizable.

By creating Saved Views, you can report the data on a register form in several different variations.

The following step by step example will walk you through creating a custom register report on resource
utilization and saving it as a Saved View.
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STEP BY STEP — CREATE A REGISTER REPORT

1. Open the Training Job and select Setup tab, then select the Resource Rates drop-down list.

Estimate Quote Price Execution System
¥ Al
B 2 B ™ & 5 1k a
. - . 2
Job Properties  Foundation  Pay Item &  Bid Wizard | Resources .= _ Resource Cost Ite
- SetupData =  Proposal Rates I Materials  Agsemblies | Assembli
Initialize 2. Labor Ass

#0  Construction Equipment

Jo.  Rented Construction Equipment
&= Installed Materials

4y Installed Equipment
A€  Supplies

G Unique

2. From the drop-down list, select Labor.

3. From your Saved Views drop down menu on the Resource Rate Register, select the Print View
for Summary view.
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Saved views: | Previous View HD

Previous Yiew

Acc... 2 Print View for Breakdown

Code

¢ Utllized Resource View

4. Notice this view includes utilization hours

5. Right-click on a column header and select Column Chooser.
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Maint. Organizational Geogra...
Man-H... Category Areg

- 21 Sort Ascending

[ 2| Sort Descending

C Clear All Serting

[ :l: Group By This Celumn

C Hide This Column
Remowve All Columns

Go To Column... (Ctrl+3)

[
Column Chooser

0 s+ Best Fit

[ ]

6. From the Customization window, drag-and-drop the Minority Percent, Unique Sales Tax, (Scale
2), and Maint. Man-Hour Factor columns into the register.

7. Close the Customize window.

8. Sort the Utilization Count column by clicking on the column header twice so that you see the
bars descending.
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¢ This sorts your items so the most utilized resources are at the top

Eesnurce Utilization - Maint. Organizational
Code Count Man-H... Cateqgory

+ LL2 8,946.59 0.00 Laborer

+ Lo2 4,734.02 0.00  Operator

+ LT1 3,611.05 0.00  Truck Driver - Team...
+ LO1 1,640.00 0.00  Operator

+ LO4 1,484.63 0.00  Operator

+ LC2 1,188.73 0.00  Carpenter

+ LO3 889,33 0.00  Operator

+ LSSUPT a00.00 0.00  Supervision

+ L5SS5EC 00,00 0.00  Superwvision

+ LSPE 300,00 0.00  Supervision

+ LL3 721.33 0.00 Laborer

+ LIW1 594,37 0.00 Iron Worker

9. Click on the Saved Views drop-down menu and select the Save disc B icon to save the view.
10. Name the view Labor Utilization View, and then click OK to save the customized view.

11. From the Actions menu, select Preview to review the report before printing.
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Labor Register

INEIGHT - PAUL TRIPPI
E101 - Training Job KL-—-Sample Training Job

e Vs i e | MIOB s

Factor

L1 OperatorClass 1 680.00 | Hour 0.00 0.00 0.00
LL2 Labarer 590.00 | Hour 0.00 0.00 0.00
.LSSUF'T Project Superintendent 560.00 | Hour 0.00 0.00 0.00
.LSSEC Secretary 560.00 | Hour 0.00 0.00 0.00
.L03 OperatorClass 3 220,00 | Hour 0.00 0.00 0.00
LLS Labor Foreman 200,00 | Hour 0.00 0.00 0.00
.LCH Operator Foreman 110.00 | Hour 0.00 0.00 0.00
.LT1 Teamster 100.00 | Hour 0.00 0.00 0.00

2.2.1 REGISTER REPORT OUTPUT SETTINGS

Within the Preview for a register report, there are several options to choose from to configure the
output of your report.

2.2.1.1 PAGE SETUP

While in the Preview mode, selecting File > Page Setup provides setup options for the page format:

* Page Size (legal, letter, etc.)

Paper Width & Height

Orientation (portrait or landscape)

Page Margins (left, right, top, bottom)

2.2.1.2 EXPORTING TO DOCUMENT

Using the Export function allows you to identify a Print range, Image quality, Password Security, and
more. Selecting File > Export Document prints an Adobe Acrobat (*.pdf) report.
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EXERCISE 2.2 - CREATEACU M REGISTER REPORT

You can configure the columns in your registers for reporting and run your own custom reports.
Complete the following steps to configure and run a report from the CBS Register, using the Training
Job:

1. Select Estimate>Cost Breakdown Structure (CBS).

2. Under Saved Views, Select CBS Simple View.

3. Hide the Optional Code column.

4. Add back in the Man-Hours (Total) and Man-Hours / UM columns.

5. Now add back in the Labor Total Cost, Owned Equipment Total Cost, and Materials
Total Cost categories for reviewing the estimate.

6. Save the View (create your own name for the view).

7. Select Preview to view the report.

You should end up with the following results

Cost Breakdown Structure (CBS) Register
ABC Contracting Inc
Training Job—Training Job - Maricopa County No. TM2524

Posiéi:EnsCode Description {Tj'girqalfﬁtt\ty ML‘L";ESL Ma(yr—oHt:ll;rs Unit Cost Labor Total Cost gﬁ;gﬂﬁ; btal iﬂ:lljw:i:znan-md Equipment Total Man[]H;ursf Materials Total Cost Currency
JoB 20.00 | Mile 27,993.15 §306,883.14 S907,442.76| $§6,137,662.81 2843844 §1,062,750.40 £3,393,700.70 | U.5. Dollar
Prime Bond 1.00| Lump Sum $48,686.14 £0.00 $48,686.14 £0.00 $0.00 | U.5.Dollar
Price % Add-On 1.00 | Lump Sum $308,475.27 $0.00 $309,475.27 50.00 $0.00 | U.S.Dollar
Job Financing 1.00 | Lump Sum §0.00 $0.00 $0.00 $0.00 §0.00 | U5, Dollar
Indirect Cost Escalation 1.00 | Lump Sum §0.00 §0.00 50,00 50,00 £0.00 | U5, Dollar
Direct Cost Escalation 1.00| Lump Sum §11,026.79 £12,026.79 §11,026.79 £0.00 (51,000.00) | U.S.Dollar
Indirect Cost Add-On 1.00 | Lump Sum $0.00 $0.00 50.00 50.00 50.00 | U.S. Dollar
JobManagement & Equipment 1.00| Lump Sum 2,400.00 $157,096.28 $91,176.28 $157,096.28 2,400.00 $65,920.00 2,400.00 $0.00| U.5. Dollar
General Expense 1.00| Lump Sum 0.00 £4,200.00 §0.00 £4,200.00 0.00 £0.00 0.00 £0.00| U.5. Dollar
Direct Cost Add-On 1.00| Lump Sum $109,544.08 §15,676.56 $109,544.08 §19,450.89 $66,546.70 | U.5. Dollar
Mobilization 1.00 | Lump Sum 0.00 $75,000.00 $50,000.00 §75,000.00 0.00 $0.00 0.00 §25,000.00 | U.S. Dollar
Clearing & Grubbing 10.00 | Acre 0.00 £0.00 £0.00 £0.00 0.00 £0.00 0.00 €0.00| U.5. Dollar
Unclassified Excavation 50,000.00 | CubicYard 3,964.29 §9.95 £110,457.00 $497,466.56 4,11548 §302,999.56 0.08 $0.00 | U.5.Dollar
3.1 Excavation, scrapers 50,000.00 | Cubic Yard 1,250.00 §3.00 £33,170.48 §149,922.88 1,325.00 §116,752.40 0.03 $0.00 | U.5.Dollar

Congratulations, you have completed this exercise!
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LESSON 2 REVIEW

1. The Report gives a good overview of how your price breakdowns by cost
category.

a. Estimate Summary
b. PBS Summary
C. Audit

2. The Report is a very important report to run during bid review to make sure
you didn’t leave anything out of the estimate.

a. CBS Details
b. Audit

C. Pay Iltem Summary

3. A best practice is to always set your Print output setting to Preview so you can review
before printing.

a. True

b. False

LESSON 2 SUMMARY

As a result of this lesson, you can:
e Run reports from the Report menu

e Create and run reports from register forms
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ESTIMATE

LESSON 3 — DATA
REPRODUCTION

LESSON DURATION: 20 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
e Create a job from an existing job or template
¢ Create a template
e Reproduce estimate data using the Bid Wizard
* Reproduce estimate data using copy/paste
e Add cost items to a job using the CBS Bid Wizard

e Utilize the Snapshot function

InEight Inc. | Release 24.7
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3.1 COPY AN EXISTING JOB

As you build an estimate, you may want to reuse pay items, cost items, or resources from a previous
estimate. When you plan to reuse the majority of content within a job, you can simply make a copy of
the existing job.

Using the Create a new Job from... Existing Job option on the Backstage View creates an exact replica
of the existing job, including the job’s properties, pay items, cost items, and resources.

The following Step by Step walks you through how to make a copy of an existing job.

STEP BY STEP — COPY AN EXISTING JOB

1. Click the File tab on the Estimate landing page.

Library - Estimate

Estimate Execution System Integrations Actions

B » 28 @ 2.2 49 a8 & B

23 Equipment
JobPropertes  Foundation  Address  Trench  ShiftRate | Resource Resource | Costltem  Standard User Roles  Access Reports
- SetupData ~  Book  Calculstor Calculstor | Rates ~ S8 Materials  Assemblies | Assemblies  Tables Contral

Master Initialization Master Resources Master Assemblies Roles and Permissions Reports
2. From the left side panel, select New, then select Existing Job.
Library - Estimate

Create a new Job from...

B &S ;EmE P EE

Soatch Template Existing Job Bid Wizard Archive Snapshot Primavera US Cost

Templates

Snapshots

Archive | Restore

Settings

Exit

3. The Job Register displays a list of your existing projects; select the Training Job and click OK.
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4. On the New Job dialog, click the ellipses and select a Core Project.
In the Code field, type Infra Job Copy with your initials.

6. To copy the cost details from the existing job to the new job, verify that the Copy Cost Details
checkbox is selected

» If you wanted to copy just the cost item structure without cost details, you would uncheck
the box.

7. Uncheck the check for copying the PBS Changes Log, Copy Quotes and Auto-Update Job in
Connected Analytics.

8. Click OK to create the new job.

Hew Job from "190002-1'

Core Project: ™ | 104257

Code: * |InfraJob Copy

Description: Infra Job Copy

Copy Cost Details
[ ] Copy PBS Changes Log

[ ] Copy Quotes

[ ] Auto-Update Job in Connected Analytics

oK, Cancel

The new job opens with the Job Properties form active, so you can begin to modify the new job
as needed. If you look through the tabs on the Job Properties form, you will find that it looks
exactly like the job from which it was copied. Other forms, such as the Pay Item & Proposal
Register and the CBS Register, also look the same in both jobs until you make modifications in
one job or the other.
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This is a very easy method for creating a new job, and it is a good choice if you want to copy an
entire job. However, if you want to pick and choose which parts of a job to duplicate, the Bid
Wizard is a better choice.

3.2 TEMPLATES

Job Templates provide you the ability to maintain a list of template jobs that can be used to create new
jobs. As your company grows and increases the number of projects, the need to standardize the
estimating process increases to ensure consistency and reduce the chance of information being
overlooked.

In InEight Estimate you can create job folders and store them in a separate register as templates. This
allows you to store cost items in master templates separate from the jobs in your Job Register.

You can create templates from scratch or from existing job folders. The following steps walk you
through how to create a new template from an existing job folder.

STEP BY STEP — CREATE A TEMPLATE

1. Click the File tab on the Estimate landing page.
2. From the left side panel, select Templates.

3. Under Templates, select the Template Register.

Templates

Template Reqister

Close All Jobs
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4. From the Actions tab, select Create Template from Job.

E!'l Print e Mew

"%. Preview Delete

& Export to Excel Load
Print Edit

Execution

Create Template
from Job

Tools

* The Job Register opens for you to select the source job for the template

¢ Assume that you want to make a template from your E101 Training Job

5. Select the E101 Training Job with your initials, then click OK.

Salact the sowrce jobs:

Code

= NEuD1 - Traning Job KL 1
Trarirsg Job

Find: | [Search For.,.] Saved views: | Previoos view -

Description Status Schedule Locaton (=]
Sample Traning Job Bdding Microsoft Prof . S0th Stiest & Shes Sootis.
Traring Job - Marcopa Courty Mo, THEZ Beeing Microsoft Proj [-30 MP 100 to BP Phoerin

3.2 Templates

Al 2 You cannot create templates from jobs that are published to Job Tracking.

InEight Inc. | Release 24.7
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¢ The New Template From Job 'Training Job' with your initials prompt appears.

Mew Template from Job 'Training Job'

Organization: 5100000 - PES Inc

Code: ™* |

Copy Cost Details
Copy PBS Changes Log

Copy Quotes

QK Cancel

6. Click the ellipsis to the right of the Organization field.

Organization: 5100000 -PKS Inc

Code: *

Description:

oK Cancel

The Organization Register Library opens.
In the Organization Register Library, select an organization and then click OK.
8. Inthe Code field, type Small Project Template[your initials].

¢ Leave Copy Cost Details and Copy PBS Changes Log checked
9. Click OK.
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e The new template is created and opens to the Job Properties form

3.2 Templates

¢ You can add the description in addition to the code for any new job you are creating from
a template. This description is later added to the Overview tab of the new job on the Job

Properties form

Job Properties ©

Overview Security

Code: |099KL

Caover Sheet

Cost Basis Minarity Setup

Fuel Cost | Job Tracking

Description:

Sample Training Job h

e Back in the Templates Register, you can see the new template created

Estimate
& print [ open
*:q Preview e e

& Export toExcel | ) Delete

Template Register ©

Sraq columns here to oroue
3g columns here to group

Code

Print Edit

Execution

Create Template
from Job

Tools

Status Schedule

Bidding Micrasoft Praj

» Similar to copying an existing job, you can create a new job from a template
from the New menu in the Backstage View.

Create a new Job from...

Saatch Template

Existing Job Bid Wizard

* You can also create a new job from a template from the New menu in the Bid

Wizard.
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Create a new Job from...

10. Select Add to existing job

11. From Select Source Job, click the dropdown arrow
12. Click Next

13. Select a job that is shown as having a Template

14. Click OK

2] x

v saved views: | Previous View

Step 1: What would you like to do?

EN Ie Template InUse Status Schedue Location

O create anewjob:
v ro)... S0th Street &

o

New Code:
S0th Street &

Description:

@ dd to existing job: [Select Source Job] -
1 i Next > Cancel

s0th Street &

roj... 1410 MP 100 tt

3.2.1 OBS FILTER TREE

The Template register's organization tree filter shows the templates assigned to a selected

organization.

Page 48 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide 3.2 Templates

Library - Estimate

Integrations

S Print O new Close Iil;—_‘ E
A Preview Delete
Create Template | Organization
@ Export to Excel Load from Job Tree Filter
Print Edit Tools View -
Template Register © / -
Organization % Yros cotmes e o raup Soved views: ¥l
(== Cade = InUse Description Status Schedule Location City Caunty State Country
MLQ-SUPPORTCASEL ] Class3  MicosoftProj.
MLQ-SUPPORTCASE1-1 (| Perf SQL Bulk Copy  Class 3 Microsoft Proj
11 O Bidding Microsoft Proj.
T1£En [l at Energy Bidding Microsoft Proj... | 1-10 MP 100 to MP. phoenix | Maricops @Geo_ United Stat.
THInf ] Bidding MicrosoftProj.. -10MP 100toMP .. Phosmx | Maricopa  ®Geo_.. United Stat.
T2-0andG (| Bidding Microsoft Proj. Farah Afghanistan
> SB2000 - Energy
> 5B3000 - Infrastructure
» 5B4000 - Mining
> SBS5000 - Other
> 5B60DD - Home Office
z [
6
b K] >

Close Cancel

Just like the job register, the list of templates is filtered based on the selected organization. The
primary difference between the OBS tree filter in the job and template registers is that estimates are
associated with projects in the job register, and projects belong to an organization. In the template
register, templates belong to an organization.
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Organization x Drag columng here to group
Code In Use Drescri
at Energy

"

tii
Ti€n
T2-DandG

3.2.2 ARCHIVE AND RESTORE TEMPLATES

The templates feature gives you the ability to archive and restore templates, enabling templates to
become portable. You can move templates between different environments. You can also backup the
templates similarly to the Jobs Archive and Restore function.

STEP BY STEP — ARCHIVE AND RESTORE A TEMPLATE

1. Click File to open the Backstage View.
2. Select Archive / Restore.

e Several options appear for archiving and restoring your jobs, templates, and library
3. Select Archive Template.

¢ The Template Register appears

4. Select the Small Project Template [your initials] template you previously made, then click OK.
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5. When prompted to include attachments, click Yes.
¢ The Save As window appears
6. Browse to where you want to save the job, then click Save.

7. Select Restore Template from the Archive / Restore page of the Backstage View to begin
restoring the template.

8. Browse to the archived template and select it.
9. Click Open.
¢ If the template already exists, a prompt will appear asking if you want to overwrite it
¢ To overwrite it, select Yes

* If you select No, you will be prompted to save it under a new Template Code

You can assign templates to specific organizational nodes in the OBS, grant permissions, and control
user access for templates.
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Estimate Intermediate User Guide

Drag columns here to group

L
g

Organization Register - Library

Cancel |

For example, you can assign a template to a specific node level in the OBS that is specific to Power
Delivery. The OBS node structure assignment is useful for assigning estimators access to designated
templates as determined by an Estimate administrator.
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Drag columns here to group
Mame Description

Status Schedula Location City
~ Drganizstion: | SF2042 - Power Delivery l
? Code: * [Power Delivery SE

Description: Underground power utiity instal 5 distmct
I 0K | Cancel | 1
Bidding Micrasoft Proi.. 1
Bidding Microsoft Proj... LRI UL ]

Estimators with the appropriate Estimate/template permissions in Suite Administration > Roles and

Permissions > Master Data Libraries > Estimate, can use the templates in which they are assigned to in

their designated OBS node.
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{2t  Suite administration / Roles and permissions

Roles and permissions >  Edit role

Estimate
[#¥ Edit estimate library

Use templates
(*) Add template
[=*) Edit template

(x) Delete template
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STEP BY STEP — ASSIGN TEMPLATE TO OBS

1. Open the Training Job, then select the Templates.

InEi
ES

Version: 23.10
Environment: 23.10

Close All Jobs Open a recent Job )

Jobs

Library ﬁ

Templates 53-Training Job .
5100000 - Test_Bu E::E::m

cniuienxei xeuxb...

Snapshots

Archive [ Restore

Create a new Job f

Settings

(1
- -

2. Select Template Register.
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Templates

=]

Template Reagister

Close All Jobs

Jobs

Library

Templates

3. Select New.
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5 2o

| Ry Preview Delete
&) Export to Excel Load
| Print Edit

Template Register ©

Create Template
from Job

Tools

Drag columns here to group
Code

| = | 1100T1

555

555-666

Ans

| AL Proj
AL Template from Texas DOT
AL Template X

' Test Template - Today
lest template - Today 2

IL Template from DOT Job

Code: * |

Organization:

S100000 - PKS Inc

Description:

Tllinois

4. Click the ellipsis to the right of the Organization field.

Organization:

5100000 - PES Inc

Cancel

Code: *

Description:

oK

Cancel

The Organization Register Library opens.

5. In the Organization Register Library, select SF2090-Renewables, and then click OK.
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Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
Bidding
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Organization Register - Library

System Integrations

Iil:" Drag columns here to group x [Enter text to search.. 1[~1[~][%%

Close
Crezﬂ;mgafe Name Description
- - = sEAm posermgnesng | PonerEngnens .
. wovGeed Gl
. Smm-PaeGeN Poweny
TS o -
. saGesewes  Gensewces
Organization: ‘ 5100000 - PKS Inc L _
Bescription: L smeow o
L smetder e
e
Renswaties
‘ . sun-Fodabewse  Foodabeveage
& L i | S0s-CobnCabre  CabonCopre
& O | ae L - takeg B0, KEGMarketng &Progossls
L] |8snob mt ke B M- o Sharsdser. [ Poer sharedsevces
O |1 Pomer Shared Services|S Services
e R e e————
] rewter T Bl
] new temp ——

The new template will be set at the SF2090-Renewables node in the OBS. Users assigned to the
SF2090-Renewables level or above in the OBS will be permitted to use this template when
creating estimates.

6. The next step will be to create a new template code and a description to complete the new
template creation process.

Template Register ©

Drag columns here to group Mews Tenminir
s Organization: | SF2090 - Renewables - | | :

= 1109-T1 Code: * || | E
555 E
555-666 ' Description: .E
AAA E
AL Proj not atroot org E
AL Template from Texas DOT E
AL Template X | | 0K | Cancel .E
Ammibdeme Tt Tommmclm b ‘r..l...‘ Y Y T | K | T .:

What's next: After the template is created you can start to create estimates using a
template.
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3.3 BID WIZARD

InEight Estimate’s Bid Wizard is a powerful tool that can help automate the process of setting up
estimates by copying information that already exists in other InEight Estimate job folders. The Bid
Wizard can be used to create new projects, create a new job from an existing template, or to add to
projects that are already underway.

Rather than copying every part of an existing job, the Bid Wizard gives you more flexibility and control
over which parts of a job you want to duplicate, e.g., pay items or cost items or both.

In most cases you will be copying cost items, but if you have a project with pay items that are
commonly used, you can copy them into a new project. If you select pay items, you will be able to
select cost items as well.

The following Step by Step walks you through how you can use the Bid Wizard to create a new job by
importing pay items and their associated costs from an existing job.

STEP BY STEP — USE THE BID WIZARD

1. To open the Bid Wizard, click the File tab on the Estimate landing page.

Library - Estimate

Estimate Execution System Integrations Actions

e
l I Ya : = e .. Labor | LA
= I EH] HH] [ ] 22 ﬂ
#3 Equipment
Job Propertes  Foundation  Address  Trench ShiftRate | Resource Resource CostItem Standard User Roles  Access Reports

SetupData ~  Book  Calculator Calculator | Rates - FRf Materials  Assemblies | Assemblies  Tables Control

Master Initialization Master Resources Master Assemblies Roles and Permissions Reports

2. From the left side panel, select New, then select Bid Wizard.
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Library - Estimate

Create a new Job from...

O E O S EF e EE

Seratch Template Existing Job Bid Wizard Archive Snapshot

US Cost

Close All Jobs

Jobs

Templates

Snapshots

Archive / Restore

settings

Exit

¢ The Bid Wizard — Step 1 dialog displays

@j x
Step 1: What would you like to do?

(®) Create a new job:

Description: |

(O Add to existing job: [Select Source Job]

Next = Cancel

TIP Notice that you can either create a new project or add to an existing project.

3. Type E101 Bid Wizard (with your initials) in the New Code field.
4. Type Bid Wizard Example in the Description field.
9. Click the Next button.

¢ The Bid Wizard — Step 2 dialog displays

6. Choose Select cost items and click Next.
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@ Bid Wizard
Step 2 of 5: What should fill the new Job?

O Select pay items copy their corresponding cost items.

(®) Select cost items from asource Jobfolder.

from a source Job felder (or import them from an electronic file), and optionally,

< Back Cancel

e The Bid Wizard — Step 3 of 4 dialog displays

3.3 Bid Wizard

¢ You use this step to indicate which source you want to pull your setup data from (the

library or your source job)

7. For all selections, select Copy from source job.

8. Check the Also copy all non-utilized resources checkbox.

9. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy Markup

box is automatically selected.
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Step 3 of 4: What would you like to do?

Job Properties
Job Properties contains the Overview, Security,
(C) Copy from MasterJob Properties Cover Sheet, Cost Basis, Minority Setup and Fuel
Cost for the job.

|
I (@ Copy from sourcejob

Foundation Setup Data
Foundation Setup Data contains the Account Codes,
(C) Copy from Master Foundation Setup Data Tags, Quote Group Tags, Units of Measure,
Currencies, Resource | Assembly Files, Geographic
@ Copy from sourcejob Areas, Wage Zones, Organization Categories and
‘Weather Tags.

Resources and Resource Assemblies

Resources and Resource Assemblies that are
utilized by Cost Items in the source job(s) are
copied by default. Optionally, all Resources and
Resource Assemblies can be copied from the source
job{s) into the new job.

Copy utilized Resources and Resource Assambliss
from source job

Also copy allnon-utilized resources

Unassigned Cost Items and Markup : = :
Unassigned Cost Items are those costitems in the

() Copy from Master CBS CBSthat are not assigned to specific pay items,
including Prime Bond, Job Financing, General
(® Copy from sourcejob Expense, and others.

Copy Markup

Workbook

The workbook contains data that is used te link

. fields in Estimate to cells in Excel. The

(O Copy from Library workbook containing the data that you want to
CapwhOmisolEEE k use for linking with Excel can be copied from

@ Cony L the Library or the source job.

< Back Cancel

10. Click Next.

¢ The Bid Wizard — Step 4 of 4 dialog displays

11. Click the Source Job drop-down arrow.
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Step 4 of 4: Choose the source Caost ltems to copy.

| I Source Job:

| Drag columnz here to group Find: | [Search Far...] Saved views: | Standard View -
CBS - - Optional Forecast
[retiz Position Code = | Desaription Code (T/0) Quantity
4 3

Togagle Include All < Back Cancel

¢ The Job Register opens
12. Find and select Training Job.
13. Click OK.

e This screen displays the cost items of the source job (Training Job). All items are
automatically selected

14. Use the Toggle Include All button to exclude all selections.
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Step 4 of 4: Choose the source Cost ltems to copy.

Source Job:| Training Job

|
| brag columns here to group

Indude

5. 1

4

Toagle Include All

Descr...

Mobilization

Clearing & ...
Undassifie...
Excavat...
Embank...
Aggregate...
Furnish ...
Finegra. ..
Install A...

Place ...

Find:

Optional
Code
541 0100
2010102
2020183
3.1

3.2

303 5912
4.1

4.2

CLE

el

Bid Wizard

[Search For..

Forec...
(r/o)

Quan...
1.00
10.00
50,000.00
38,227.74
42,432.79
45,000.00
45,000.00
400,000.00
45,000.00
45,000.00

1

Unit of
Meas...
Lump Sum
Acre

Cubic Yard
Cubic Meter
Cubic Meter
Ton

Ton

Square Yard
Ton

Ton

Saved views:

Unit

Cost
$11,909.51
£3,793.70
$4.79
§3.90
$2.13
£15.15
$11.54
$0.18
$1.97
£1.55

Estimate Intermediate User Guide

Standard View

Total
Cost
{Fore...

£11,908.51
£37,936.97
£239,582.64
£149,236.48
£00,346. 16
$681,696.99
£519,513.30
£73,352.36
£35,331.33
£69,716.92

< Back

Curre...

U.5. Dallar
U.5. Dollar
.S, Dallar
U.5. Dallar
U.5. Dallar
U.5. Dallar
U.5. Dollar
.S, Dallar
U.5. Dallar
U.5. Dallar

Finish

Account
Code
1020 0+
1110
1122
11221
1192.2
1120
1130.1
1180
1120
1120.2

Cancel

15. Select the checkboxes to include Mobilization, Clearing & Grubbing, and Unclassified

Excavation.

16. Notice that when selecting Unclassified Excavation, that cost item’s subordinates are
automatically selected
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@ o x
Step 4 of 4: Choose the source Cost ltems to copy.
Source Job:| Training Job -
[
Drag columns here to group Find: | [Search For...] Saved views: | Standard View -
Indude EBS Descr... gop;:ignal ?,535 N kl"lgi;so.f. ggistt Eztsatl Curre... ggcdo;unt
C.. Quan... (Fore...
" 1 Mobilization 6410100 100 Lump Sum £€11,909.51  £11,909.51 U.5. Dollar 1020 =+
" 2 Clearing & ... | 2010102 10,00 Acre §3,793.70  §37,936.97 U.S. Dollar 1110
4! " 3 Undassifie... | 2020183 50,000.00 Cubic Yard $4.79 §239,582.64 U.S. Dollar 1122
" i1 Excavat... | 3.1 38,227.74 Cubic Meter £3.90 £149,236.48 |.S. Dollar 11221
" e Embank... |3.2 42,432,79 Cubic Meter §2.13  §90,346.16 U.S. Dollar 11222
= 4 Aggregate... 303 5912 45,000.00 Ton $15.15 8§681,696.99 U.5. Dollar 1120
sl Furnish ... 4.1 45,000.00  Ton £11.54 §£519,513.30 U.S. Dollar 112001
4,2 Finegra... 4.2 400,000.00 Square Yard &0.18  §73,352.36 .S, Dollar 1180
= B3 Install A... 4.3 45,000.00 Ton $1.97 $88,831.33 U.5. Dollar 1120
4.3.1 Place ... 4.3.1 45,000.00 Ton §1.55 £59,716.92 U.5. Dollar  1120.2 ,

Toaggle Include All

17. Click Finish to add the new job.

e An Attention prompt appears asking, “Do you want to adjust Pay Rules and Shift

Arrangements of the copied cost items?”

¢ Typically, you will want to use the shifts and payment rules of your new destination job.

s

Cancel

18. Select Adjust the pay rules and shift arrangements to match the destination.

%

You have ordered one or more costitems to be copied by the Bid Wizard.

Do youwant to adjust Pay Rules and Shift Arrangements of the copied cost items?

() Keep the original pay rules and shift arrangements

{® Adjust the pay rules and shift arrangements to match the destination

[] Mever ask me this question again

19. Click OK.

InEight Inc. | Release 24.7

Page 65 of 236



3.3 Bid Wizard

Estimate Intermediate User Guide

¢ A help bubble appears letting you know the job has been created, and that you can use
the ribbon tabs on the Estimate landing page to open any form

20. Close the help bubble by selecting the X in the upper right corner.

Mever offer this help agzin

The new job has been created. Use the

ribbon tabs to navigate to any of this
job’s data forms.

21. Open the Estimate > CBS to see the three cost items that were brought in.

Cost Breakdown Structure (CBS) Register ©

Drag co

CBS
Position Code

+ o+

3.1
3.2

+ 4+ W o+ o+
w
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Columns nere to group

Description

Jos
Prime Bond
Price % Add-On
Job Financing
Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On
Job Management & Equipment
General Expense
Direct Cost Add-On
Mobilization
Clearing & Grubbing
Unclassified Excavation
Excavation
Embankment

Really
Optional
Code

FRIME BOND
PRICE % ADD-ON
FIMNAMNCE EXPEMSE

INDIRECT COST ESCAL...
DIRECT COST ESCALAT...

INDIRECT COST ADD-OM
JOB MANAGEMENT &E...
GEMERAL EXPEMSE
DIRECT COST ADD-OMN
541 0100

2010102

2020183

3.1

3.2

Forecast

(T/0) Quantity

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00

1.00
10.00
50,000.00
38,227.74
42,432.79

Unit of
Measure

Lurnp Sum
Lump Sum
Lurnp Sum
Lump Sum
Lurnp Sum
Lump Sum
Lurnp Sum
Lump Sum
Lurnp Sum
Lump Sum
Lurnp Sum
Acre

Cubic Yard
Cubic Meter
Cubic Meter
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3.3.1 BID WIZARD UPDATES

While using the Bid Wizard, the Include option is left unchecked by default. A filter is applied to bring
in pay items when using the Bid Wizard. The Toggle Include All button only selects the filtered list of
items instead of all items.

When the filter criteria is modified, the selected items remain checked even if some of the items might
not be visible in the view. When the view is changed, the selected items remain checked.

Tags and UDF fields are included in the Bid Wizard Selection register for the cost items and Pay ltem &
Proposal selection registers. This lets you filter the list of cost items based on a tag or UDF.

When you select the Toggle Select All button, only filtered items are included which allow you to
include scopes of work relevant to your estimate without having to manually select all items needed.

Sl %ol b Cleieici o | o Selmgt 0 F &y Dema 10 OOy ifil 0 s Jaobs E o oumeniilois, o] diishd mpiniones, i sy

343 el = |
Trobde f_":f: g fagd g 1 I ey Dcland i D 3 s Gt 5 J e
. E L) 1304 Lo viiah
' o+ o) 133
o SOA) 1347 Sowcal Coraruck
;| e L=l ]

[Ty 1) B Breiom
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3.4 COPY ESTIMATE DATA USING EDIT
COMMANDS

While the Bid Wizard is an efficient way to copy cost history into new projects, you may prefer to use
edit commands such as copy and paste to bring cost history into your estimate.

To copy and paste cost history from one job to another, it is beneficial to see the jobs side by side. The
following steps walk you through the process.

STEP BY STEP — COPY ESTIMATE DATA USING EDIT COMMANDS

1. Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you just
created.

2. Open the Training Job (if you do not still have it open).

3. Make sure the CBS is open for both jobs by going to the Estimate menu and selecting Cost
Breakdown Structure (CBS).

Estimate Quote Price Execution

!-H Account Code Utilization am Resource Rates ~

Ba+ Work Breakdown Structures 'EE Resource Utilization

=
Cost Breakdown -
Structure (CBS) & Resource Cost Details
Breakdown Structures Resources

Cost Breakdown Structure (CBS) Register €

4. Since you have both jobs open and they are in their own application window, align them to be
side by side by using the minimize icons of each job or utilizing Windows align functionality.
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Standard View -

Saved views:

Iy Hniirs Hniirs

3.4 Copy Estimate Data Using Edit Commands

» Note that the window caption identifies the CBS Register for each job

Integratons Actons

% B
[o— Wbk | e Cafon | et 20 | presiesion
Structure (CBS) g = Costltems [8]  stuctore (P8S) &
oS | Res. | Workbook | Schede | ndrectCost | overhead andPr
Cost reakdonn Sructure (B5) Regster O
e oliester oo ot [emr o]
ety
@ L Forcost
ook = ovrown gt 7 sty
B
brme bond s
Prce o Add-on ice %0001
30bFancing Fovoce ppese
Indeec Cont Ecalation pomecr costesca
DirectCostEcalaton e cosTescaT,
Indeec ost Add-On vorecrcost Aot
5 Gemrnibrpesse e omse
DrectCot Ad-0n [
w1 Hobilzaton snom
‘2 Clearing & crubbng oz
=s Undassited Excavation e
v St B
‘52 it 52
ss Rasresate sase sz

Base

pr—

Alternates

Reports

Reports

Seved views: | Prevous View

Unitof
Messire

e
Lump sum
Lunp Sum
Lunp Sum
Lump Sum
Lump Sum
Lump sum
Lunp Sum
Lunp Sum
Lump sum
Lump sum
e

b rard
Cubic Meter
b Meter
Ton

Ut Cost

$3633,197..
47,1907
s205,371.61
000

0.0
$19,131.77
§59,476.5¢
s125,8%.28
420000
10420316
s11.30951
s5,750
494

1
21
s15.15

Pice  Excauton

M| = 7 S| mm B | At s T]
=) 00 g = g |ue
Worlbook | Schedde CosnFow | drect e rescionn Repors
- * Conttens [ St (59 A 4y Atermates
~ reakdownstnic. | Res.. | Workbook |  Schedule | IndrectCost | Overhead andPr. Atemates Reports -
- CostBreakdown Structure (CBS) Register ©
[ v [BemanFord | Saved views: [ Sandardvew
T R e . et o | motcm []
(Forecsst) Poston Code oot /o) quantty veasure Forecast)
s || > B 208 100 o som s ssenoTE
s, 11507 Prime sond sroeson 100 Lo sm s ssmi
ss57160 Prce %0 Add-on #ruce % ADDON 100 Lo sum s s
w0 3obFinancing Funce Boeise 100 o sum w0 w0
$0.00 Indirect Cost Escalation INDIRECT COST ESCAL. 100 Lump Sum $0.00 $0.00
si9,13177 Direct Cost Escalaton OmECT cosT ESCALAT. 100 o sum 0m 000
ss576.54 Indirect Cost Add-on IOIRECT COST ADO-ON 100 Lmosum smis sz
si25856.28 - Equpment B 100 umoSum ssamn spssses
ss.2000 . GenerstExpense et 100 Lmpsum sam0m  sam000
s100203.16 Direct Cost Add-on omecr cosr a00-0n 100 Lo sm smas  sms
a0 v Hobiization sstoi0 100 Lo sum sis9st susonst
597 +2 Clearing & Grubbing wiow2 1000 Ace smm s
2w a3 Unclassified Excavation w201 50,0000 ubicvard “am s
s156,55455 + a1 Sxcavason 2 s.222.74 Cmter as smass
0,315 + a2 Sntaniment 52 nan v s soves
ss01656.99

5. On the CBS of the Training Job, click the row header on cost item 4 — Aggregate Base and press

Ctrl+C to copy the cost item.

Aggregate Base

+ 41 Furrish & Haul Base Material

+ 42 Finegrade Subgrade .

B 43 Instzl Agaregate Base 4.3
+ 431 Place Aggregate Base 4.3.1
+ 432 Blue Top Aggregate Base 43.2

TIP

copied.

When you copy a superior cost item, all of its subordinates are automatically

6. On the CBS of the E101 Bid Wizard job, click the row header on the first blank register row, and

press Ctrl+V to paste the cost item.
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+ 1 Mobilization 6410100 1.00  Lump Sum
+ 2 Clearing & Grubbing 2010102 10,00 Acre

a3 Unclassified Excavation 2020133 50,000,00  Cubic Yard
+ i Excavation 3.1 38,227.74 Cubic Meter
+

Embankment 3.2 42,432,739  Cubic Meter

7. On the Attention dialog, select Adjust the pay rules and shift arrangements to match the
destination and click OK.

Attention

‘
:\

You have ordered one or mare cost items to be copied and inserted as subordinates to
to the Cost Item at CBS Position Code <JOB >,

Do youwant to adjust Pay Rules and Shift Arrangements of the copied cost items?

() Keep the original pay rules and shift arrangements

{® adjust the pay rules and shift arrangements to match the destination

[] Mever ask me this question again

& | (o= ]

* You can see in the destination job’s CBS that you’ve added the Aggregate Base cost item,
along with its subordinate cost items and all cost and productivity detail

ﬁ = 2 Z 00 = —— I—‘ Z oo I—‘
i 00, = g [y oo [
cture & - - Costltems [%] | Stn 2 | Jy Aemates - - Costltems (%] | Structr {4 Atemates
= e e = P ey I e O
Structure (CBS) Register © ructure (CBS) Register ©
e onson o D | (o] e e vonson s s | (o] (e
v o scoton s ol o v o scoton o com .. ol o
et o st oo R W e o tscamon onter oo Tl ool o
s ot athon sontercom o P [ el et v ottt on sontercom s D [l T
. cenrrpeme il o [uaran— | vamml smollll |2 cenrpeme il TR | e
pes o & e | - s fon et
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TIP You can also drag and drop cost items from one CBS to another instead of
copying and pasting.

TIP Copied cost items are considered Job Overhead until they are assigned to a
pay item

8. To go back to your full screen view of the E101 Bid Wizard job, select the maximize icon.

Reports

Reports

3.5 CBS BID WIZARD

You can also use the Bid Wizard to add cost items while you are in the CBS Register. The following
steps walk through using the CBS Bid Wizard.
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STEP BY STEP — USE THE CBS BID WIZARD

Click the File tab from the Estimate landing page and open the E101 Bid Wizard job you created.
From the Estimate tab, select Cost Breakdown Structure (CBS).

1
2
3. Create a new cost item by typing New in the Description column on the bottom row of the CBS
4

Highlight the New row.

oW -
File Setup Estimate Quote Price Execution System Integrations
i wap ~ ™2 Bid Wi i i — —
&= Schedule Selection 4 » Swap T Bid Wizard Z Unit / Total Confirmation b 3 E
Unschedule Selection @ Remove ~ Subtotal Calculator €3 Refresh Benchmarks
oE ) ) Add Level One  Add Subordinate Import [
=g Caloulate Plug Days O Update - Quantity Checking @ Add Quote Cost Items ~ Cost Items ~ Update CBS ~
schedule Batch Operations Tools Data Source

¢ The Bid Wizard window opens

6. Click in the Source Job column on the New cost item row.

Place Aggregate Base 45,000.00 Taon [5elect Source Job]
Blue Top Aggregate Base 400,000.00 Sguare Yard [5elect Source Job]

7. From the Source Job drop-down list, select Training Job.

8. Scroll to the right of the Source Job column and click in the Source CBS Position Code column on
the New Cost item row.

¢ A source CBS Register window appears

9. Select CBS position code 5 — Asphalt Concrete Hot Mix Type A from the register.
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Drag columns here to group Find: | [Search For...] = | Saved views: | Previous View -
EBS_ _ = Cesrsror g.;?jl.lz.ynal Unit of Forecast
osition Code Code Measure (T/Q) Quantity
4.2 Finegrade Subgrade 4.2 Square Yard 1 &
=2 4.3 Install Aggregate Base 4.3 Ton
4,3.1 Place Agaregate Base 4,3.1 Taon
4.3.2 Blue Top Aggregate Base 4.3.2 Square Yard :
L | Furnish & Haul Hot Mix 5.1 Tan
5.2 Install Hot Mix Type A 5.2 Ton
E 6 36 Inch RCP Culvert Class IIT 413(B) 0464 Linear Feet
6.1 Furnish RCP Materials 6.1 Linear Feet
6.2 Excavate RCP Trench 6.2 Cubic Yard
6.3 Install RCP Pipe 5.3 Linear Feet
6.4 Backfil RCP Pipe 6.4 Cubic Yard -
“ *
Cancel

10. Click OK.
11. Click Finish on the Bid Wizard.
¢ An Attention prompt displays, asking if you want to make adjustments

¢ Keep the default options selected: Make Adjustments according to their quantity drivers
and cost drivers and Adjust the pay rules and shift arrangements to match the
destination

12. Click OK.

2] Attention

s, or just their details, o be copied by the Bid

s and cost details based on the destination

of

¢ You can see that cost item 5 and its subordinates are now imported into your existing job.

* You could choose a new name for the cost item, or name it Asphalt Concrete Hot Mix
Type A to match the original cost item
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2 43 Install Aggregate Base 4.3 45,000.00  Ton

+ 431 Place Aggregate Base 4.3.1 45,000.00  Ton

+ 432 Blue Top Aggregate Base 4,3.2 400,000,000 Square Yard
X oot conceere oo oA T N

+ 5.1 Furnish & Haul Hot Mix 5.1 .00 Ton

+ 5.2 Install Hot Mix Type A 5.2 1.00 Ton

3.6 SNAPSHOTS

A job snapshot is a copy of an estimate that provides read-only access to the job as it existed at a
specific point in time. You can now filter the Snapshot register to jobs containing snapshots.

The Snapshot register has some additional columns as well. In addition to the Code, Description, Last
Saved, and Version column, the Snapshot register contains all fields that are present on the Jobs
register that provides you with an easier way to group, sort, filter, and find the jobs you need.

3.6.1 SNAPSHOT REGISTER

The Snapshot Register is where you will view individual snapshots for specific jobs.

STEP BY STEP — SNAPSHOT REGISTER

1. Click theFile tab to open the Backstage View. In the panel, select Snapshots.

2. From the Snapshots form, select the Snapshot Register tab.
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S

Snapshots
New
Rl
Sav
Clase Job Create Snapshot Snapshot Register

Close All Jobs

Jobs

Library

Templates

Snapshots

Archive [ Restore

Settings

Exit

3. To view individual snapshots for specific jobs, click the icon next to the desired job to display
the list of snapshots.

Code = Description

= D E101 - Training Job KL Sample Training Job
Training Job Training Job - Maricopa County Mo, TM2924

InEight Inc. | Release 24.7 Page 75 of 236



3.6 Snapshots Estimate Intermediate User Guide

3.6.2 CREATING A NEW JOB SNAPSHOT

STEP BY STEP — CREATE A NEW JOB SNAPSHOT

You can create a Job Snapshot from an existing Job.

1. From the Snapshots form, select the Create Snapshot tab.

Setup Estimate Execution System Actions
IEI'! Print Load | g Create Job Snapshat /f w w C:‘ Refresh
"i Preview Edit .3:: Delete All Job Snapshots ” - = Create New Job from Snapshot
Expand [ Filter to Jobs Clear
Delete Collapse =  with Snapshots  Filter
Print Edit View Tools
Snapshot Register ©
Drag columns here to group
Code = Description Last Version In Use Status
Saved
E101 - Training Job KL Sample Training Job 111242019 2;23:1... | 19.2.0.27
Training Job Training Job - Maricopa County Mo, TM2924  11f13/2019 7:40:1...  19.2.0.27 Bidding

2. If an existing job is open select Save, if you haven’t already done so.
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3 Attention

UInsaved data will not be stored in the snapshot. Save the job
beforetaking a snapshot?

E101 - Training Job KL

0] Cancel Unselect All

3. A New Job Snapshot [Job Code Here] dialog box appears. From there, you can add a Snapshot
comment.

e If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box, otherwise uncheck the box.

¢ If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button.

» If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

¢ If you want to Specify User Access restrictions for this Snapshot (default selection), select

this option

¢ Then use the Add and Remove buttons to specify user access using Active Directory.
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(Users with current access to the job default onto the list.)

Mew Job Snapshot [E101 - Training Job KL]

Job: |E101 - Training ] Job Description: |Samp|e Training Job

Snapshot || <add comment here>|
Comment:

ﬁ‘ Include all Attachments that have been stored in the Job Folder with this Snapshot

User Access
(") UseJob's current User Access restrictions for this Snapshot
() Remaove all User Access restrictions for this Snapshot

(®) Specify User Accessrestrictions for this Snapshot

user - karen.loftus @ineight.com Add...
user - paul. trippi@ineight. com

Remove

4. Click OK to create the snapshot.

5. A pop-up indicates when the snapshot has been created.

Success!

Successfully created Job Snapshot for Job: "E107 - Training Job KL

[ ] Never offer this help again

OK
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3.6.3 EDITING A JOB SNAPSHOT

STEP BY STEP — EDIT A JOB SNAPSHOT

1. From the Snapshot Register, click the = icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to edit and select Edit.

= — E101 - Training Job KL Sample Training Job

Snapshot Comment

- Load
Train -
ralrllrlgl Echt

fﬁ’ Delete
5y

Create New Job from Snapshot

3. The same sort of dialog box opens up as when you created the Snapshot. In this case, from the
Edit Job Snapshot [Job Code Here] dialog box, modify the Snapshot Comment and the User
Access options as needed.

¢ If you want to Include all Attachments that have been stored in the Job Folder with this
Snapshot, select the check box. Otherwise, uncheck the box

¢ If you want to Use Job's current User Access restrictions for this Snapshot, select this radio
button

» If you want to Remove User Access restrictions for this Snapshot and allow read-only
access to all users, select this radio button

¢ If you want to Specify User Access restrictions for this Snapshot (default selection), select
this option

¢ Then use the Add and Remove buttons to specify user access using Active Directory.
(Users with current access to the job default onto the list.)

4. Click OK to update the snapshot.
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3.6.4 DELETING A JOB SNAPSHOT

STEP BY STEP — DELETE A JOB SNAPSHOT

1. From the Snapshot Register, click the icon next to the desired job to display snapshots.

2. Right-click on the individual snapshot you want to delete snapshots from and select
Delete.

Code — Description

= — E101 - Training Job KL Sample Training Job

Snapshot Comment =

Load
Edit

5 Delete

Create New Job from Snapshot

3. Click OK

Delete Job Snapshot

Are you sureyou want to delete this Job Snapshot?

<add updated comment... [E101 - Training Job KL_201911

Cancel Unselect All

Alternatively, you can delete all Job Snapshots by clicking Delete All Job Snapshots from the
Actions tab.
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Estimate Execution System Actions
= Print load g4l Create Job Snapshot ['l"
"%. Preview Edit -':: Delete all Job Snapshots
Expand [
Delete Colapse =
Print Edit Vie
Snapshot Register &

3.6.5 LOADING A JOB SNAPSHOT

When you load an existing Snapshot, it loads into Estimate as any other job.

STEP BY STEP — LOAD A JOB SNAPSHOT

1. Click the File tab to open the Backstage View, then select Snapshots.
2. From the Snapshots form, select the Snapshot Register tab.
3. On the Snapshot Register, click the icon next to the desired job to display the list of snapshots.
4. Right-click on the individual snapshot you want to load and select Load.
Code = Description ;:f;; d Version In Use
= — E101 -Training Job KL Sample Training Job 11/13/2019 8:25:3... 19.2.0.27 o
Snapshot Comment =  Date Created Version
<add updated comment here= 11/13/2019 3:31:54 PM 19.2.0.27
= [E— | 11/13/2019 3: fReieib B
Training Job Training Job - Maricopa County No., TM252 == |
Edr
f{f Delete
P Create Mew Job from Snapshot

To identify a snapshot in Estimate as a read-only snapshot:
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e The job name is preceded by the label SNAPSHOT: centered on the top of the toolbar

e Ared banner shows the specific snapshot information at the bottom of the screen

el =0 A snapshot can be modified, but it cannot be saved as it is read-only.

SNAPSHOT: Training Job - Estimate

Estmate  Quote Pz Exzauton Actons
& print Qnew B coy spit Indent Link Field Cost Item Assembly Resource e W W EossTecrie
R Previen Delete Paste. Spiitby Cost Type Outdent Uniink Field | %= Subordinate Cost Item | = Subordinate Assembly Resource Assembly Ld » /" Expand CBS Tree
Epand [ Fiter  Clear
& Export to Excel cut FilDown T Toggle Suspended ¥ Dependent Cost Ttem Callapse = - Filter
Print Edit Workbook Insert View o
Cost Breakdown Structure (CBS) Register @ -
CBS Tree (Filter Mode) X || Drag esiumns here to group Find: | savedviews:
Forecast
Code Description cas Unit of Total Cost Alocation Cost Opteral
Position Code Description o) Measure  UMCO  (Rorageey  Albeted g CUTENSY  agustment  Code
o 08 - Quantity
88 Frime Bond » = 08 2000 Mie $292,094.58 $5,841,89155 = U.5. Dolar - &
0 Price % Add-On + Prime Bond 100 Lump Sum $96,950.91  $46,950.91 U.S. Dollar = PRIVE
= Job Financing + Price % Add-On 100 Lump Sum $203858.20  $293,858.20 U.S. Dollar 0 PRICE
oo
oo Indirect Cost Escalation + Job Financing 100 Lump Sum $0.00 $0.00 U.5. Dollar 0 FINAN
oo
OO | Direct CostEscalaton + Indirect Cost Escalation 100 Lump Sum 0.00 .00 U.5. Dollar = ORI
= Indirect Cost Add-On
60 + Direct Cost Escalation 100 Lump Sum 0.00 0.00 U.S. Dollar = DREC
= Job Management & Equipment
& Indirect Cost Add-0n 100 Lump Sum $0.00 .00 U.5. Dollr 0 ORI
= General Expense
o + Job Management & Equipment 100 WmpSum  §157,096.28  $157,09.28 U.5. Dollar 108M
89 Direct Cost Add-On
SN robicason + General Expense 100 Lump Sum 420000  $4200.00 U.S. Dollr cEnER
2 | Gearing & Grubbing & Direct Cost Add-On 100 WwmpSum  $10430110  $10430110 U.5. Dollr = DREC
» @280 Undassified Excavation + 1 Mobilization 100 Lump Sum $1150951  $11,909.51 U.S. Dollr v 6410
> @54 | Aggregate Base + 2 Clearing & Grubbing 1000 Aae $3,918.50  $39,184.97 U.S. Dollar 010!
> @u|8 | Asphalt Concrete Hot Mix Ty. s 3 Undlassified Excavation 50,000.00  Cubic Yard $4.68  $233,915.81 U.5. Dollar 2020
» %8 | 361nch RCP Cubvert Class I + 31 Excavation 50,000.00  Cubic Yard $3.00  $149,92238 U.S. Dollr 31
> @87 10Inch PYC Force Main (5D + 32 Embarkment 50,000.00  Cubic Yard $168  $83,99294 U.S. Dolar 32
> @B 2310ch PYc ravity Sewer ( Ea Aggregate Base 45,000.00 Ton $1540  $692,928.99 U.S. Dollr 3035¢
> B@ 8 | 4FootDiameter Manhole
+ a1 Furnich & Haul Base Material 45,0000 Ton $1154  §519,513.30 U.S. Dollar 41
> @@ 10 | Structural Excavation & Backfil
+ 42 Finegrade Subgrade 400,000.00 Square Yard 018 75843 U.5. Dalr 42
> @ 11 | SteelReinforcement =
T P —— . 106 5801801
< v e o
As Entered Currency | As-Entered Units _ Minimum Example Accrued Costs OFF
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EXERCISE 3.1 — DATA REPRODUCTION

Now that you have learned how to utilize the Bid Wizard, complete the following steps using the Bid
Wizard and Copy & Paste features.

1. Open the Bid Wizard by clicking the Bid Wizard icon from the More Actions tab.

2. Choose the Create a new job radio button.

3. Type BW Exercise (with your initials) in the New Code field and type Exercise in the
Description field.

4. Choose Select cost items.

5. For all selections, choose Copy from source job.

6. Select the Also copy all non-utilized resources checkbox.

7. Select Copy from source job under Unassigned Cost Items and Markup, and the Copy
Markup box is automatically selected.

8. Find and select Training Job and click OK.

9. Use the Toggle Include All button to exclude all selections.

10. Select the checkboxes to include Cost Items 4-7.

11. Click Finish to add the new job.

12. Select Adjust the pay rules and shift arrangements to match the destination.

13. Open the CBS to see the cost items that were brought in.
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14. Open the Infra Job Copy with your initials that you created earlier in this lesson.

15. Copy Cost items 8 and 9 and paste them into the BW Exercise job.

C

You should end up with the following results

BS

Position Code

+

+ 4+ 0 + + + 4+ 0D 0+ + 0 + + + + 0 + + 0 + + O + + W

Li
1.2
L3
L1
1.3.2

21
22

&l
32
33
34

4.1
4.2

Sl
& 11
SFl.2
52
&3

6.1
0.2
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Description

Indirect Cost Escalation
Direct Cost Escalation
Indirect Cost Add-On
Job Management & Equipment
General Expense
Direct Cost Add-On
Aggregate Base
Furnish & Haul Base Material
Finegrade Subarade
Install Aggregate Base
Place Aggregate Base
Blue Top Aggregate Base
Asphalt Concrete Hot Mix Type A
Furnish & Haul Hot Mix
Install Hot Mix Type A
36 Inch RCP Culvert Class IT1
Furnish RCP Materials
Excavate RCP Trench
Install RCP Pipe
Backfill RCP Pipe
10 Inch PVC Force Main (SDR21)
Furnish 10 Inch PVC Materials
Excavate-Install-Backfill 10 Inch PVC

24 Inch PVC Gravity Sewer (SDR35)

Excavate 24 Inch PVC
Excavate 24 Inch PVC 0-5 ft Depth
Excavate 24 Inch PVC 6-10 ft Depth
Furnish & Install 24 Inch PVC
Backfill 24 Inch PVC
4 Foot Diameter Manhole
Furnish 4 ft Manhole Materials
Excavate-Install-Backfill Manhol=

Optional
Code

INDIRECT COST ESCAL...
DIRECT COST ESCALAT...
INDIRECT COST ADD-OM
JOB MAMAGEMENT &.E...
GEMERAL EXPENSE
DIRECT COST ADD-ON
303 5912

4.1

4.2

4.3

4.3.1

4.3.2

303 4263

5.1

5.2

413(B) 0954

8.1

8.2

6.3

6.4

800 0220

7.1

7.2

800 0330

8.1

8.1.1

8.1.2

8.2

8.3

800 0400

a.1

2.2

Forecast

(T/C) Quantity

1.00

1.00

1.00

1.00

1.00

1.00
45,000.00
45,000.00
400,000.00
45,000.00
45,000.00
400,000.00
35,000.00
35,000.00
35,000.00
1,024.00
1,024.00
1,858.56
1,024.00
1,587.20
12,000.00
12,000.00
12,000.00
3,000.00
3,000.00
1,390.00
3,610.00
3,000.00
4,520.00
16.00
16.00
15.00

Unit of
Measure

Lurnp Sum
Lurnp Surm
Lump Sum
Lurnp Sum
Lurnp Sum
Lump Sum
Ton

Ton

Sguare Yard
Ton

Ton

Sguare Yard
Ton

Ton

Ton

Linear Feet
Linear Feet
Cubic Yard
Linear Feet
Cubic Yard
Linear Feet
Linear Feet
Linear Feet
Linear Feet
Linear Feet
Cubic Yard
Cubic Yard
Linear Feet
Cubic Yard
Each

Each

Each
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Congratulations, you have completed this exercise!
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LESSON 3 REVIEW

1. From the New option on the Backstage View, which of the following options are available
for creating a new job? (Select all that apply)

Scratch

T o

Template
Import
Existing Job

Historic

-~ ® a2 o

Bid Wizard

2. Which of the following job reproduction options lets you pick and choose which cost
items you want to import into your new job?

a. Template

b. Bid Wizard
C. Existing Job
d

. Archive

3. Which of the following options allows you to add cost items from another project when
working in the CBS Register?

a. Bid Wizard
b. CBS Bid Wizard
C. Template

d. Existing Job

LESSON 3 SUMMARY

As a result of this lesson, you can:

e Create a job from an existing job or template

¢ Create a template
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Reproduce estimate data using the Bid Wizard

Reproduce estimate data using copy/paste

Add cost items to a job using the CBS Bid Wizard

Utilize the Snapshot function
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LESSON 4 — EXCEL INTEGRATION

LESSON DURATION: 20 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
e Export data from InEight Estimate to Excel
¢ Link afield in InEight Estimate to Excel

e Update a linked InEight Estimate field with Excel data

4.1 EXPORT TO EXCEL

InEight Estimate's integration with Microsoft Excel includes a two-way integration that allows you to
update register fields in InEight Estimate with data contained in an Excel workbook, and update Excel
cells with data contained in a register column in InEight Estimate.

InEight Estimate includes a worksheet export that makes it easy to transfer data out of InEight Estimate
register forms to Microsoft Excel spreadsheets. This feature makes it faster and easier to send data
from an InEight Estimate register to a spreadsheet, analyze it, modify it, and customize it for any other
uses.

The Export to Excel feature is available on all register forms in the system and allows you to export the
data currently displayed on a register form to an Excel worksheet.
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STEP BY STEP — EXPORT DATA TO AN EXCEL WORKBOOK

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. From the Actions tab, select Export to Excel.

oM -

File Setup Estimate Quote Price Execution System Integrations

1= Print @ vew G copy split Outdent | A& Link Field CostIi

'%_ Preview Delete é Paste ﬁ Toggle Suspended &% Unlink Field E Subore

&} Export to Excel Cut Fill Down Indent H Depen
Print Edit Workbook

Cost Breakdown Structure (CBS) Register ©

3. On the Export spreadsheet to... dialog, browse to the location (folder) in your system where you
want to save the workbook, enter CBS Export in the File name field, and click Save.

e The workbook is saved to that location with the specified file name, and Excel
automatically launches and displays the workbook
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¢ Notice that the columns are formatted, with column headers and filtering turned on

AutoSave (8 of) [F] & CES Export - Excel Karen Loftus

File Home Formulas Data Review View Help Acrobat O Search ‘ 1% Share | ‘ = Comments

Eﬂ e -0 <[ === 8 | [ree +| | [ conditional Formatting - ’ Q
ngv =E- | $-% 9 |BHfomatasTable- Cells | Editing | Ideas | Share This Webex

Past,
< | . <0 00 [ Cell Styles~ - - B =

60 20

Clipboard 1 Font 5l Alignment G Number & Styles Ideas Webex

| \ \ \ | | \
Ll CBS Position Code | - Description - | Forecast [110]4 ~ |Unit of Measure ~ | UnitCost |~ Total Cost [Forecast] ~ Currenqr =
filel:) 20.00 Mile $292,316.18 $5,846,323.66 U.S. Dollar
Prime Bond 1.00 Lump Sum $46,974.12 $46,974.12 U.S. Dollar
Price % Add-On 1.00 Lump Sum $294,067.09 $294,067.09 U.S. Dollar
Job Financing 1.00 Lump Sum 50.00 $0.00 U.S. Dollar
Indirect Cost Escalation 1.00 Lump Sum 50.00 $0.00 U.S. Dollar
Direct Cost Escalation 1.00 Lump Sum 50.00 $0.00 U.S. Dollar
Indirect Cost Add-On 1.00 Lump Sum 50.00 $0.00 U.S. Dollar
Job Management & Equipment 1.00 Lump Sum $157,096.28 $157,096.28 U.S. Dollar
General Expense 1.00 Lump Sum $4,200.00 $4,200.00 U.5. Dollar
Direct Cost Add-On 1.00 Lump Sum $104,301.10 $104,301.10 U.S. Dollar
Mobilization 1.00 Lump Sum $11,909.51 $11,909.51 U.S. Dollar
Clearing & Grubbing 10.00 Acre $3,918.50 $39,184.97 U.S. Dollar
Unclassified Excavation 50,000.00 Cubic Yard $4.68 $233,915.81 U.S. Dollar
Aggregate Base 45,000.00 Ton $15.40 $692,928.99 U.S. Dollar
Asphalt Concrete Hot Mix Type A 35,000.00 Ton $42.62 $1,491,580.59 U.S. Dollar
Furnish & Haul Hot Mix 35,000.00 Ton $39.27 $1,374,562.54 U.S. Dollar
Install Hot Mix Type A 35,000.00 Ton $3.34 $117,018.05 U.S. Dollar
36 Inch RCP Culvert Class Il 1,024.00 Linear Feet $67.54 $69,159.49 U.S. Dollar
Furnish RCP Materials 1,024.00 Linear Feet $33.48 $34,286.70 U.S. Dollar
Excavate RCP Trench 1,858.56 Cubic Yard $4.51 $8,379.59 U.S. Dollar
Install RCE Pine 2 4 i a
Formatted Data [EEECHNES @

I

In

IDEEEEEEE

4.1.1 CELL SELECT

To copy and paste data in InEight Estimate or to Excel, you can use a feature called Cell Select. Walk
through the following steps to learn how to copy specific fields in InEight Estimate to an Excel

Spreadsheet.

STEP BY STEP — CELL SELECT

1. Open the Training Job and from the Setup tab, open the Resource Rate Register.

2. Select the Labor tab.

3. Select Print View for Summary from your Saved Views drop-down menu.

4. From the top-right corner, select the Cell Select icon, (next to the Help icon).
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¢ This puts you in “cell-select” mode, so you can select cells to copy in the same way you
would in Excel.

5. With the Cell Select icon active, highlight all information in the Description, Utilization Count
and Unit of Measurecolumns for all Labor resources.

Resource Rate Register @

All Labor Construction Equipment | Rented Construction Equipment | Installed Material Installed Equipment | Supplies Unique

Drag columns here to group

S oesrpton v zzmﬁm az‘;::re
+ LEC1 Carpenter Apprentice
LC2 Carpenter Journeyman 3
LC3
LF1
LF2

LF3

m -

LL2 3
LL3

LMECH

LO1

LO3 Operator Class 3 889,33
LREM 01 i

LREM 05
LSPE ginee B00.00
LSSEC
LSSUPT
LT1
LT2
LWD
= LWDA i m Hour

o+ F o+ o+ o+ F o+ o+ o+ +

6. Right click on the selection and select Copy.

7. Open an Excel spreadsheet, right click in the A1 field and select Paste Special, choosing CSV as
the Source.
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8. Click OK.

¢ The fields you copied from InEight Estimate paste into the spreadsheet

A

1 Carpenter Apprentice
2 Carpenter Journeyman
3 Carpenter Foreman
4 Finisher Apprentice
5 |Finisher
6 |Finisher Foreman
7 |lron Worker
8 |Iron Worker Foreman
9 |Labor Apprentice
10 Laborer
11 Labor Foreman
12 Mechanic
13 Operator Class 1
14 |Operator Class 2
15 Operator Class 3
16 |Operator Foreman
17 |Principal Eng/Scientist
18 |Field Technican
19 |Project Engineer
20 secretary
21 Project Superintendent
22 Teamster
23 Teamster Foreman
24 \welder
25 |Welder Apprentice
26

Sheet1

B =
594.3650794 Hour
1188.730159 Hour
594.3650794 Hour

0 Hour
594.3650794 Hour
0 Hour
594.3650794 Hour
0 Hour

0 Hour
8963.733879 Hour
721.3333333 Hour
418.4398946 Hour
1800 Hour
4019.732279 Hour
889.3333333 Hour
1421.768 Hour

0 Hour

0 Hour

800 Hour

800 Hour

800 Hour
3056.768 Hour

0 Hour

0 Hour

0 Hour

4.1 Export to Excel

¢ To turn off the Cell Select, simply click the Cell Select Icon again and it deselects
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4.2 LINKING TO EXCEL

4.2.1 INEIGHT ESTIMATE WORKBOOK

Every job has its own Excel workbook embedded within it for doing side calculations and take-offs. You
can link your calculations to fields in InEight Estimate to automatically update them into your estimate.
When you create a new job from scratch, the Library Master Workbook is copied to create a new
embedded Excel workbook for the job.

The workbook comes with some pre-defined take-off and analysis worksheets, or you can create your
own. Simply open the appropriate worksheet, plug in your values, and Excel will calculate your results.
To open your job’s workbook, select the Estimate tab, then click on the Workbook icon under the
Workbook section.

%

File Setup Quote Price Execution System Actions More Actions
ﬂ Yam Account Code Utilization & ResourceRates ~ - | f aodo
!nﬁ Work Breakdown Structures Ei Resource Utilization D D
Cost Breakdown . ) Workbook Schedule Cash Flow Indirect
Structure (CBS) & Resource Cost Detail - - Cost Iter
Breakdown Structures Resources Workbook Schedule

Cost Breakdown Structure (CBS) Register ©

Page 94 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide 4.2 Linking to Excel

e The embedded Excel workbook for the job opens.

o U (emmbimEmm  © o

InEight
ESTIMATE

Take Off & Analysis
Worksheets

el and Estimate, you can update all linked fields by
n Estimate.

Instructions:

Table of Contents

Instructions | Table of Contents | AHaul Cost | B_Hauler Calculator | C_HaulTake Off | D_Production Rate Calculator | E+

4.2.2 LINKING TO AND FROM EXCEL

InEight Estimate's linking capabilities with Excel can be done in one of two ways. A field in InEight
Estimate can be populated with a value from Excel, or a cell in Excel can be populated with the data
from an InEight Estimate field. This two-way linking functionality allows you to make quick work of
complex chores to perform spreadsheet-based take-off or formula-driven analysis.

= 6 36 Inch RCP Culvert Class III 413(B) 0464 I 1,024.00 I Linear Feet
+ 6.1 Furnish RCP Materials 6.1 1,024.00 Linear Feet
+ 6.2 Excavate RCP Trench 6.2 1,858.56 Cubic Yard

The following example walks through how to link a simple take-off calculation into InEight Estimate
from Excel. It is a take-off to determine the size of a concrete foundation.
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STEP BY STEP — LINK ESTIMATE TO EXCEL

1. Open the Training Job and from the Estimate tab, open the CBS Register.

2. For this example, create a new cost item in the blank row at the bottom of the CBS register and
name it Concrete Foundation.

Concrete Foundation .00 CY

3. Open the job’s Excel workbook from the Estimate tab, by selecting the Workbook icon.

4. In the workbook, create a new worksheet named Concrete Take-off and enter the following

fields:
A B C . B . E . F | G
1 Concrete Take-off
2
3 |Length 10 yards
4 'Width 10 yards
5 Height 0.5 yards
E | |
? —
B —
9 —
10
11|
12
» Instructions Table of Contents Concrete Take-Off |_

5. Create a new row to calculate the total cubic yards by factoring the length, width, and height
quantities.
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A, B C
1 |Concrete Take-off
2 [ ] [ ]
3 Length | 101yards

W ———————

4 |Width | 10lyards
5 Height | 0.5lyards
6 [Volume |=sum(B3"B4°B5)
7

¢ Your Volume Total should be 50 cubic yards

A B
1 |Concrete Take-off
2
3 |Length 10 yards
4 |Width 10 yards
5 |Height 0.5 yards
6 [Volume 50 CY
7

4.2 Linking to Excel

6. InEight Estimate will only link to named fields in Excel. Click in the field you want to name (B6),

then click in the Field Name window and type Volume.

Volume e p

A c
1 |Concrete Take-off
2
3 |Length 10 yards
4 |Width 10 vards
5 |Height 0.5 vards
6 |Volume solcy
=

7. Go back to the CBS Register and right click on the Concrete Foundation cost item Forecast (T/O)

Quantity field.

8. From the resulting right click menu, select Link this field to Excel.

e You can also link the field by selecting the field and then selecting Link Field from the
Actions tab
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Execution

n

Suspended

the Water

Integrations

B, Link Field

&4, Unlink Field

= Indent

Outdent

Workbook

Optional
Code

00420

03210

09640

12510

15300

16510

1500 0100
1500 0200
1000 0230
co1
UMASSIGMED DIRECT C...
UMASSIGNED
LUMASSIGMED
LUMASSIGMED
UMASSIGMNED

Estimate Intermediate User Guide

Training Job - Estimate

Actions

== Cost Item

More Actions

"= Subordinate Cost Ttem

H Dependent Cost Ttem

Forecast

(T/C) Quantity
.00
.00
1.00

Unit of

=+ Assembly

f= Subordinate Assembly

Insert

Unit Cost

Measure

Lurnp Sum
Lurnp Sum

Lurnp Sum

£2,100.00
£1,000.00
£1,800,00

pAIY
o Resource

%% Resource Asseml

Finc
Total Cost
(Forecast)
$2,100.00
£1,000.00
£1.800.00

1.00
1,00
1,00

1,000.00

200,00

1,000.00

1,00

= O
I z |_8
E =

Fill Down

1.01
1.0

1.00
1.00
1.00
1.00
1.00

1.00
1.00

ey o0

Link this field to Excel

loip ¢ ¥ o=

=0

s il il

UnLink from Excel

Indent

Cutdent

Inzert

Insert Subordinate

Insert Dependent Caost [tem

Insert Cost ltem Assembly

Insert Cost ltem Assembly as Subordinate

Split

9. On the Link to Excel dialog, select the Update InEight Estimate field from Excel radio button.

10. In the Field to link window, select Volume (you may need to click the Refresh ic button for the

field name to display).
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X Link to Excel - o x
When linking to Excel you can choose to have the data in

Excel update an Estimate field or have the data in
Estimate update a named cell in Excel.

(@ Update Estimate Field from Excel fP

(O Update Excel Cell from Estimate 3"

Field to Link: Forecast (T/0) Quantity

O_Ttem 1VolCY _StructuralConcTakeOff A
O_Item2AreaSF_StructuralConcTakeOff
O_Item2VoICY_StructuralConcTakeOff
O_Item3AreaSF_StructuralConcTakeOff
O_Item3VoICY_StructuralConcTakeOff
O_Item4AreaSF_StructuralConcTakeOff
O_Item4VoICY_StructuralConcTakeOff
O_ItemSAreaSF_StructuralConcTakeOff
O_Item5VoICY_StructuralConcTakeOff
O_TotAreaSF_StructuralConcTakeOff

¥_StructuralConcTakeOff
[[ e .

[ Prorate to Superior Item Quantity

[ Group Cell Names by Worksheet

C D?uﬁorfefrmh Pick from Excel
el ames
concel
11. Click OK.

4.2 Linking to Excel

¢ The Forecast Quantity field for Concrete now is linked to the Volume field in Excel and
populates with the take-off quantity (50)

CB5

Position Code  — DeScate

26 Concrete Foundation

Forecast
(Tf0) Quantity

50.00

Urit of
Measure

cY

4.2.3 UPDATE LINKS

When data in InEight Estimate or Excel changes, you can quickly update all links, in just the currently
active job or in all open jobs. Simply select one of the following options from the Workbook drop-

down list on the Estimate tab.
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Estimate Execution System Actions More Actions

!,_= Account Code Utilization 3 Resource Rates ~ m - z o0 =
& Work Breakdown Structures E = Resource Utilization D D %
- Workbook Schedule CashFlow | Indirect
& Resource Cost Details N v Costltems [
akdown Structures Resources Open Job Workbaok re
wn Structure (CBS) Register © ff Update Current Job From Workbook
re to group ﬂfg Update All Open Jobs From Workbook
x Description Optio gj Update Workbook From Current Job ol
de Code| BsU
J08B 83 Update Workbooks From All Open Jobs
Prime Bond PRIM @) Delete Broken Links in All Open Jobs p!
Price % Add-On PRICE & ADD=ON T.00Tomp |
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LESSON 4 REVIEW

1. The Export to Excel feature is available on all register forms in the system and allows you
to export the data currently displayed on a register form to an Excel worksheet.

a. True

b. False

2. In order to link an Excel field to InEight Estimate, the Excel field must be:
a. Named
b. Highlighted
C. Tagged
d. Selected

LESSON 4 SUMMARY

As a result of this lesson, you can:
e Export data from InEight Estimate to Excel
e Link a field in InEight Estimate to Excel

e Update a linked InEight Estimate field with Excel data
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InEight’
ESTIMATE

LESSON 5 — SCHEDULE
INTEGRATION

LESSON DURATION: 45 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
e Set up scheduling options
¢ Update schedule from InEight Estimate
¢ Update InEight Estimate from schedule

¢ Manage changes between estimate and schedule
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5.1 Microsoft Project Estimate Intermediate User Guide

5.1 MICROSOFT PROJECT

5.1.1 SET UP SCHEDULING OPTIONS

Prior to sending information from InEight Estimate to Microsoft Project, you need to make sure the
proper settings are in place.

5.1.1.1 JOB PROPERTIES SCHEDULE TAB

Microsoft Project scheduling options are configured on the Schedule tab of the Job Properties form.

¢ At the top of the Schedule tab, the Integrated Schedule must be set to Microsoft Project

e As a default, the Always use Plug Days when updating InEight Estimate from the schedule
checkbox is not selected (on a job by job basis, this box can be checked later for jobs in which an
estimator does not want updates from Microsoft Project to change the duration and therefore
the cost of your cost items in InEight Estimate)

Job Properties ©

Overview Security Cover Sheet | CostBasis | Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors | Pricing Schedule | Cash Flow Equipment

Integrated Schedule: Microsoft Project - [] Always use Plug Days when updating Estimate from the schedule

Schedule Currency: U.5, Dollar
Cost Item Roll Up

[ Automatically calculate Plug Days when rolling up costitems for scheduling purposes
@ Longest scheduled days among all rolled up costitems

Total scheduled days for all rolled up costitems

Note: When rolling up cost items for scheduling purposes, the Plug Days of the superior costitem
will be recalculated when a change is made to the scheduled days of a subordinate.

To force immediate recalculation of Plug Days for superior cost items, use the ‘Recalculate Plug Days’
button or the 'Calculate Plug Days...' command on the Tools' menu in the CBS Register.

Recalculate Plug Days

5.1.2 SCHEDULE COST ITEMS

Before you can integrate with Microsoft Project, your cost items need to be marked as Scheduled in
InEight Estimate. This is done on the Cost Breakdown Structure (CBS) Register. From your Saved Views
drop-down list in the CBS, the Schedule Setup View displays all of your schedule-related columns.
There are a couple to keep in mind when you schedule your items:
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e Scheduled: This column tells you which of your items are selected to be included in your
Microsoft Project schedule.

¢ Roll Up Schedule: This column lets you check a box to roll up your estimate to the selected level
when it imports into Microsoft Project.

In the below example, notice that all of the cost items are scheduled, but the subordinates for
Unclassified Excavation will be rolled up to the superior level.

Euagﬁun Code Description S g;[:ELl.llllleE
+ 1 Maobilization v‘

+ 2 Clearing & Grubbing Vv

2 3 Unclassified Excavation v v
+ 4.1 Excavation u

+ 3.2 Embankment =

= 4 Aggregate Base +

+ 4.1 Furnish & Haul Base Material o

+ 4.2 Finegrade Subgrade o

E 4.3 Install Aggregate Base o

The following steps walk you through scheduling your cost items.

STEP BY STEP — SCHEDULE A COST ITEM IN INEIGHT ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.

2. In the Saved Views drop-down list, select Schedule Setup View.

Saved views: | Schedule Setup View -

¢ In the Scheduled column, you can select the checkbox for each cost item that you want to
schedule

e If a cost item has subordinate cost items below it, you will only be able to check the
superior cost item, which will automatically schedule the subordinate cost items along
with it
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3. Select the Mobilization, Clearing & Grubbing, and Unclassified Excavation cost items, then

press Tab.
CBS - - Rall Up
Position Code = L=mEiT Scheduled Schedule
2 JOB vy
Prime Bond

Price % Add-On

Job Financing

Indirect Cost Escalation

Direct Cost Escalation

Indirect Cost Add-On

Job Management & Equipment
General Expense

Direct Cost Add-On

+ 1 Mobilization ¥
+ 2 Clearing & Grubbing v
= 3 Unclassified Excavation +
+ 3.1 Excavation ¥
+ 3.2 Embankment v"
= 4 Aggregate Base

+ 4.1 Furnish & Haul Base Material

+ 4.2 Finegrade Subgrade

STEP BY STEP — SCHEDULE A GROUP OF COST ITEMS IN INEIGHT

ESTIMATE

1. In the Training Job, from the Estimate tab, select Cost Breakdown Structure.
2. From the Saved Views drop-down list, select Schedule Setup View.

¢ To schedule multiple cost items, you can highlight the row for each cost item that you
want to schedule, using the Shift and Ctrl keys to select multiple rows.

3. Select additional cost items 4-Aggregate base, 5- Asphalt Concrete Hot Mix, and 6- 36-inch RCP
Culvert Class.

Page 106 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide

—

1P To schedule all cost items, highlight the JOB row

4. Right click on the selected rows and select Schedule Selection.

Unclassified Excavation

Furnish RCP Materials

"

B |+ |+ + (@ + +
N o |0 oo | o o s
§ Blie i a to | b

g

Bax

=]
@

36 Inch RCP Culvert Class ITT

10 Inch PVC Force Main (SDR21)

Ropregae pose = e
i Insert Subordinate

: :- Insert Dependent Cost ltem
t 4 Blue Top :_' Insert Cost ltem Assembly
Asphalt Concrete Hot Mix Type A = Insert Cost ltem Assembly as Subordinate
Furnish & Haul Hot Mix L_.E i
Split
/7« R Install Hot Mix Type A P

™
# |Insert Resource

[= schedule selection |

Cost Breakdown Structure {CBS) Register © E Open
New
Drag columns here to group 0 Delete or....]
CBS £ - -
& aw~
Position Code = Desaiio . Cut
B Co
» e gz
f 2 Paste
Clearing & Grubbing — =
H Fill Down

Link these fields to Excel

ot

Insert Resource Assembly

Toaagle Suspended

Go To Cost Allocation ltem

As-Entered Currency  As-Entered Units

vig

0000030

“E  Unschedule Selectidf®
Calculate Plug Days...
Subtotal Calculator

' Add Quete...

5.1 Microsoft Project

¢ On the Schedule Cost Items dialog, you can select whether or not you want to roll up the
selected cost items to a specific level of the CBS for scheduling purposes

5. Select Schedule selected cost items and their subordinates without rolling them up, then click

OK.

ﬁ-f_::j Schedule Cost Items

To roll the selected cost items up to a specific level of the CBS for scheduling
purposes only, choosethedesired level below.

i@ Schedule selected cost items and their subordinates without rolling them up

(™) Schedule selected cost items rolled up to CBS level: |1

[ oK ] [Cancel]
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¢ Your scheduled cost items will import into Microsoft Project the next time you update
Microsoft Project from InEight Estimate.

5.1.2.2 ROLL UP SCHEDULE

For cost item 3 — Unclassified Excavation, your scheduler does not need all of your estimate details and
wants to roll up your cost items to a higher level when they import into the Microsoft Project schedule.

Follow the steps below to learn how to roll up your cost items for the schedule.

STEP BY STEP — ROLL UP SCHEDULE

1. In the Training Job, from the Estimate tab select Cost Breakdown Structure.
2. From the Saved Views drop-down list, select Schedule Setup View.
¢ Review your cost items to decide which cost items need to be rolled up

3. Select the Roll Up Schedule checkbox on the Unclassified Excavation cost item.

Egsﬁun Code = Description e EED'!ELEIII:'L"E
+ 1 Meobilization +

+ 2 Clearing & Grubbing o

=3 Unclassified Excavation v
+ 31 Excavation

+ 3.2 Embankment D

= 4 Aggregate Base o

+ 4.1 Furnish & Haul Base Material '

+ 4.2 Finegrade Subarade '

E 43 Install Aggregate Base '

+ 431 Place Agaregate Base '

+ 4.3.2 Blue Top Aggregate Base '

5.1.3 UPDATE MICROSOFT PROJECT FROM INEIGHT
ESTIMATE

Now that you have set up your schedule to integrate with Microsoft Project in Job Properties and
scheduled your cost items in the CBS, you are ready to send your project information to Microsoft
Project.
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When you first update Microsoft Project from InEight Estimate, Microsoft Project will create a new
project automatically and load it with the following information from InEight Estimate:

Data Sent from InEight Estimate to Microsoft Project

Data Type InEight Estimate Microsoft Project
Project Data Job Code Project Name
Activity Data CBS Position Code 01 - CBS Position Code
Description Description
Days (Duration Driven) Duration

Cost Data Cost Category Total Cost Cost Category (custom text columns)

The following steps walk you through updating Microsoft Project from InEight Estimate to create a new
schedule.

STEP BY STEP — UPDATE MS PROJECT FROM INEIGHT ESTIMATE

1. From the Estimate tab, select Schedule>Update Project from InEight Estimate.

Training Job - Estimate]

Estimate ¥Ea System Integrations Actions More Actions
ﬁ L—_ Account Code Utilization ‘3 E; Resource Utlization m - f (]| Job Finance = Epé Direct
— el
!.2 Work Breakdown Structures - E» Resource Cost Details oo % Price % Add On G|3 Indire
Cost Breakdown Resources Workbook Schedule  Cash Flow Indirect Price Breakdown |
Structure (CBS) = £7] Resource Employments = = CostItems [£8] Prime Bond Structure (PBS) = Datal
Breakdown Structures Resources Workbook Il El Open M5 Praject (Cost Overhead and Proi
Cost Breakdown Structure (CBS) Register © | 8k Update Estimate from Project
Drag columns here to group | &P Update Project from Estimate
CBS - Destrint Optional Export Copy of MS Project File | Total Cost R
Position Code = Enni] Code Loy Quanuy [CEEy ({Forecast) LI =Ries
5> = 108 20,00 Mile $294,133.13  $5,882,762.51
Prime Bond PRIME BOND 1.00  Lump Sum $47,148.68 $47,148.68
Price % Add-On PRICE % ADD-ON 1.00  Lump Sum $295,638.13 $295,638.13
Job Financing FINAMCE EXPENSE 1.00  Lump Sum $33,105.26 $33,105.26
Indirect Cost Escalation INDIRECT COST ESCALATION 1.00  Lump Sum $2,131.11 $2,131.11
Direct Cost Escalation DIRECT COST ESCALATION 1.00  Lump Sum $15,048.80 $15,048.80
Indirect Cost Add-On 1.00  Lump Sum $5,338.67 §5,888.67 $294,433.42
Direct Cost Add-On DIRECT COST ADD-ON 1.00  Lump Sum $104,088.34 §104,088.34  §5,204,417.24
=1 SITEWORK & ROADWAY 200 1.00 Each $2,964,161.56  $2,464,161.56
+ 11 Mobilization 8410100 1.00  Lump Sum $11,909.51 $11,909.51
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¢ Your job automatically opens in Microsoft Project
e The Work Breakdown Structure Layout displays for the project

¢ You can see the breakdown structure imported from InEight Estimate with durations,
rolled up as specified by the Roll Up Schedule option in InEight Estimate

e |Initially, the start date for your activities is the start date defined on the Job Properties >
Cover Sheet tab (these will change as activity relationships are defined)

H - s Training Job.mpp - Project Standard GANTT CHART TOOLS R x
FILE TASK RESOURCE REPORT PROJECT VIEW FORMAT Bhavna Gupta ~ x

. 2. 4 - -
W oot s WS vaiconTack - . T EERNE
By - B

_ - summary & -
o BT U S A S e w0 Drepeattine [ B @ hieone T ST
View  Clipboard Font = Schedule Tasks Insert Properties Editing -~
D;E'ﬁfns o January 1 March 1 May 1 =
0 L. - Deseription +  Duration w| St - Finish - |25 oz o e 5 =3 sal
o[ ] 0 4 JOB 45 days?| Mon 273120 Fri 43720 = 7
1 1 Mobilization 10 days? Mon 273720 Friz/t4/20 EA
2 2 Clearing & Grubbing 10 days? Mon 273720 Friz/t4/20 i
| s Unclassified Excavation | 1 day? Won 2/3/20° Mon 2/3/20 |
o 4 4 Agaregate Base 45days?|  Mon 273720 Fri4/3/20
41 Furnish & Haul Base Material 45 days? Mon 272720 Fri4fa20
42 Finegrade Subgrade 40 days? Mon 2/3/20 Fri /27120
43 4 Install Aggregate Base 40days?|  Mon2/3/20 Fri 3127120
3 231 Place Aggregate Base 30 days? Mon 273720 Friaraizo
232 Blug Top Aggregate Base 20 days? Mon 273720 FriarzT/z0
10 5 4 Asphalt Concrete Hot Mix Type A 2047 days?|  Mon 2/3/20. Fri 313/20
E 1" 54 Furnish & Haul Hot Mix 2517 days? Mon 272720 Frianarzo
R 52 Install Hot Mix Type A 23.33 days? Mon 272720 Thu 36520
E 13 6 4 36Inch RCP Culvert Class lll 952days?|  Mon 213120 Fri 2114120 vy
Z 1 &1 Furnish RCP Materials £ days? Mon 2/3/20 Fri2m20 ]
IRE &2 Excavate RCP Trench 4,65 days? Mon 273720 Fri2zo B
16 &3 Install RCP Pipe 41 days? Mon 273720 Frizeo B
7 6.4 Backfil RCP Pipe .92 days? Mon 273720 Fri2iarz0 i
L
-
—
4 » 4 »
READY ™, NEW TASKS : AUTO SCHEDULED H B B i -——+

5.1.4 UPDATE INEIGHT ESTIMATE FROM MICROSOFT
PROJECT

You can also bring information back from Microsoft Project into InEight Estimate. When you update
InEight Estimate from Microsoft Project, the following information updates:

Update InEight Estimate from Microsoft Project

Data Type Microsoft Project InEight Estimate
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Update InEight Estimate from Microsoft Project

Activity Data Start Dates Start Dates
Finish Dates Finish Dates

Hours Hours

Walk through the following steps to practice updating InEight Estimate from Microsoft Project. You will
create a scheduling relationship in Microsoft Project and then import the updated dates and
relationships into InEight Estimate.

STEP BY STEP — UPDATE INEIGHT ESTIMATE FROM MS PROJECT

1. Open your version of the Training Job project in Microsoft Project.

¢ In the real world, it is likely that you would have overlapping activities or your activities
would be out of order, however for this example you will link all activities from finish to
start

2. Click on the Link Tasks icon to link all activities.

FH S s Training Job.mpp - Project Standard GANTT CHART TOOLS R x
TASK | RESOURCE  REPORT  PROJECT  VIEW FORMAT Bhavna Gupta * x
ol 2. 4 - -
’E 0 I?é RIS o o] EEMEMESES S MakonTrack - L% ’:_Z" :':::maw m L :,
o ot B0 DA TS H P Brepectlin el Do W Mimtone T o B
View Clipboard Font 7] hEdulE Tasks Insert Properties. Editing ~
o o Link the Selected Tasks (Ctrl+F2) Jsnuary 1 March 1 May 1 f=
@ [ocition - Description ~ | You can link tasks so one can't start | Finish w|| 1215 2 @ W as s sm
0 02 J0B until the other has finished. T = —
' 1] Mobiization Vou can also link tasks in other Friziaz0 [
2 2 Clearing & Grubbing ways, such as a Start-to-Start link Fri 214720 2]
3 3 \:;l::g ;‘:VT‘DEIESKSHEEd to start at the Won 23720 1
4 4 4 Aggregate Base Fri 413120 p—
5 41 Furnish & Haul Base Material 45 days? Mon 2/3/20 Fri 4/3/20
6 42 Fineqrade Subgrade 40 days?| Mon 2/3/20 Fri 327120
7 43 4 Install Aggregate Base 40 days? Mon 2/3120 Fri 3127120
8 431 Place Aggregate Base 30 days? Mon 2/3/20 Fri 313/20|
9 432 Blue Top Agaregate Base: 40 days?| Mon 2/3/20 Fri 327120
10| 5 4 Asphalt Concrete Hot Mix Type A 29.17 days? Mon 2/3120 Fri 313120
E 1" 51 Furnish & Haul Hot Mix 29.17 days?| Mon 2/3/20 Fri 3113/20|
E 12| 52 Install Hot Mix Type A 23.33 days? Mon 2/3/20 Thu 3/5/20
': 13| & 4 36 Inch RCP Culvert Class lll 9.92 days? Mon 2/3/20 Fri 2114/20
‘Z( 14] 6.1 Furnish RCP Materials. 5 days? Mon 2/3/20 Fri 207120
0 15 6.2 Excavate RCP Trench 465 days?| Mon 2/3/20 Fri 27120
16| 6.3 Install RCP Pipe 4.1 days?, Mon 2/3/20 Fri 27120
17] 6.4 Backfill RCP Pipe 9.92 days?| Mon 2/3/20 Fri 2414720
=
‘{ » a4 »
READY —9 NEW TASKS : AUTO SCHEDULED

¢ Ensure the Auto Schedule button is selected

InEight Inc. | Release 24.7 Page 111 of 236



5.1 Microsoft Project

Estimate Intermediate User Guide

3. To update InEight Estimate with this change, go back to InEight Estimate and from the Estimate

tab,

select Schedule>Update InEight Estimate from Project.

Training Job - Estimate]

Estimate Quote Price Execution Integrations More Actions
ﬁ L—_ Account Code Utilization e 'E'_-‘. Resource Utilization m L} D D Job Finance = @u’i Direct
— b —
!.= Work Breakdown Structures - f Resource Cost Details oo % Price % Add On [-E] Indire
Cost Breakdown Resources Workbook Schedule  Cash Flow Indirect Price Breakdown |
Structure (CBS) - £5] Resource Employments - - Cost Items  [£8] Prime Bond Structure (PBS) = Datal
Breakdown Structures Resources Workbook B‘ Open MS Project Cost Overhead and Proi
Cost Breakdown Structure (CBS) Register @ | 9 Update Estimate from Project
Drag columns here to group §®  Update Project from Estimate
c8s - Sescrtion Optional (5] Export Copy of MS Project File Total Cost et
Position Code = P Code [TPorQuanuy MEGSOrE (Forecast) &
- H JoB 20,00 Mile $294,138.13 $5,882,762.51
Prime Bond PRIME BOMD 1.00 Lump Sum $47,148.68 $47,148.68
Price % Add-On PRICE % ADD-ON 1.00 Lump Sum §295,638.13 $295,638.13
Job Financing FINANCE EXPENSE 1.00 Lump Sum $33,105.26 $33,105.26
Indirect Cost Escalation INDIRECT COST ESCALATION 1.00 Lump Sum $2,131.11 $2,131.11
Direct Cost Escalation DIRECT COST ESCALATION 1.00 Lump Sum $15,048.80 $15,048.80
Indirect Cost Add-On 1.00 Lump Sum §5,888.67 $5,888.67 $294,433.42
Direct Cost Add-On DIRECT COST ADD-OM 1.00 Lump Sum $104,088.34 $104,088.34 $5,204,417.24
21 SITEWORK & ROADWAY 200 1.00 Each $2,964,161.56 $2,964,161.56
+ 11 Mobilization 6410100 1.00  Lump Sum $11,909.51 $11,909.51

e On the Schedule Setup View, you can see the Start and Finish dates updated from MS

Project.

goszﬁon Code Description Start Finish E::r‘;

+ 1 Mobilization 2/3j2020  2(14/2020  2{3/2020

+ 2 Clearing & Grubbing 217/2020 2282020 2/17/2020
I e T S

+ 31 Excavation 3/2/2020  3f2/2020 3/2/2020

+ 32 Embankment 3/2/2020  3f2/2020 3/2/2020

= a Aggregate Base 3/3/2020  10/5/2020  3(3/2020

+ 4.1 Furnish & Haul Base Material 3f3/2020 5/4/2020 332020

+ 4.2 Finegrade Subgrade 5/5/2020 6/29/2020 5/5/2020

= 43 Install Aggregate Base 6/30/2020  10/5/2020  &/30/2020
+ 431 Place Aggregate Base 6/30/2020  8f10/2020  &/30/2020
+ 4.3.2 Blue Top Aggregate Base 8112020  10/5/2020 8112020
=5 Asphalt Concrete Hot Mix Type A 10/6/2020  12/17/2020  10/6/2020
+ 51 Furnish & Haul Hot Mix 10/6/2020  11f16/2020  10/6/2020
+ 52 Install Hot Mix Type A 11/16/2020  12/17/2020  11/16/2020
= 6 36 Inch RCP Culvert Class III 12/17/2020  1/20/2021  12/17/2020
+ 6.1 Furnish RCP Materials 12/17/2020  12/24/2020  12/17/2020
+ 6.2 Excavate RCP Trench 12/24/2020  12/31/2020  12/24/2020
+ 6.3 Install RCP Pipe 12/31/2020  1f6/2021 12/31/2020
+ 6.4 Backfil RCP Pipe 1/6/2021 1202021  1f8/2021
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Early Late Late
Finish Start Finish
2/14/2020  Zj3/2020  2/14/2020
2/28/2020  2/17/2020  2/28/2020

3/2/2020  3f2/2020  3{2f2020
3/2/2020  3f2/2020  3{2f2020
10/5/2020  3(3/2020  10/5/2020
5/4/2020  3f3/2020  5/4/2020
6/29/2020  5/5/2020  6/23/2020
10/5/2020  6/30/2020  10/5/2020
8/10/2020  §/30/2020  8/10/2020
10/5/2020  8/11/2020  10/5/2020
12/17/2020  10/6/2020  12/17/2020
11/16/2020  10/6/2020  11/16{2020
12/17/2020  11f16/2020  12/17/2020
1/20/2021  12{17/2020  1f20/2021
12/24/2020  12{17/2020  12/24{2020
12/31/2020  12(24/2020  12/31/2020
1/6/2021 | 12312020  1f6/2021
1/20/2021  1f6/2021  1f20/2021
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5.1.5 EXPORT COPY OF MS PROJECT FILE

If your project’s schedule is integrated with MS Project, you can export a copy of your MS Project file.
This can be advantageous if a preliminary schedule is needed for a starting point schedule, as the
project goes into execution. Recreating the schedule from scratch can be time consuming and error

prone, as the existing schedule details might not be properly captured in the beginning stages.

Estimate Quote Price

Execution

System Integrations

Actions

Training Job - Estimate]

More Actions

ﬁ '_—. Account Code Utilization e E; Resource Utilization m -_ Z D D Job Finance :’: '?;’i Direct
%a: Work Breakdown Structures - £ Resource Cost Detalls - oo 94, Frice % Add On f— @ Indire
Cost Breakdown Resources Warkbook Schedule | Cash Flow Indirect Price Breakdown
Structure (CBS) é:l Resource Employments - CostItems  [-9] Prime Bond Structure (PBS) = Datal
Breakdown Structures Resources Workbook E‘ Open MS Project Cost overhead and Proi
Cost Breakdown Structure (CBS) Register @ 81 Update Estimate from Project
Drag columns here to group iﬂ Update Project from Estimate
= e BT Optional Export Copy of MS Project File l Total Cost ErE
‘osition Code Code (Forecast)
=+ B JoB 20,00 Mie $294,138.13 §5,882,762.51
Prime Bond PRIME BEOND 1.00  Lump Sum £47,148.68 $47,148.68
Price % Add-On PRICE % ADD-ON 1.00  Lump Sum $295,638.13 $295,638.13
Job Financing FINAMCE EXPENSE 1.00  Lump Sum $33,105.26 $33,105.26
Indirect Cost Escalation INDIRECT COST ESCALATION 1.00  Lump Sum 52,131.11 $2,131.11
Direct Cost Escalation DIRECT COST ESCALATION 1.00  Lump Sum £15,043.80 £15,048.80
Indirect Cost Add-On 1.00  Lump Sum $5,888.67 $§5,888.57 §294,433.42
Direct Cost Add-On DIRECT COST ADD-OM 1.00  Lump Sum 5$104,083.34 $104,088.34 §5,204,417.24
21 SITEWORK & ROADWAY 200 1.00 Each $2,464,161.56 $2,464,161.56
+ L1 Mobilization 6410100 1.00  Lump Sum §11,909.51 §11,909.51

5.1.6 MANAGE CHANGES BETWEEN ESTIMATE AND

SCHEDULE

As changes to scope, resources, and costs come up in your estimate, and changes to relationships and
dates occur in the schedule, you can continue updating your estimate and schedule as needed.

5.1.6.3 PLUG DAYS

The Schedule Plug Days option allows you to define the duration in the schedule separate from the
duration defined for your cost items on the Production tab. For example, your 10” PVC Pipe activity

may have extra days in the schedule due to the delivery date of the pipe material, but you don’t want

those extra days to drive the costs in your estimate, since your crews won’t be working on the activity

on those extra days.

TIP

InEight Inc. | Release 24.7

All superior cost items are hard-coded to use Schedule Plug Days.
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STEP BY STEP — SCHEDULE PLUG DAYS

1. Look at the Days (Duration driven) column in the CBS where it shows 4.65 days for Excavate RCP
Trench.

2. Make sure the Schedule Plug Days checkbox is selected on the Excavate RCP Trench cost item,
and then enter a Plug Days duration for the number of days the item will be scheduled in
Microsoft Project (7 days).

CBS

Description Days Schedule Plug

Pasition Code = (Duration driven) Flug Days Days
2 6 36 Inch RCP Culvert Class IIT 18.66 L 26.01
+ 6.1 Furnish RCP Materials 0.00 ' 5.00
|+ 6.2 Excavate RCP Trench 4.65 v‘ ?.[J[JI
+ 6.3 Install RCP Pipe 4,10 41;?
+ 6.4 Backfill RCF Fipe 9.92 9.92

¢ This allows you to maintain your duration of 4.65 days in the estimate and 7 days in the

5.1.6.4

schedule.

Any duration changes made in Project will import into InEight Estimate as Plug Days
automatically so that they can be reviewed by the estimator before making any changes to
production in InEight Estimate.

UPDATE MICROSOFT PROJECT WITH INEIGHT

ESTIMATE CHANGES

The following steps will walk you through updating the schedule with a scope change in your estimate.

STEP BY STEP — UPDATE MS PROJECT WITH INEIGHT ESTIMATE

CHANGES

1. In the InEight Estimate Training Job, from the Estimate tab, select Cost Breakdown Structure.

In this scenario, there is a scope change for your Excavation requiring you to change all of
your quantities

2. Change the quantity in the Forecast (T/O) Quantity field in the CBS as specified below.
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Quantity Change for Cost Item

CBS Code Description Old Quantity New Quantity

5 Asphalt Concrete Hot Mix Type A 35,000 25,000

¢ As you make your changes, take note of how your duration changes in the Days (Duration
driven) column for these items.

e |f prompted about changing Total or Unit Cost, select Change TOTAL cost, so that your unit
costs stay intact

You have changed the quantity for a cost item that already contains costs.
Would you like the TOTAL cost to change or the UNIT cost?

@ Change TOTAL cost

i) Change UNIT cost

I Deactivate this confirmation for quantity changes FOR ALLJOBS
and ALWAYS change the TOTAL cost

To re-activate this confirmation, choose Tools = Adtivate Unit/Total
Confirmation for Quantity Changes.

3. From the Estimate tab, select Schedule>Update Projectfrom InEight Estimate to send the
changed hours to Microsoft Project.

4. Go back to the Training Job in Microsoft Project.

¢ The Microsoft Project scheduled duration should have changed from 4.65 days to 7 days to
match the updated duration in InEight Estimate for Excavate RCP Trench

e You can also see that the days for Asphalt Concrete Hot Mix Type A and its subordinates
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adjusted because you adjusted the Forecast T/O Quantity in InEight Estimate

01-CBS

Position
Code ~ Description - Duration Start - Finish -
0 0« JOB 239 51 days? Mon 2/3/20 Fr 171721
1 1 Wobilization 10 days? Won 2/3/20 Fri 2/14/20
2 2 Clearing & Grubbing 10 days? Mon 217420 Fri 2/28/20
3 3 Unclassified Excavation 1 day? Won 3/2/20 Mon 3/2/20
4 4 Aggregate Base 155 days? Tue 31320 Mon 10/5/20
=) 41 Furnigh & Haul Base Material 45 days? Tue 3320 Mon 5/4/20
6 42 Finegrade Subgrade 40 days? Tue 5/520 Mon 6/29/20
T 4.3 4 Install Aggregate Base 70 days? Tue 630620 Mon 10/5/20
3 431 Place Aggregate Base 30 days? Tue 6/30/20 Mon 8M10/20
g 432 Blue Top Aggregate Base 40 gays? Tue 811/20 Mon 104520
10 B 4 Asphalt Concrete Hot Mix Type A 37.5 days? Tue 10/6/20 Thu 11/26/20
11 5.1 Furnizh & Haul Hot Mix 20.83 days? Tue 10/6/20 Tue 11/320
12 5.2 Install Hot Mix Type A 16.67 days?| Tue 11320 Thu 11/26/20
13 6 4 36Inch RCP Culvert Class lll 26.01 days?  Thu 11/26/20 Fri1M/21
14 6.1 Furnish RCP Materials 5 days? Thu 11/26/20 Thu 12/320
15 I 6.2 Excavate RCP Trench 7 days?l Thu 12/3/20 Mon 12/14/20
15 6.3 Install RCP Pipe 4.1 days? WMon 1214720 Fri12M8/20
7 5.4 Backfill RCP Pipe 5.592 days? Fri12/18/20 Fri1/1i21

5. Your Start and Finish dates are different now. In InEight Estimate, from the Estimate tab, select
Schedule >Update InEight Estimate from Project to update InEight Estimate with the new dates.

Fositon Code Descrpton satmen SN DM SR B

+ 2 Clearing & Grubbing 2/17/2020 | 2282020 | 2/17/2020  2{28/2020 | 2/17/2020 | 2/28/2020
=3 Unclassified Excavation 3/2/2020  3f2/2020 322020 3f2/2020  3/2/2020  3/2/2020

+ 31 Excavation 3/2/2020 | 3/2/2020 | 3j2/020  3f2/2020 | 3/2/2020 | 3[2{2020

+ 3.2 Embankment 3/2/2020 | 3/2/2020 | 3j2/020  3f2/2020 | 3/2/2020 | 3[2{2020

= 4 Aggregate Base 3/3(2020  10/5/2020  3/3{2020  10/5/2020  3/3/2020  10/5/2020
+ a1 Furnish & Haul Base Material 3/3/2020 | 5/4/2020 | 3/3{2020  5/4/2020 | 3/3/2020  5/4/2020

+ 42 Finegrade Subgrade 5/5/2020 | 6/29/2020 | 5/5(2020  6/29/2020  5/5/2020  6/25/2020
= 43 Install Aggregate Base 6/30/2020  10/5/2020  6/30/2020  10/5/2020  6/30/2020  10/5/2020
+ 431 Place Aggregate Base 6/30/2020 8102020  §/30/2020  8(10/2020  §/30/2020  8/10/2020
+ 432 Blue Top Aggregate Base 8/11/2020  10/5/2020  8/11/2020  10/5/2020  B/112020  10/5/2020
=5 Asphalt Concrete Hot Mix Type A 10/6/2020  11/26/2020 10/5/2020  11/26/2020 10/6/2020  11/26/2020
+ 51 Furnish & Haul Hot Mix 10/6/2020 | 11/3/2020  10/6/2020  11/3/2020  10/6/2020  11/3/2020
+ 52 Install Hot Mix Type A 1/3/2020 | 11/26/2020  11/3/2020  11/26/2020 | 11/3/2020  11/26/2020
=6 36 Inch RCP Culvert Class III 11/26/2020  1/1j2021  11/26/2020 11/2021  11/26/2020  1/1/2021

+ 6.1 Furnish RCP Materials 11/26/2020 | 12/3/2020 | 11/26/2020 12/3[2020 | 11/26/2020  12/3/2020
+ 8.2 Excavate RCP Trench 12/3/2020 | 12/14/2020 | 12/3/2020  12/14/2020 | 12(3/2020  12{14/2020
+ 63 Install RCP Pipe 12/14/2020  12/18/2020 12/14/2020 12/18/2020 12142020 12{18/2020
+ 6.4 Backfill RCP Pipe 12/18/2020  1/1/2021  12/182020 1f1/2021 | 12182020  1/1/2021
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LESSON 5 REVIEW

1. Under the Job Properties > Schedule tab, which setting can be enabled to account for
plugged costs (e.g., for subcontractors)?

a. Resource price/unit
b. Expense Costs

C. Schedule ID
d

. Actuals

2. For InEight Estimate schedule integration with Primavera, which of the following can be
sent from your estimate to the schedule? (Select all that apply)

a. Activity data

b. Cash Flow graphs
C. Resource data
d. Cost data

€. Price data

3. The Schedule Plug Days option allows you to define the duration in the schedule separate
from the duration defined for your cost items on the Production tab.

a. True

b. False

LESSON 5 SUMMARY

As a result of this lesson, you can:
¢ Set up scheduling options
¢ Update Schedule from InEight Estimate
e Update InEight Estimate from Schedule

e Manage changes between estimate and schedule

InEight Inc. | Release 24.7 Page 117 of 236



Lesson 5 Summary Estimate Intermediate User Guide

This page intentionally left blank.



InEight’
ESTIMATE

LESSON 6 — CASH FLOW

LESSON DURATION: 25 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
¢ Interpret cash flow and resource utilization on the Cash Flow graph
¢ Select Cash Flow Options

¢ Change Cash Flow Display Settings
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6.1 CASH FLOW OVERVIEW

The Cash Flow form provides a graphical representation of the cash flow and resource utilization of
your project, so you can quickly assess financing and resource needs.

You can open the Cash Flow form by selecting the Estimate tab from the Estimate landing page, then
selecting Cash Flow from the Schedule section.

In order to generate a cash flow curve the estimate must be populated with schedule dates either
directly from integration with Primavera, Microsoft project, or input manually.

Overview - Cash Flow Form

S —————

The graph displays the projected cash flow of your project, along with job financing
expense, individual cost category costs and resource utilization.

The x-axis measures time

The left y-axis measures amounts

The right y-axis measures quantities (when resource utilization is displayed)
All graphs depicted on the Cash Flow form can be displayed based on Pay
Quantity or Forecast (T/O) Quantity

2 Click on the Display Settings icon to indicate what to display on the graph.

» You can display total costs and price or specific cost categories
* You can also set the display settings to report on Resource Utilization

3 Click on the Cash Flow Options icon to specify revenue timing, cost timing, and
cost of money.
4 Click the Excel icon to export the numerical data represented on the graph into an

Excel spreadsheet where you can run additional analysis.
5 You can filter the Cash Flow graph by date range or by a range of cost items.

6 Click and drag over the graph to zoom in on a particular section. Click the Reset
Zoom button to restore the graph to its original state.
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File Setup Estimate Quote Price Execution System Integrations Actions

E!! Print [&] cash Flow Options 3
'%. Preview ﬁ Display Settings o
B Page Setup E Worksheet o

Print Tools
CashFlow @ Q =
$8,000.000.00 I
$6,000,000.00 P
& I
".
£4,000,000.00 - - §
e
%/ ,
$2,000,000.00
-
£0.00 4 | e ——
(52,000.000.00) 2 2
Z < < 2 . = - g a. £
= B B = ey o s ) i s B =
%% O ée% O %o % % %97 % A %‘% -
e v 7 v 7 4 £ 4 £ 7 - e 7 ¢ 4 s
Schedule Last Updated: %/25/2013 5:34 PM Finance Cost: £3,007.32
+vu. Total Cost v, Total Price ___ Total Cost ___ Total Price Cash Flow == Finance Cost
(Forecast) (current) (Forecast) - Cash (current) - Cash
Date Range Cost Item Range Click and drag in the graph Include Finance Cost in this Job's Target Price
area to zoom in manually
Start: Start:
| - : - (O Calculate automatically according to the Cash Flow graph
- - Reset Zoom
End: ~| End: - (® Enter a plug number directly in the PBS
As-Entered Currency  As-Entered Units  w19.1HD_19.1_QA2016  Training Job Accrued Costs OFF

6.2 CASH FLOW OPTIONS

The Cash Flow Options are used to define the cash flow rules (revenue timing, cost timing, cost of
money, and quantities) needed to calculate the finance expense and cash flow for your project.

Cash flow rules (revenue timing, cost timing, cost of money, and quantities) describe how cash flow
occurs between a contractor and a client, and between contractors or owners and
vendors/subcontractors. Cash flow is then calculated based on both the earning and payment terms
you specify, and the job's schedule and pay item prices.

To open the Cash Flow Options, click on the Cash Flow Options - icon in the Tools section of the
Actions tab.

TIP You can also access Cash Flow Options from the Setup > Job Properties > Cash Flow tab.
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1. Revenue timing: Revenue is the amount of money actually paid to a contractor by the client for
the completion of project deliverables. This section contains options to specify when and how
often payment is recieved.

2. Cost Timing: Cost is the amount of money expended to complete the scope of the project. This
section contains options to specify when and how often you pay contractors, subcontractors and
vendors.

\[e] 2 To include any of your costs in your cash flow (including indirect costs), they need
to be scheduled

3. Cost of Money: Represents the financing cost to fund the project. This section contains fields to
specify interest rates you pay for the money you borrow, and interest rates you earn for money
invested, to determine a total Finance Cost.

4. Quantities: Allows you to calculate cash flow based on pay quantities or forecast (T/0)
quantities.

5. Dates: By default, the scheduled Early Start and Early Finish dates of each cost item (and its
resource employments) as listed in the CBS Register, provide the timing of the expenses,
revenue, and costs that show up on the Cash Flow graph. You have the option to base cash flow
timing on Start/Finish dates or Late Start/Finish dates.

Page 122 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide 6.2 Cash Flow Options

Setup = Quote Price Execution System Integrations

H ¥ Bt &ir. 42 a 8 @

£2 Equipment

JobProperties  Foundation  Pay Item &  Bid Wizard

Resource Resource | Costltem Standard | Reports
SetupData = Proposal ates - Materisls  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports ~
Cash Flow Job Properties @

Qverview Seaurity Cover Sheet Cost Basis Minarity Setup Fuel Cost Job Tracking Job Folder Tags Competitors Pricing Schedule L4

Bills are submitted to the owner: Average calendar days elapsed from billing to collection:

(O At the end of the job

Amount of each billing thatis withheld by owner as retainage:

@ Every month on this day Retainageis relaased: (@ At the end of the job
() Every D weeks () On a specific date: -
() Every D days [] Spread revenueusing the same Cost Curves as the contributing Cost Items

Bills are received from subcontractors Average calendar days elapsed from receipt of invoice to payment: days
and vendors:

Amount of each invoice received thatis withheld by you as retainage: s
) At the end of the job bs J °

Retainageis releasedto At the end of the job
@ Every month on this day25__ | R e

) On a specific date: -

Overy [T ke
O Every D days Apply cash timing rules for all procurable cost categories (non labor and equipment),

even if their cost source is not set to "Quote’?

Average annual interest rate paid to borrow money (when cost exceeds

() Pay Quantity
(® Forecast (T/0) Quantity

=10

Early Start / Finish -

Average annual interest rate earned (when revenue exceeds cost):

Reporting Periods

Period setting for cashflow: | Day e

Coneel

6.2.0.1 CASH FLOW OPTIONS SET UP

The following steps walk you defining settings on the Cash Flow Options form.

STEP BY STEP — CASH FLOW OPTIONS SETUP

1. Inthe E101 - Training Job, from the Estimate tab, select Setup >Job Properties >Cash Flow.

Cash Flow

Overview Security Cover Sheet Cost Basis Minority Setup Fuel Cost Job Tracking Job Folder Tags Competitors Pricing Schedule - E L5

¢ You will see the default options already there
¢ You will adjust a few of those options

2. Change your Revenue timing to Every month on the 10th.
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¢ The average calendar days from billing to collection should be set to 25 days

Overview Security Cover Sheet | CostBasis Minority Setup Fuel Cost | Job Tracking Job Folder Tags Competitors | Pricng Schedule Cash Flow

B 2 )

Bills are submitted to the owner: | Average calendar days elapsed from billing to collection: 25 days
At the end of the job Amount of each billing thatis withheld by owner as retainage: 500 %
]
Retainageisreleased: At the end of the job
Every month on this day| ]
O Every weeks () On a spedfic date: -
() Every days [] Spread revenue using the same Cost Curves as the contributing Cost Items

3. For Cost timing, bills are received from subcontractors and vendors Every month on the 25th.

¢ Average calendar days elapsed from receipt of invoice to payment should be set to 30 days

Cost timing o

Bills are recsivad from subcontractors |Averageca|endar days elapsed from receipt of invoice to payment: 30 daysl
and vendors: —
Amount of each invoice received thatis withheld by you as retainage: o
() At the end of the job ’
Retainageisreleasedto (®) At the end of the job
I (@) Every month on this day|25 I subcontractors and vendors:
(O) On a specific date: -

() Every |1 weeks

Apply cash timing rules for all procurable cost categories (non labor and equipment)
1 r
O Every days even if their cost sourca is not set to "Quote"?

4. For Cost of money, enter 10% for the Average annual interest rate paid to borrow money (when
cost exceeds revenue) and 2% for Average annual interest rate earned (when revenue exceeds
cost).

Cost of money o

Average annual interest rate paid to borrow money (when cost exceeds 10,00 =%

Average annual interest rate earned (when revenue exceeds cost): %

5. Leave all remaining options as originally defaulted.
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6.3 CASH FLOW DISPLAY SETTINGS
6.3.1

6.3.2 COST ITEMS AND COST CATEGORIES

The Cash Flow Display Settings allow you to control what information displays on the Cash Flow graph.
To open the Display Settings click on the Actions > Display Settings = icon in the Tools section.

Overview - Cash Flow Display Settings - Cost Items and Cost Categories

S —————

You can save your display settings for future use.

2 Select how the graph measures the timing of your cash flow. Options include: Day,
Week, Month, Quarter, and Year.

3 Under the Cost Items section, you can select:

» Total Cost (Forecast): The total cost of your scheduled cost items, based on
when your costs are accrued (when your cost items are scheduled). This is
displayed as a dashed line on the graph

» Total Price (current): The total revenue of your pay items, based on when
the revenue is earned (when your cost items are scheduled). This is displayed
as a dashed line on the graph

» Total Cost (Forecast) - Cash: The total cost of your scheduled cost items,
reflecting the cost timing you specify in the Cash Flow Options. This is
displayed as a solid line on the graph

» Total Price (current) - Cash: The total revenue of the pay items, reflecting
the revenue timing you specify in the Cash Flow Options. This is displayed as
a solid line on the graph

» Cash Flow: Displays the difference between your Total Cost - Cash and Total
Price - Cash values, so you can see if you are making or losing money

» Finance Cost: Displays the Cost of Money amount calculated from the
settings you specify in the Cash Flow Options

4 You can check the Estimated box for any specific cost categories you need to
display.
» The other check boxes are used for InEight Estimate Performance

InEight Inc. | Release 24.7 Page 125 of 236



6.3 Cash Flow Display Settings Estimate Intermediate User Guide

Cash Flow Display Settings - O X
Categori
|Seﬂ|ngs: | Default I Cost Resources
Planned [] Reseurce Utilization
[] Display this text Gstﬂm report title: Estimated As-Built To Date
Labor O - | - O - Summarize resources by: | Resource Type
9 Owned Equipment 0 O O Get data from:
Rented Equipment [ ] O O
Period Day > | Value Gty Cost AB Gty  ABCost
Cost tems s Umm O NN OB [] Labor
[] Construction Equipment
tTEm' C°50t - Matenials O - | - O - [[] Rented Construction Eq...
Orecas
i [ Installed Material
'tl;:uuh:rlePngoe L] SlEies O O (. O . [ Installed Equipment
[ Supply
Total Cost ] Fees [} [} O :
(Forecast) - Cash [ Unique
Total Price [ Allowance O O e O e
(current) - Cash
Cash Flow Custom Category1 [] (] O
Finance Cost - Undefined [l - [} - OJ - Quantity Cast:
I N
[ s B one one
Total Cost As-Built Quantity: As-Built Cost:
CE-Total Cost
O Earned (to-date) L Nene None
(3] Concs

6.3.2.1 CASH FLOW DISPLAY SET UP

The following steps walk you through setting up your Cash Flow Display Settings.

STEP BY STEP — CASH FLOW DISPLAY SETTINGS SET UP

1. In the E101 - Training Job, from the Estimate tab, select Cash Flow from the Schedule section.
2. On the Actions tab, select Display Settings = to open the Display Settings window.

3. From the Period drop-down list, select Week.

4. Under the Cost Items section, make sure the following are selected:

e Total Cost (Forecast)

Total Price (Forecast)

Total Cost (Forecast) — Cash

Total Price (Forecast) — Cash

Cash Flow
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¢ Finance Cost

Cost tems

ol

Total Cost
[Forecast)

Total Price
[current)

Total Cost
[Forecast) - Cash

v, Total Price

(current) - Cash

| Cash Flow

Finance Cost

Ls-Built
Total Cost

CE-Total Cost
Earned (to-date)

6.3 Cash Flow Display Settings

5. Under the Cost Categories section, check the Estimated checkbox for the Labor and Owned
Equipment categories.
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Cost Categories

Labor

Crhwned Eguipment

6. Click OK to close the Display Settings window.

Your Total Cost (Forecast) displays as a dashed red line, indicating your accrued costs
based on when your cost items are scheduled and the assigned cost curves for each cost
item.

Your Total Price (current) displays as a dashed green line, indicating the revenue you’ve
earned, based on the timing of your pay items

Your Total Cost (Forecast) — Cash displays as a solid red line, indicating your costs, based
on when your cost items are scheduled and the cost timing defined in Cash Flow Options

Your Total Price (current) — Cash displays as a solid green line, indicating your revenue,
based on the timing of your pay items and the revenue timing defined in Cash Flow
Options

Your Cash Flow displays grey bars indicating when your cash flow is negative or positive
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¢ Your Finance Cost displays as a blue line on the graph

$8.000,000.01

$6,000.000.0(

N T efb
ot
54,000,000 i

$2,000.000.0(

$0.00— . — =

(82.000.000.00)

7. To filter your graph by date range, click on the Start drop-down arrow - and select a start date of
your date range filter.

P -, - ‘;,}
Thursday, December 27, 2018 ! %f.;-
4 February 2014 "

sU MO TU WE TH FR 5A

2B 2 28 29 30 31 1
2 3 4 2 & 7 8
9 10 11 12 13 14 15 otal Cost
16 17 18 19 20 21 22 Forecast) - C
23024 25 26 27 2B 1
2 3 4 5 6 7 3
Date Ri Clear
Start: .| Start: | .
End: - | End:

8. Click on the End drop-down arrow - and select an end date of your date range filter.
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e Your graph now only includes your cost items that fall within the specified date range

9. To remove the filter, click in the Start field and press the Backspace key.

10.

Do the same for the End field.

6.3.3 RESOURCE UTILIZATION

You can also use the Cash Flow graph to report on resource utilization. For example, you may want to

run a report that displays a work hours curve for a particular labor trade or to see the peak usage times

for a particular piece of heavy equipment.

You can run resource utilization graphs based off of any of the following:

Resource Type

Resource Code

Description

Organizational Category

Tag1, 2,and 3

Quote Group

Account Code and Cost Item Account Code

Fuel Type

You set up your resource utilization settings from the same Display Settings window you use for setting

up Cash Flow, Display Settings = in the Tools section of the Actions menu.
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Cash Flow Display Settings

Settings: | Previous

[] Display this text as a custom report title:

Pericd

Wesk

Cost kems

Total Cost
(Forecast)

Total Price
(current)

Total Cost
(Forecast) - Cash

Total Price
(current) - Cash

Cash Flow
Finance Cost

As-Built
Total Cost

O CE-Total Cost
Earned (to-date)

Cost Categories

Labor

Owned Egquipment
Rented Equipment
Supplies
Materials
Subcontract

Fees

Allowance
Custom Category1

Undefined

Estimated
||

Asz-Built

O .

O

6.3 Cash Flow Display Settings

O
O
O
O
O
O
O
O

Ooooooood

- O >
Resources
Planned Resource Utilization
To Date %
ml | Summarize resources by: | Description w
0 Get data from: (® This job's utilized resources
(7) Al Library resources
O
Value Gty Cost ABGty ABCo™
[} - [] Dozer D2
[] Dump Fees
O - [] Dump Truck
[ Excavator 225
O -
0 [] Feeder Controls
[ Fine Aoaregate
[ Finisher
O - [ Ratbed Truck
O ] Form Materials w
< 3
O Quantity: Cost:
None ~ None ~
As-Built Quantity: As-Built Cost
None ~ None ~

0K Cancel

6.3.3.2 RESOURCE UTILIZATION DISPLAY SET UP

The following steps walk you through setting up your Cash Flow graph to report on Resource

Utilization.

STEP BY STEP — RESOURCE UTILIZATION DISPLAY SETUP

In the E101 - Training Job, from the Estimate tab, select CashFlow from the Schedule section.

On the Actions tab, select Display Settings = to open the Display Settings window.

Under the Resources section, check the Resource Utilization checkbox.

1
2
3. Make sure the all checkboxes are unchecked under the Cost Items and Cost Categories sections.
4
5

From the Summarize resources by drop-down list, select Description.
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Resources

Resource Utilization

Summarize resources by: | Description

(@) This job's utilized resources
() All Library resources

Get data from:

6. From the resulting list of Values, select Laborer.
7. Click in the Qty field for the selected value and select a color of your choice.

¢ In this case the Qty represents the work hours for your Laborer resource

8. Click in the Cost field for the selected value and select a different color of your choice.

(et data from: (® This job's utilized resources

() All Library rescurces
Value City Cost ABGty ABCo™
[] Labor Foreman
Laborer H i
[] Loader 950
[ 11 owhaoy Trailer

9. From the Quantity and Cost drop down lists, you can select how your quantities and costs will
display on the graph. In this case select the Quantity to display as a Bar and Cost to display as a

Line.
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Value City Cost ABGty ABCo™
[ ] Labor Foreman

tore s s

[ ] Loader 950

[ ] Lowboy Trailer

[ ] Manhole Precast 4 Ft

L4 >

10. Click OK to close the Display Settings window.

¢ The graph now displays the utilization of your Laborer resource, showing the work hours
and costs used over time

$3.500.00 3500

$3.000.00—

$2.500.00 2500

52.000.00— 2000

§1.500.00— —15.00

$1.000.00 —10.00

$500.00—

000 —

The graphs displayed on the Cash Flow form are based on the estimated cost of each cost
item and its resource employments (in the case of resource utilization).
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LESSON 6 REVIEW

1. Under what cash flow form can you set up your revenue and cost timing?
a. Cash Flow Options
b. Display Settings
C. Worksheet
d

. Page Setup

2. By default, the red dashed line on the Cash Flow graph represents the:
a. Total Cost (Forecast)
b. Total Price (current)
C. Total Cost (Forecast) — Cash

d. Total Price (current) - Cash

3. Inthe Cash Flow Display Settings, Resource Utilization allows you to view a graphical
summarization of your resources by which of the following? (Select all that apply)

a. Resource File Description
b. Resource Type

Resource Code
Description

Wage Zone

-~ ® a2 o

Organizational Category

LESSON 6 SUMMARY

As a result of this lesson, you can:

¢ Interpret cash flow and resource utilization on the Cash Flow graph
¢ Select Cash Flow Options

¢ Change Cash Flow Display Settings
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LESSON 7 — INEIGHT ESTIMATE
CALCULATORS

LESSON DURATION: 20 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:

e Use the Haul Calculator
e Use the Trench Calculator

e Use the In-Field Calculator
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7.1 HAUL CALCULATOR

The Haul Calculator allows you to enter the specifics of up to three haul routes (distance, travel speed,
etc.). Once entered, you can either:

¢ Calculate the number of trucks required to complete the haul in a set amount of time, or
e Calculate how long it will take to complete the haul with a set number of trucks

The following activity walks step by step through using the Haul Calculator to calculate the number of
trucks needed for a cost item.

STEP BY STEP — HAUL CALCULATOR - CALCULATE QUANTITY OF

TRUCKS

Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
Open cost item 4.1 — Furnish & Haul Base Material.

On the Cost Item Record, click the Detail tab.

w0 o=

Right click on the ETDT — Dump Truck row header and select Open Haul Calculator.
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Cost Item Summary | S Detail: $11.54 | & Plug:$0.00 | [JQuote: $0.00

Drag columns here to group

Row

Number = Code Resource Assembly

E|” E O
Link this field to Excel
UnLink from Excel

Insert Besource

Insert Resource Assembly

Open Haul Calculator

VEGIY 28 NP M % O [

Edit Resource Periods ..

Description

Teamster

Dump Truck
Agaregate Base Rock

7.1 Haul Calculator

5. On the Haul Calculator, select the Calculate quantity of ETDT required to complete haul in

Haul Calculator Record - Training Job

(@) Calculate quantity of ETDT required to complete haul in duration entered below

(O Calculate total duration of haul using quantity of ETDT entered below

duration entered below radio button. (ETDT is the resource code for the Dump Truck you
selected.)

© © 0o N oo

For the Haul Distance, type 5.

Enter an Average Payload (Ton) of 30.

For Load Time (Minutes), type 3.

Enter a Travel Speed Full of 35 Mile/Hour.

For Dump Time (Minutes), type 2.

InEight Inc. | Release 24.7
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11. Enter a Travel Speed Empty of 45 Mile/Hour. Notice this calculates a cycle time of 20.24.
12. Enter a Work Efficiency of 90 percent.

Route 1
Quantity (Tan) 45,000.00
Haul Distance - One Way (Mile) 5.00
Average Payload (Ton) 30.00
Total Loads 1,500.00
Load Time (Minutes) 3.00
Travel Speed Full (MilefHour) 35.00
Dump Time (Minutes) 2.00
Travel Speed Empty (MilefHour) 45.00
Cycle Time (Minutes) 20.24
Work Efficiency (%) 90.00
Total Hauler Hours 562.17
Hours Per Shift 8.00

¢ The calculator shows a result of 1.56 concurrent haulers

Results

Quantity of resource ETDT 1.56 0.00 0.00 1.56] Concurrent Haulers
Total duration (Hours) 0.00 0.00 0.00 360.00| Hours
e
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13. Click OK.

7.1 Haul Calculator

14. Your cost item now shows a quantity of 1.56. Round up the Quantity to 2. Also, adjust the

Teamster Quantity to 2 (if needed).

Row = Code Resource Assembly Description

MNumber
1 71 Teamster
2 ETOT Dump Truck
3 MER Aggregate Base Rock

Quantity
(Less Waste)

45,500.00

Waste %
Add-on

5.00

Quantity

.00
2.00

47,775.00

Unit of
Measure

Each
Each

Ton

STEP BY STEP — HAUL CALCULATOR - CALCULATE TOTAL DURATION

On the Cost Item Record, click the Detail tab.

o a bk~ w0 DN~

entered below radio button.

Open cost item 4.1 — Furnish & Haul Base Material.

Change your Teamster and Dump Truck quantities back to 2 each.

Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.

Right click on the ETDT — Dump Truck row header and select Open Haul Calculator.

On the Haul Calculator, select the Calculate total duration of haul using quantity of ETDT

¢ With the previous information you entered still there, the calculator calculates a total

duration of 281.08 hours

InEight Inc. | Release 24.7
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() Calculate quantity of ETDT required to complete haul in duration entered below

(®) Calculate total duration of haul using quantity of ETDT entered below

Route 1 Route 2 Route 3 TOTAL
Quantity (Ton)| 45,000.00] | 0.00] | 0.00| 45,000.00 Ton
Haul Distance - One Way (Mile)| S.DIJ| | D.UD| | D.DD| 5.00 | Mile -
Average Payload (Ton)| 30.00] | 0.00] | 0.00| 3000 Ton
Total Loads| 1,500.00] | n.0o] | 0.00| 1,500.00
Load Time (Minutes)| 3.00] | 0.00] | 0.00| 3.00 Minutes
Travel Speed Full (Mile/Hour)| 35.00] | 0.00] | 0.00| 35.00 MilefHour
Dump Time (Minutes)| 200] | 0.00] | 0.00| 200 Minutes
[y Travel Speed Empty (Mile/Hour) 45.00] | 0.00] | 0.00| 4500 MilefHour
Cycle Time (Minutes)| 2024| | 0.00] | 0.00 | 2024 Minutes
Wark Efficiency (%) s0.00] | 100.00] | 100.00| 90.00 %
Total Hauler Hours 562.17 0.00 0.00 562.17 Hours
Hours Per Shift 8.00 8.00 8.00 8.00
Results
Quantity of resource ETDT 0.00 0.00 0.00 2.00| Concurrent Haulers
Total duration (Hours) 281.08 0.00 0.00 281.08] Hours
Cancel
7. Click OK.

¢ The Hours field on the Production tab updated to 281.08

e Your ETDT Dump Truck quantity remains at 2

7.2 TRENCH CALCULATOR

The Trench Calculator allows you to quickly calculate trench, pipe, and bedding values. You can
perform pipe-related take-off by defining the details of the trench (e.g., length, depth, width, hinge
elevation, backslope, and swell factor), the pipe (diameter, elevation, and waste factor), and up to four
beddings.

With this information, the Trench Calculator can automatically calculate:
e Total excavation volume (neat-line)

¢ Total excavation volume (including swell/shrinkage)
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¢ Total pipe to purchase
¢ Lift Volume (for up to four beddings)
e Lift Weight (for up to four beddings)
You can use these calculations to define certain cost item setup data:
* You can use the Total Excavation Volume that is calculated as the quantity of the cost item

e You can use the Total pipe to purchase calculation as the quantity of a resource (e.g., pipe) that
has been employed to the cost item

* You can use the Lift Volume or Lift Weight that is calculated as the quantity of a resource
employed to the cost item in either cubic yards or tons

e You can click the Toggle English / Metric button at the bottom of the dialog to switch between
the English and Metric systems for entering data

TIP You can access the Trench Calculator from the Actions tab of a Cost Item Record
MeJ= When copying cost items in a job or from job to job, the Trench Calculator variable data is

included with the data being copied. When a cost item is copied to the clipboard, Trench
Calculator variable data is also included.

7.2.1 TRENCH CALCULATOR - TRENCH TAB

The following steps walk through using the Trench Calculator to take-off excavation volume.

STEP BY STEP — TRENCH CALCULATOR - TRENCH

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
2. Create a new cost item from the bottom row of your CBS and call it 24” Pipe.
3. Add the following three subordinates and update their Units of Measure:

e Excavate Trench: CY

¢ Install Pipe: LF

e Backfill Trench: CY

4. Open the Excavate Trench Cost Item Record. Add the following resources:
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e LL2 Laborer-1
e LO2 OperatorClass2 -1
e EX245 Excavator 245-1
5. Adjust the Production to: 100 CY/Hour.

CostItem Summary | S, Detail: $1.74 | & Plug:$0.00 | (JQuote:$0.00 | Allocation Production x
Drag columnsFirds | [Search For...] Saved views: | Previous View - Days: 0.00 *
Row . o N Quantity shif-ts: 0.00

Number = Code Resource Assembly Description (Less Waste)
1 L2 Laborer
Man-Hnurs: 0.00
2 Lo2 Operator Class 2
3| Ex245 Excavator 245 EquipHours:|  0.01] 0.00
= cY/pay: 800.00 0.00
CY/shift: §00.00 0.00
| CY/Hour: 100.00 | I 0.00
C¥iMan-Hr:| 50.00/ oo T
‘ [
2 3. 2. 0=, 2
- v o B BB B 2= A

6. On the Cost Item Record’s Actions tab, select Trench Calculator.

Training Job - Estimate

System Integrations

'Ij Trench Calculator

hift / Rate Calculator

e {Delta) Resource Fields 39 Edit Resource Periods

jue (Delta) Cost Item Fields | "= Insert Subordinate

Break Cost Allocation Link

Tools
d @ Trench Calculator
t(Tf0) Qty:  Unit of Measure: Unit Cost: Total Cost: Curren
1.00| | Each §1.74 §1.74| | U.5. D

7. For Trench Length, type 1000.00 feet.
8. For Trench Width (at the bottom) type 4.00 feet.
9. Enter a Trench Depth of 10.00 feet.
10. Enter a Hinge Elevation of 5.00 feet.
11. Enter a Backslope of 45 degrees.
12. Define the Material Swell/Shrinkage Factor (fraction expressed as a decimal) at .10.
¢ You can select either a “neat-line” total volume or include swell/shrinkage

13. Select the “Total excavated volume (including swell/shrinkage)” checkbox.
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Trench Calculator

Trench Fipe Beddings

Variables

Trench length: feet
Trench width (at bottom): feet
Trench depth: m feet
Hinge elevation: _ feet
Backslope: degrees
Materialsv.'ellfshr}L:l:gE (decimal)

Results

Total excavation volume
(neat-ling): 2,407.41 oY

Use this volume as the n
quantity on this cost item

Total excavated volume
(including swelljshrinkage): ~ 2648.15 oY

Use this volume as the
|
quantity on this cost item

Save Configuration to Library Load Configuration from Library Toggle English [ Metric Cancel

14. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

15. Click OK.

7.2.2 TRENCH CALCULATOR - PIPE TAB

You can also use the Trench Calculator to take off how much piping and bedding you need for the
trench.

STEP BY STEP — TRENCH CALCULATOR - PIPE

1. On the CBS Register, adjust the Forecast T/O Quantity for the Install Pipe cost item to 1000 LF.
¢ Assume this quantity is based off manual take-off calculations you already did

2. Open the Install Pipe Cost Item Record.

3. Add the Resource Assembly of CPIPE - Pipe Crew and adjust the production to 300 LF / Day.
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4. On the Cost Item Record’s Actions tab, select Trench Calculator.
5. Select Load Configuration from Library.

6. Select Trench Example (with your initials).

Drag columns here to group Find: | [Search For...] Saved views: | Standard View -
Pipe Pipe Pipe
Mame Comments Dismeter um Type Class Agency Last Changed Last Chang
- Mew Trench Configuration (bla... 0.00 inches
247 PVC Sewer at 10' Deep (1) 26.00 inches 7292009 2:13:19PM  wmfarr
| Trench Example PB 0.00  inches 2/15/2019 11:59:52 AM PauI.Bennl
7. Click OK.

8. On the Trench Calculator, select the Pipe tab.
9. Enter the following for the size and position of the pipe:
* Pipe exterior diameter: 26.00 inches
e Pipe center elevation (from bottom): 19.00 inches
e Waste factor: 10%
10. Click on the resource icon to pull up the Resource Rate Register.
11. Select the Installed Material tab.
12. Select MPP24 Pipe 24” PVC SDR35, then click OK.

¢ The Pipe variables you entered should match the following image:
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Trench Fipe Beddings

Variables

Pipe exterior diameter: 26.00 | inches
Pipe center elevation (from bottom): 19.00| inches
Waste factor: 10.00 | %

Results

Total pipeto purchase: 1,100.00 LF

Use Total Pipe To Purchase
as the guantity on this MPP24
resource {on this cost item):

pe

Save Configurationto Library Load Configuration from Library Togale English / Metric Cancel

13. Click Save Configuration to Library and save the Trench calculator as Trench Example with your
initials.

14. When prompted to overwrite the existing saved file, click Yes.

15. Click OK to close the Trench Calculator.

7.2.3 TRENCH CALCULATOR - BEDDINGS TAB

The following steps walk you using the Trench Calculator to calculate bedding take-offs.

STEP BY STEP — TRENCH CALCULATOR - BEDDINGS

1. Back on the CBS Register, adjust the Forecast T/O Quantity for Backfill Trench to 2300 CY, based
on manual calculations.

2. Open the Backfill Trench Cost Item Record.

3. Add the following resources:
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e LL2 Laborer -3
e LO2 OperatorClass2 -1
¢ RPC Plate Compactor—1
e EL950 Loader 950 -1
Adjust the Production to 160 CY/Day.
From the Cost Item Record’s Actions tab, select Trench Calculator.
Select Load Configuration from Library
Select Trench Example (with your initials), then click OK.

On the Trench Calculator, select the Beddings tab.

© 0 N o 0 &

On the Beddings tab, you can define up to four beddings to backfill the trench
¢ The variables you enter will determine how much bedding you need

10. Enter the following variables for each bedding:

_ Bedding Lift 1 | Bedding Lift 2 | Bedding Lift 3

Elevation (from trench floor) 6.00 38.00 76.00
Additional material needed 5.00 5.00 5.00
Conversion factor 1.60 1.70 1.60

¢ Under Results, you can match each of the Bedding Lifts with a material resource, by
selecting the resource icon and selecting the resource you want to employ from the
Material tab

11. Selecting the resource from the Tons selection field, select the following materials for each
bedding:

- Resource Code | Resource Description

Bedding Lift1 MASAND Sand
Bedding Lift2 MAFA Fine Aggregate
Bedding Lift3 MACA1-1/2 Coarse Aggregate
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Trench | Fipe Beddings |

(@ Bedding Lift 1 () Bedding Lift2 (O Bedding Lift3 (O) Bedding Lift4

Variables

Elevation (from trench floor): inches

Additional material needed to - o

compensate for compaction: m ot
Conversion factor (TON per CY}):

Results
Lift Volume: 77.78 Y
Use Lift Volume as the quantity on | :|
this resource {on this cost item):
Lift Weight: 124.44 Tons
Use Lift Weight as the quantity on | MASAND 2 |
this rezource (on this cost item):
| Save Configurationto Library | | Load Configuration from Library | | Toaggle English f Metric 0K | | Cancel

12. Click OK.

* Note that the pipe and bedding materials are added to the cost item with their quantities

:3%)&', = T | Code Resource Assembly Description ?Lzz‘imt;sbe} Awdads-fn% Quantity a:i;::re

1 U2 Laborer 3.00 Each
2 Loz Operator Class 2 1.00  Each
3 RPC Plate Compactor 1.00 Each
4  ELS50 Loader 950 1.00 Each
5 MASAND Sand 124.44 0.00 124.44 Ton
6 MAFA Fine Aggregate 593.66 0.00 583.66  Ton

MACAL... Coarse Aggregate ... 3,327.59 0.00 3,327.59  Ton
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EXERCISE 7.1 — TRENCH CALCULATOR

In this exercise, you will practice using the Trench Calculator to take-off piping and bedding
materials. Complete the following steps:

1.

In the Training Job, create a new cost item called Underground Pipe.
Give the cost item a quantity and unit of measure of 1640 Linear Feet.
3. Open the new cost item and open the Trench Calculator.

4. On the Trench tab, enter the variables for the trench:

Trench length 1000 feet

Trench width (at bottom) 4 feet
Trench depth 10 feet
Hinge elevation 5 feet
Backslope 45 degrees

Material swell/shrinkage factor 0.10 (decimal)
e Do NOT check the box to bring in volume shrinkage.
5. Select the MPR36 material resource from the drop-down Results list.

6. On the Beddings tab, enter bedding variables.

Bedding lift 1

Elevation (from trench floor) 6 inches

Additional material needed to compensate for compaction 5.00%

Conversions factor (Ton per CY) 1.3
Bedding material resource (Tons) MASAND
Page 148 of 236
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Bedding lift 2

Elevation (from trench floor) 38 inches
Additional material needed to compensate for compaction 5.00%
1.1

MAFA

Conversions factor (Ton per CY)

Bedding material resource (Tons)

Bedding lift 3

Elevation (from trench floor) 76 inches
Additional material needed to compensate for compaction 5.00%
1.1

MACA1-1/2

Conversions factor (Ton per CY)

Bedding material resource (Tons)

7. Select OK and confirm that the pipe material and bedding materials populated the cost
item.

You should end up with the following results

‘Cost Breakdown Structure (CBS) Register Cost Item Record © -
CBS Code: Optional Code:  Description: Forecast (T/0) Qty:  Unit of Measure: Uit Cost: Total Cost: Currency:
w2 | | |undergmund Pipe | | 1,mn.nu‘ [1F - $34.59 $56,734.45
PIAssignment:  PILine Number: PIDescription: Cost Segment: Pay Quantity: Cost Source: Alternate:
O e Job Overhead - 1,640.00 | Detal - | [Base -
- ; . _
Cost Item Summary ‘ £ Detail: $34.59 | & Plug: $0.00 | (I Ouote : 0.00 | allocation ‘lelllctmn x |
——— id: [BeachPord ] Saved views: v Drven
Hourly
Row . Quantity Waste % ! Uniit of Duration Driven Resources Resources
Number = Code Resource Assembly Description {Less Waste) Frieen Quantity [=ere
Customize Display
1 MPR35 Pipe RCP 36 In 1,000.00 0.00 1,000.00 | Linear Feet Do oo A
2 MASAND Sand 10111 0.00 10111 Ton
Shifts: 0.00 0.00
> 3 MAFA Fine Aggregate 384.13 0.00 334.13 Ton
4| MACAL.. Coarse Aggregate ... 2,153.15 0.00 2,153.15 Ton Eious: 0.00| 4 00
* Man-Hours: 0.00 0.00
Equip-Hours: 0.00 0.00
LF/Day: 0.00 0o v
“« .
) a & = & -
) & BB B2z 8. =
[ ok ] [ concel | [ <Prev Next » |

Congratulations, you have completed this exercise!
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7.3 IN-FIELD CALCULATOR

You can use the In-field Calculator to do simple mathematical calculations in any numeric field on
records, registers, and tree lists. You use this calculator much like an Excel workbook field, by inserting
the cursor in the field where you want to perform a calculation, then pressing the "=" key, followed by
a valid arithmetic expression. To display the calculated result, you press the tab key. The resulting
value is stored without the arithmetic expression used to calculate the value.

The following steps walk through using the In-field Calculator to calculate the area of how much
sandblasting is needed for painting the steel bridge structure specified in the Training Job.

o) g= The resulting field value is stored without the arithmetic expression used to calculate the
value.

STEP BY STEP — IN-FIELD CALCULATOR

1. Open the Training Job and from the Estimate tab, select Cost Breakdown Structure.
2. Scroll to find cost item 13.3 Sandblast.
3. Click in the Forecast (T/0) Quantity field.

e il - — I e e |
=2 13 Paint Existing Steel Bridge Structure 1.00  Lump Sum
+ 131 Setup Equipment 1.00  Lump Sum
+ 13.2 Wash-Remove-Dispose of Water 25.000,00  Sguare Feet
. =
+ 13.4 Apply Primer 25,000.00 @ Square Feet
+ 13.5 Paint Top Coat 25,000.00  Square Feet

4. Press the = key, then type 10*250.
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= 13 Paint Existing Steel Bridge Structure 1.00 | Lump Sum
+ 13.1 Setup Equipment 1,00 Lump Sum
+ 13.2 Wash-Remove-Dispose of Water 25,000.00 Square Feet
+ 134 Apply Primer 25,000.00  Sguare Feet

5. Press the Tab key and it calculates the result.
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LESSON 7 REVIEW

1. The Haul calculator allows you to:

a. Calculate the number of trucks required to complete the haul in a set amount of
time

b. Calculate how long it will take to complete the haul with a set number of trucks
C. Neither

d. Both

2. The Trench Calculator allows you to quickly calculate values.

a. Trench
b. Pipe

C. Bedding
d

. All of the above

3. For the in-field calculator, what symbol needs to be at the beginning of the math
equation for it to calculate?

a. +
b. -
C. =

d. (

LESSON 7 SUMMARY

As a result of this lesson, you can:
e Use the Haul Calculator
e Use the Trench Calculator

e Use the In-Field Calculator
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LESSON 8 — ADVANCED PRICING

LESSON DURATION: 40 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:

e Use advanced pricing options including: alarm limits, subtotals, rounding precision, and Fixed
Final Price

e Create and compare alternates for cost items and pay items

e Use Billing Rates

8.1 ALARM LIMITS

The Alarm Limits lets you establish limits to specific pay items to make sure the pricing is within certain
limits, i.e. percentage or unit price. The Alarm Limits do not do any calculations. It informs you if either
of the limit types are outside the range. If outside the limits, the row is then colored red.

For example, when pricing Mobilization, there can be limits as to the amount that can be entered and
how soon to receive payment. In the screen shot below, you can enter up to 10% of the contract price
and receive that amount when 5 or 10% of the work is completed.

Pay Item and Proposal register:

Find: | [Search For...] | Savedy
mm I';OG. Row Line: Description Pay Uinit of Eh'. Price T_O'A Df:(e % Job % Job Unit Price: Linit P|.r:¢
e Humber MNumber Quantity Measure (eurrent) (current ) Max, Alarm Min, Alarm hacx. Alsrm M, Alarm
< |+ 6410100 1 10 Mobikzation 1.00  Lump Sum $386,800.00 $386,800.0 0 8.00 0.00
+ 2010102 2 0 Clearing & Grubbing 10.00 Acre $6,120.00 $61,200.00 0.00 0.00 $0.00 $0.00
+ 2020183 3 Unclassified Excavation 5]'\000.00 Cubsic Yard $8.50 $425,000.00 0.00 0.00 $0.00 $0.00
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In this case, the limits are between 8 and 10%. The row is colored red to indicate that the Unit Price is
not within the percentage limits.

The screen shot below is the record view for Mobilization.

Pay Item Number: " 3-11 0100

Description: Mobilization
Quantity
Lock Quantity:  Pay Quantity: Forecast (TfO) Qty:  Unit of Measure: Qty Variance: Qty Variance %: Qty Variance Group:
0 | 1.00| | 1.00| | Lump Sum . 0.00 0.00 EvenRun
Price
Lock Price: Unit Price Precision:  Unit Price: Total Price: Currency: Payment Method: % Margin:

m -2 (| $386,800.00 | $386,800.00| | U.S. Dolar + | | Unit Price -

Overview | Earnings Rules | Tags /User Defined Fields

Alarm Limits Assignments
Minimum Maximum  |Account: | 1020 -
Percentage of Job: l 8.ED| l lD.DEI‘
Unit Price: | $0.00] | §0.00]

The following is an example for Steel Reinforcement as a Unit Price range.

Find: | [SearchFor..] - | Save
Pay Item Lock Row Line: Descripton Pay Unit of Uinit Price: Total Price % Job % Job Linit Price Uinit Price:
Humber Price Mumber Mumber Quantity Measure ({current) (current) Max. Alarm Min, Alarm Max. Alarm Min, Alarm
+ 800 0400 9 %0 4 Foot Diameter Manhole 16.00 Each $4,500.00 $72,000.00 0.00 0.00 $0.00 50.00
+ S01{A) 1306 10 100 Structural Excavation & Backfil 800.00 Cubic Yard .00 24,000.00 0.00 0.00 $0.00 £0.00
+ S06{A) 1322 11 110 Steel Renforcement b:-.:-:o 00 Pound $1.60 £48,000.00 0.00 0.00 $1.50 Sl.a
+ S03{A) 1313 12 120 Retamning Wal 850.00 Cubic Yard §535.00 £454,750.00 0.00 0.00 £0.00 £0.00

Based on the screen shots, the Unit Price is not within the $1.00 to $1.50 range. It is $1.60.

The record view is now shown.
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Pay Item Number: e 506 A) 1322

Description: Steel Reinforcement
Quantity
Lock Quantity:  Pay Quantity: Forecast (T/O) Qty:  Unit of Measure: Qty Variance: Qty Variance %: Qty Variance Group:
0 | 30,000.00] [ 30,000.00| | Pound - 0.00 0.00 Even Run
Price
Lock Price: Unit Price Precision:  Unit Price: Total Price: Currency: Payment Method: % Margin:

(] 2 $1.60 $48,000.00 | | U.S. Dollar - | | Unit Price .

Overview | Earnings Rules ‘ Tags [ User Defined Fields

Alarm Limits P\ssignments
Minimum A Maximum  Rccount: | 1330 '
Percentage of Job: | Z.’JD| | ~ 0.00
Unit Price: | $1.00| | $1.50

8.2 SUBTOTALS

The subtotal feature is for situations where the Owner wanted subtotals on the proposal form of pay
item groups.

The following screen shot is using the supplied Subtotal register view:

Fing: | [Search For...] = | Saved views: | Sublotsl View
Row Pay ltem Duscription Pay Forecast (T/0) Unit of Uit Price: Total P".:' Subtotal Subtotal Subtotal Running
Number Surmber Quantity Quantity Measure {ourrent) (cuent) Description Amcunt Subtotal Amount
+ 1 6410100 Mobikzation 1.00 100 | Lump Sum $386,800.00  $386,800.00
+ 2 01012 Clearing & Grubbing 10,00 10.00 Age $6,120.00 §61,200.008
+ 3 020183 Unclassified Excawation 50,000.00 50,000.00  Cubic Yard $8.50  $425,000.00
+ 4 0MB12 ‘Aggregate Base 40,000.00 45,000.00 Ten $22.00  $880,000.00
+ 5 034263 ‘Asphalt Concrete Hot Mx Type A 38,000.00 35,000.00 Ton $35.00 $1,330,000.00
+ & 413(8) 0464 36 Inch RCP Cubvert Class 111 1,000.00 1,024.00 Linear Feet $100.00 b SITEWORK & ROADWAY $3,183,000... $3,183,000.00
+ 7 8000220 10 Inch PVC Force Main (SDR21) 12,000.00 12,000.00  Unear Feet $28.00  $336,000.00
+ 8 8000330 24 Inch PYC Granvity Sewer (SDR35) 3,000.00 3,000.00 Linear Feet $64.00  $192,000.00
+ 9 800 0400 4 Foot Dismeter Hanhole 16.00 16.00 Each $4,50000  $72,000.00 v SUBTOTAL: WATER & SEWER $600,000.00 $3,783,000.00
+ 10 501{A) 1306 Structural Excavation & Backfil 800,00 B00.00 | Cubic Yard $30.00 $24,000.

From the Subtotal column, the last item in the subtotal group is where the box is checked. Once the
box is checked, then a description may be entered. After the box is checked, the Subtotal Amount and
Running Subtotal Amounts are then displayed in a bold font.

In our standard Proposal Report, there is an option to printout the subtotals.
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Y

Reports

Job Properties

=*" Foundation Setup Data

& FResources
Resource Register
Resource Changes
Resource Rate Details
Resource Utlization
Resource Utilization (Excel)

Resource Currency Comparisar

i

Reszource Assemblies
Cost Breakdown Structure
Quotes

Price Breakdown Structure

[ e

Pay Item & Propasal
| Standard Proposal I
DOT Proposal

Pay Itemn Summary
Pay Item Currency Comparison

Pay Item Price Breakdown

Settings: | Default

Print | Details Layout Header Footer

Pay Item Numbers
Show Line Number
Show Pay Item Number

Show these fields above the pay items:

[J3ob code [J3obcity
[] 30b Description [J 3ob County
[]Bid Date []3ob state
[]Bid Time [] 3ob Country
[]3ebLocation

Indude

[ Include Cover Sheet

[] include Preferences Sheet

8.2.1 EARNINGS RULES:

Filter by currency: Mo Filter -
Term for Document
(®) Proposal/Bid
() Tender
Qawom [ ]
Show
I Show Subtotals I
[] show Running Totals

[] show Suspended Ttems

Unit Price Predsion

(®) Truncate values based on decimal precision

(C) Do nottruncate values (show decimal precdision)

The Earnings Rules let you decide how much can be paid where certain work is completed. The cost
items assigned to the pay items are where you can decide when to ask for payment.

The application is used in the Job Tracking form. The Earnings Rules also determine how the Cash Flow

curve is generated.

In the following screen shot, the record for 36 inch RCP Culvert Class Il from the Training Job is open.
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Pay Item Number: ™ [413(8) 0464

Description: 36 Inch RCP Culvert Class III
Quantity
Lock Quantity: Pay Quantity: Forecast (‘I'LO) Qty: Unit of Measure: Qty Variance: Qty Variance %: Qty Variance Group:
0 | 1,000.00| *1,024.00 | | Linear Feet - 24.00 240 OverRun
Price
Lock Price: Unit Price Precision:  Unit Price: Total Price: Currency: Payment Method: % Margin:
] 2 ‘ $100.00| $100,000.00| | U.S. Dollar - || UnitPrice - 22.83
Overview Earnings Rules | Tags [ User Defined Fields
Use DefaulgZarmings Rules? [ Assigned Eamnings (Forecast) Unassigned Earnings (Forecast)
% Amount: % Amount:
/ 100.00 $102,400.00 0.00 $0.00
ag ere to group
CcBs o Optional Forecast Unit of . - Earnings
Position Code Desaription Code (T/0) Quantity Measure Eamings % Timing
6 36 Inch RCP Culvert Class IT1 413(B) 0464 1,024.00 Linear Feet 100.00 Percent Complete
= 6.1 Furnish RCP Materials 6.1 1,024.00 Linear Feet 49,58 Percent Complete
6.2 Excavate RCP Trench 6.2 1,858.56 Cubic Yard 12,12 Percent Complete
6.3 Install RCP Pipe 6.3 1,024.00 Linear Feet 17.38 Percent Complete
6.4 Backfill RCP Pipe 6.4 1,587.20 Cubic Yard 20.93 Percent Complete

By default, the cost items in the Earnings % column are calculated based on the cost distribution. In
this case where all the Materials are furnished and completed the Excavation, you have earned $49.58
and $12.12 for a total of 61.7% revenue.

There may be times when you can only receive revenue when you have only completed the Backfill of
the Pipe. In that case | can uncheck the Use Default Earnings Rules box, as seen in the previous screen
shot, and enter 100%. You can then decide when to account for the revenue by changing the Earnings
Timing.

The following screen shot show this option.

InEight Inc. | Release 24.7 Page 157 of 236



8.2 Subtotals Estimate Intermediate User Guide

Cost Breakdown Structure (CBS) Register Pay Item & Proposal Register Pay Item Record ©

Pay Item Number: * 413(B) 0464

Description: | 36 Inch RCP Culvert Class 1l
Quantity
Lock Quantity:  Pay Quantity: Forecast (T/O) Qty:  Unit of Measure: Qty Variance: Qty Variance %: Qty Variance Group:
0O 1.uuu.oo|: 1,u24.uu| Linear Feet - 24.00 240 OverRun
Price
Lock Price: Unit Price Precision:  Unit Price: Total Price: Currency: Payment Method: % Margin:
0 :2 | 5100.00” smu,uuo.uu] U.5. Dollar « || Unit Price . | 22.s3|

Overview Earnings Rules | Tags /User Defined Fields

Use Default Earnings Rules? [:| Assigned Earnings (Forecast) Unassigned Eamings (Forecast)
% Amount: Ve Amount:
/ 10000  $102,400.00 0.00 $0.00
Drag c ere to group
CBS " - Optional Forecast Unit of
Position Code Deacryug Code (T/0) Quantity Measure
6.1 Furnish RCP Materials 6.1 1,024.00 Linear Feet
6.2 Excavate RCP Trench 6.2 1,858.56 Cubic Yard
6.3 Install RCP Pipe 6.3 1,024.00 Linear Feet

7 I8 6. 1,587.20 | Cubic Yard

Another example is when you can get full payment for material on hand, such as Precast Girders. Then
you can choose the start for the Earnings Timing. This way, the Cash Flow shows costs and revenue
occurring at the start of the item.
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EXERCISE 8.1 — SUBTOTAL VIEW

Estimate Intermediate User Guide

Go to the Pay Item & Proposal Subtotal view to view subtotals.

1. Inthe Training Job, add an additional subtotal on the pricing page of your estimate to
appear after Unclassified Excavation.

2. Add the subtotal with the description "SUBTOTAL: EARTHWORK" in the Pay ltem &
Proposal register.

3. Run the Standard Proposal report with subtotals showing.

Congratulations, you have completed this exercise!

8.3 ROUNDING PRECISION

Rounding Precision lets you change the decimal position of the Unit Prices instead of manually entering
the values.

You can preset the Unit Price decimals, then using this feature, round up or down the decimals. The
job’s default Unit Price decimal is set to 2.

There are two decimal selections to understand. In the Settings form from the Backstage View,
Decimal Precision lets you to calculate how many decimals to display.

'::";:{;:I Settings
[=]- Options - N
. General Decimal Precision
Cost Summary Precision |2
- Fax Mail
- Account Code Settings LInit Cost Precision | 2
=] Metwork
- Deployment Mode Quantity Precision |2
- SQL Security
- Security Roles Short Percent Precision |2
- Attachment Settings
--Timesheet Warehouse Settings Lang Percent Precision |2
- Licenses
- CLFFENCY Currency Rate Precision |5

InEight Inc. | Release 24.7
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In the Cost Basis form from Job Properties, use the Unit Price decimal to calculate the Total Price.

Cost Breakdown Structure (CBS) Register Pay Item & Proposal Register Pay Item Record Job Properties ©
Overview Security Cover Sheet CostBasis | Minority Setup | Fuel Cost Job Tracking Job Folder Tags Competitors | Pricing

Standard Shift Arrangements Standard Wage Rate Composite Rules

Lock Cost Items to Pay Items

Work Hours per Shift 8.00 Scale 1: 100.00 | % Pay Item Unit Price Precision: [ 2 l

Pay Hours per Shift: 8.00 Scale 2: 0.00 | 3% l_—-| Activate PBS Changes Log
[C] Activate Quwit\* Checking
Shifts per Day: 1.00 Scale 3: 0.00 | %
? ! :| [[] Maintain CBS Structure at Level: 0
Days per Week: [ S.UDI Shift / Rate Calculator When man-count changes: (@® Change UM / Man-Hour

(O) Change Days

In the following screen shot, the Rounding Precision column is set to 2 for each pay item with the
exception of Mobilization, which was changed to -2. The -2 means to the nearest $100.

Proposal Recap - Copy of Training Job x Item Recap - 202 0183 Unclassified Excavation
Current Target Forecast Variance Balanced Unit | Current Unit
Price: | $6,430,844.00 | $6,430,805.34 | $6,444,775.04 $38.66 QuUT A Price: $6.34 $6.34
Profit: $631,629.85 $631,591.19 $695313.98 | 6372279 |QUT Profit: $0.80 $0.80
Margin%e: 9.82 9.82 10.79 §69,141.3% |QuUT Total Cost: §5.54 §5.54
2 Business Overhead: $0.33
s Job Overhead: 5049
am Unassigned Direct Cost: $0.00
| AssignedDirect Cost: $4.73
|} Find:
Pay Item Lodk Row Line Description Pay Unit of Rounding Unit Price Total Price

Number Number Quantity Measure Precision (current) (current)

110 1.00 | Lump Sum 2|  $18,300.00 $18,300.00
20 2 $58,339.30

- K 33 3| % Undassified Excavation [ 2 | & 00
+ 3035912 4 40 Aggregate Base 40,000.00 Ton 2 $26.73  $1,069,200.00

+ 3034263 5 S0 Asphalt Concrete Hot Mix Type A 38,000.00 Ton 2 $40.89  $1,553,820.00

+ 413(B) 0464 6 60 36 Inch RCP Culvert Class ITI 1,000.00 Linear Feet 2 $12296  $122,960.00

+ 8000220 70 10 Inch PVC Force Main (SDR21) 12,000.00  Linear Feet 2 $28.91 $346,920.00

+ 8000330 & 80 24 Inch PVC Gravity Sewer (SDR35) 3,000.00 Linear Feet 2 $63.84 $191,520.00

+ 800 0400 9 90 4 Foot Diameter Manhole 16.00 Each 2 $4,559.03 $72,944.48

Change the 2 and 3 pay item row's Rounding Precision to 0 and 1. The Unit Price changed accordingly.
In doing so, you are moving the decimal to show tenth, zero, ten dollars, or in the Mobilizations case to
the nearest $100.
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Cost Breakdown Structure (CBS) Register Pay Item & F I Reg © JobProp
Proposal Recap - Copy of Training Job X l ‘mm—mmmm
Current Target Forecast Wariance Balanced Unit
Price: | $6,428,844.70  $5430,80534  $5,42775.74 | §1,95064 ADD A Price: $50.12
Profit: $629,630.55 §631,591.19 469331468 | 46172349 QUT A Profit: $4.73
Margint: [ .79 [ 9.82 10.76 | $67,142.09 |CUT Total Cost: $45.39
A Business Overhead: $2.70
A Job Overhead: $1.79
a Unassigned Direct Cost: $0.01
|  AssignedDirect Cost: $40.89
Drag columns here to group
Pay Item Lock Row 5 Line i Pay Unit of Rounding Unit Price Total Price
Mumber Price Number Number EEnni] Quantity Measure Predsion (current) (current)
+ 6410100 |—| 1 10 Mobilization 100 | Lump Sum -2 $18,300.00 $15,300.00
+ 2010102 ] 2
] 30
n
| |
n
4 aAR AT (| * = A Tk P B R FETOP Y AT ASR A e B - 8 A FVAZ AW AR
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EXERCISE 8.2 — ADVANCED PRICING

SCENARIQ: Using the Training Job, do the following to get ready for your bid closeout meeting with
your manger:

1. Set up rounding precision so all prices round to whole numbers (no decimals).
2. Add subtotals based on the owner's specifications.

3. Add an indicator to show if your unit price for Unclassified Excavation goes over
$18/cubic yard.

Congratulations, you have completed this exercise!

8.4 PAYMENT METHODS

There are three different Payment Methods:

e Unit Price
» Fixed Final Pay
* Time and Expense

Page 162 of 236 InEight Inc. | Release 24.7



Estimate Intermediate User Guide

Pay Item Number: ™ [202 0183
Description: [ Undassified Excavation
Quantity
Lock Quantity:  Pay Quantity: Forecast (T/0) Qty:  Unit of Measure: Qty Variance:
0 [ 50,000.00| [ 50,000.00 | | Cubic Yard . 0.00
Price
Lock Price: Unit Price Precision:  Unit Price: Total Price: Currency:
0 [1 I s6.30] [ $315,000.00| | U.S. Dollar
Overview | Eamings Rules | Tags /User Defined Fields
Alarm Limits Assignments
Minimum Maximum Account: | 1122
Percentage of Job: [ n.nn| | 0.00]
Unit Price: | $0.00] | $0.00]
Proposal Layout Settings

Insert Subtotal after this Pay Item? []

Subtotal Description:

8.4 Payment Methods

Qty Variance %: Qty Variance Group:

0.00 EwvenRun

Payment Method:

« | | UnitPrice T}[

% Margin:
12.05]

M, Type Name

Fixed Final Price

Time & Expenses

x

The Unit Price is the default Payment Method. This option multiplies the Unit Price to the Pay Quantity
to calculate the Total Price.

The Fixed Final Pay method has two applications:

 display contingency type pay items.

» accurately calculate the over/under run pay items that are paid as if they were lump sum

items.

Contingency type pay items is where the owner provided the pay item and entered their own value.
This becomes part of the proposal where it may or may not be used. To identify this type of pay item,
select the Fixed Final Pay method, as displayed in the following screen shot. Then, enter $10,000 for

example.

Pay [hem
Musmber

+ S03(A) 1313
+ 600 0300
+ Mo

+ 1'30:

+ 1m0

+ 1200 0100
+ 15000100

Raowe

Price Mumber Numbesr Ty J;:Imuv ﬂiéﬁe
12 120 Retaining Wal 850.00 Cubic Yard
13 130 Paint Existing Steel Bridge Structure 100 Lump Sum
14 140 Process Equipment L00 Each
15 150 Removal of Underground Storage Tanks 200 Each
16 160 Disposal of Contaminated Soil B00.00 Cubic Yard
17 170 Toll Booth 100 Each
18 180 Guardral Type 2 1,000.00  Linear Feet

Uit Price: Total Price Payment
{current) (current) Methad
$539.91 $458,923.50  Unit Price
$102,683.94 $102,683.94 Unit Price
$1,920,341.67 §1,920,34L.67 Unit Price:
§12,504.82 §25,009.64  Unit Price
$25.96 $20,768.00 Unit Price
$29.665.47 £29.665.47 Unit Price
$IT.29

Type 4 Signs

sﬂﬂ Fest

%14, 780.00

Contingency Pay item Each

$10,000.00

InEight Inc. | Release 24.7
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If this were a real pay item, lock the $10,000 because it must be part of the proposal. However, then
the issue is how to account for any costs, overhead, or profit to this Pay Item. Assuming you did not
want to add any overhead and profit dollars to the $10,000, enter a plug source of $10,000 in the CBS.
This offsets the Price of $10,000 but charges the $10,000 to a Cost Category that won't be used in any
overhead of profit dollars. Now, the $10,000 is not markup.

The second application the Fixed Final Pay method has is to accurately calculate the over/under run
pay items that are paid as if they were lump sum items. An issue occurs where a pay item is provided
with a quantity, such as a Superstructure Bridge of 10,000 CY, and you must enter a Unit Price against
the 10,000 CY.

However, the fine print says that this Pay Item can not be measured and can be paid as if it was a Lump
Sum item, but your quantity takeoff convinced you that you use more or less than the 10,000 CY. Say
your takeoff came to 12,000 CY and you entered the Forecast (TO) Quantity with the 12,000 CY.

Now the CBS is calculated on the 12,000 CY. Now normally in an over/run quantity, InEight Estimate
can help you decide how best to price out these items. In this case, you cannot take advantage of this
situation. The system converts that total cost based on the 12,000 CY. However, you divide by the
10,000 CY to give a different Unit Cost in the Pay Item and Proposal form. This way, when you get paid,
you get the cost as developed in the CBS.

The following screen shot shows the situation where you have an overrun normally. In this example,
you developed the CBS direct cost as $4.00 times 12000 CY for $48,000. (the system shows more
accuracy). Notice the direct costs of $40,000 and the balanced unit of $5.51. This is the normal
calculation if this was a true overrun pay item.

Pay Ttem Deseription Pay Forecast (T/0) Unit of Payment Total Price al Direct Cost Liritt Price
Number Quian Quantity Messure M thod feurrent) (i qty) (balanced
+ M0 Process Equipment 1.00 LO0 Each Uit Price §1,900,341.67 $1,920,341.47 §1,500,196.19 §1,919,910.08
* 1000 Remowal of Undenground Storage Tanks 2.00 2.00 Each Uit Price $12,504.82 §25,009.44 $15,833.35 §12,480.591
* 1010 Disposal of Contaminated Soil BOO.00 BOOUDD  Cubic Yard Unit Price $25.96 20,7 68.00 %13,721L.50 $25.91
#1200 0100 Toll Booth 100 100 Each Uit Price $29,665.47 $29,665.47 $315,269.40 $29.652.33
+ 1500 0100 Guardral Type 2 1,000.00 100000 Linsear Fest Lirit Price $27.2% $27,290.1 £24,004.60 £27.%9
+ 1300 0200 Guardrad Type JA 200,00 200.00 Lmear Feet Uit Price §35.2% $7,050.00 ®,20L19 §35.25
#1600 0230 Type 4 Signs 1,000.00 1,000.00 Square Feet Unit Price $i4.78 §14,780.00 $13,002.49 $14.78
Contngancy Pay item .00 LOU B8 Fooed Final Price $10,000.00 $10,000.00 £0.00 £0.00
[ soover IREE

When you change the Payment Method to Fixed Final Pay, the CBS cost of $48,000 is now shown.
Then when you price out the pay item, you get your $48,000 return.

Page 164 of 236

InEight Inc. | Release 24.7



Estimate Intermediate User Guide 8.4 Payment Methods

Find: | [5
Pay [tem Description Pay Forecast (TA0) Lt of Payment mrP'cF Tatal Price Total Drect Cost Linit Price ) 1
Hurnber Quantity Quantity Measure Method (current) {ourrent) {kd qty) {balanced) (
+ M0 Frocess Equipment 100 .00 Each Uit Price $1,920,341.67 §1,920,341.6 $1,600,195.72  §1,919,807.32
+ 1000 Removal of Linderground Storage Tarks 2.00 200 Each Lirit Price $12,504.82 $25,009. 61 $15,833.35 §12,475.38
+ 1010 Disposal of Contaminated Sod BO0.00 B00O0  Cubic Yard Uik Price $25.96 $20,768.04 $13,721L.50 $25.90
+ 1200 0100 Toll Booth 1.00 100 Each Unit Price §29,665.47 §39,665.4 $25,269.39  $29,649.32
+ 1500 0100 Guardral Type 2 1,000.00 L,000.00  Linear Fest Limit Price 27.39 $27.290. §24,004.60 $27.29
+ 1500 0200 Guardrad Type 34 200,00 200,00 Linear Feet Uit Price §35.25 §7.050.04 $6,20L19 §35.25
+ 1600 0230 Type 4 Signs 1,000.00 1,00000 Square Feet Unit Price $14.78 $14, 780,00 Y:mue $14.78
+ 11 Conbingency Pay item L0 L00 Each ned-Frei-Fro $10,000.00 £10,000 $0.00 \ £0.00
# + [Enter Pay e Superstructure Bridge 10,000.00 12,000.00 ©Y Fruoed Finad Price .00 5.0 $48,009.19 .61
. L

Now for the Time and Expense payment method. This option is used with the Job Tracking form. Each
resource type can enter a Billing rate. For Force Account/Time and Material/Time and Expense work,

by changing the pay item to this method, the actual costs are entered in the Job Tracking form. Then

there is an Excel report that lists the actual costs using the Billing rates, plus the profit entered in the

Job Tracking tab in the Job Properties form.
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8.4.0.1 CRITICAL THINKING - FIXED FINAL PRICE

SCENARIO: You are estimating a reinforced concrete bridge job. For the “Superstructure Concrete”
pay item, the owner provides a quantity of 1000 cubic yards, but in the fine print you read “This pay
item will be paid as if it were a lump sum item; there will be no measurement of the cubic yards.”

You have already done the takeoff and measured 1200 cubic yards for the Superstructure Concrete
and estimated the unit cost, but you know, based on the owner’s fine print, you will only get paid
based on the 1000 cubic yards the owner specified, leaving 200 cubic yards on the table that you
won’t get paid for.

If this were a unit price item, normally you would get paid based on your pay item price, by taking
the unit cost from the CBS, adding overhead and profit, then multiplying that unit price by the
quantity. But since this is being treated like a lump sum, you will only get paid based on the 1000
cubic yards instead of the 1200 you measured.

HOW CAN YOU STILL GET PAID BASED ON THE TOTAL COST
YOU DEVELOPED FOR THIS ITEM IN THE CBS?

A. Add more profit to the pay item to cover the loss in cost.

B. Come up with the pay item’s total price, based on the total cost you determined from 1200 cubic
yards, then divide it by the pay quantity (1000 cubic yards) to come up with the unit price.

C. Come up with the pay item’s unit price, then multiply it by the forecast quantity (1200 cubic
yards) to come up with the total price.

View the following page for feedback
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8.4.0.2 CRITICAL THINKING - FIXED FINAL PRICE

Feedback

HOW CAN YOU STILL GET PAID BASED ON THE TOTAL COST
YOU DEVELOPED FOR THIS ITEM IN THE CBS?

A.
You could do this, but it would make less profit available for other items.

B.
This is a great approach. This ensures you account for all the cost you came up with in the CBS.
When you divide it by the pay quantity, you will have a higher unit price that covers the
overruning quantity you measured.

C.

This is exactly what would occur if this were a normal unit price item and the owner had agreed
to pay you based on the measured quantity. Since the owner is treating this like a lump sun, you
will only get paid based on 1000 cubic yards and miss out on 200 cubic yards' worth of cost.

8.5 UNBALANCED PRICING

The pay items are provided along with the Pay Quantities. If the pay items are to be measured and
paid on the final measured quantity, then we can provide information to price the pay items to
maximize the return. Some specifications are written that if an over/under pay item runs a certain
percent, then the Unit Price is negotiated. Now, understanding this,you can forecast the final revenue
result.

The following screen shot shows a typical over and under run situation. The overrun quantities are
shown in green and the underrun is shown in red. | have balanced priced the job where all pay items
are using their Balanced Unit Price. In the Variance box, the Profit row, there is an ADD of $4153
dollars.
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Proposal Recap - Copy of Training Job

Current | Target | Forecast|| Variance

Price: | $6430,80534 | $643000534 | ssaeesere||  s0.00
Profit: | $6ILSSLIS | 6319019 | $627437.72| | $415347 |ADD
[ Marginw: | 582 | sz | 98] | s1.26513 |cuw

1
2
3
4

Agpregate Base

10 Inch PVC Force Main (SDR.21)

x Item Recap - 303 5912 Aggregate Base

Balanced Unit | Current Unit |

A Price 51887 $18.88
Al Profit: | $195 | $197 |
| Total Cost: | s1651 | $1881 |
A Business Overhead: 5101
A Job Overhead: $0.95
4 Unassigned Direct Cost: $0.00
aa  Assigned Direct Cost £14.55
Find
Pay Forecast (T/0) Unit of Uit Price Total Price Unit|
Quantity Quantity Measure (current) (current) (bala
1.00 1.00 | Lump Sum $18,00.00  $18.300.00 4

This means that if your Forecast Quantities become the final measure amount, | lose the $4153 dollars.
This is the difference between the Target Profit and the Forecast Profit. The issue is the underrun
quantity is priced at its Balanced Price, meaning there is 3000 Ton that | will not be paid for if my

35000 Ton is what | am expecting.

Now, | will use the system’s Unbalanced feature to price all the pay items. See the following screen

shot.

Proposal Recap - Copy of Training Job

x | |nu|uup-mssuwunu

Current Target Forecast Variance
Price: | $6,42884470 | $5430,80534 | se4iz7is74| | s196044  ADD
Profitt | 562943055 | se3s9119 | sesdiess| | sen7mae aur
MarginSe: .7 9.82 10.76 §67.142.08 QUT
rag columns here bo group:
Nanter Gadty e Mabe = hmber | OSORR
+ 5410100 Il ] 1w Moblzation
+ 2010102 1D Clearing & Grubbing
2020183 ] ] 3%
- 4

Aggregate Base

10 Inch PVC Foroe Main (SDAZ1)

'Balanced Unit | Current Unit

Al Price: 51807 $26.73
Al Profit: | s195 | 982 |
Total Cost: $16.91 $16.91
A Business Overhead: $L01
Al Job Overbead: | 5095 |
A |UssssignedDiret Casts | $0.00 |
&  Assigned Direct Cost $1495
Find: l
Pay Forecast (T/0) Unit of Uinit Price Total Price Unit Pr
Quantity Cuantity Measure (current) (ourrent) {balarx
100 100 | Lump Sum $18,300.00  $18,300.00 §u
10.00 10.00  Age

§5,834.00 $58,340.00 3

12,000.00 12,000.00 $28.91  $346,920.00
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What the Unbalanced Autoprice did was to price out the underrun with it’s Direct Cost only. The
overhead and profit share of the underrun was spread proportionately to the overrun items. The
underrun was priced lower than normal and the Overrun items were price higher than normal.

Now look at the Variance block and see the Profit row where it now says CUT, meaning if my forecast
quantities in up being the final measured quantities, | will pick up an additional $61,723 dollars in
profit.

The CUT simple allows you to decide if you want to keep the final Proposal price as shown, or to CUT
the 561,000 OR ANY PORTION of it from the final Proposal amount to get the job believing your
Forecast Quantities is the final measured quantities. Of course you can enter any preferred Unit Price.

8.6 BID PRICING USING BILLING RATES

For Cost Reimbursable or time and expense type projects it might be necessary to produce a bid
proposal based on the billing rates used in the estimate. Choose to price your bid items in the job using
a target price based on either charge rates or billing rates plus a distribution of unassigned costs and
markup.

Training Job - Estimate

Estimate Quote Price Execution System
= Print ./( Saved View:
B Preview ” Biling Rate
Open Ites Expand/  Charge Rate
Colapse ~
Print Edit

Charge Rate and Biling Rate

Pay Item & Proposal Register © - Price Breakdown Structure  ©

P 1 Rs - Trai Job x Assigned Unassigned Total % of
roposaliiecap - Training 3o Pesaipiion siling iing Target
Current Target Forecast | Variance v A Price Breakdown Structure
== i | EE— Tl AtD - A $5,485,362.52 | $1,200,158.59 [ERc- R RIN 100.00
- Markup $0.00 $823,664.72 $823,664.72 12.32
Markup: $984,113.34 | $384,119.62 | $1,041,388.54 | $57,26892 | CUT
v A TargetProfit $0.00  $470,860.96  §470,850.4%  7.04
M i : 4, 4, |
Sl G G 15030 |isness 1pl ) Indirect Cost Markup 000 $28,15177  $28,191.77 0.42
Direct Cost Markup £0.00 $442,677.68 $442,677.68 6.62
v A Busness Overhead $0.00  $352,795.26  §352,795.26  5.28
B8 rice % Add-On $0.00  $285,638.13  $295,636.13 442
Drag ok e 5 Grop Saved views: | Standard Vien myel 09 366 Franeng $0.00  §33,10525  $33,105.26 0.5
oaton P ok Todt 5 - Pm———— 58 Indirect Cost Escalation $0.00 $2,083.55 $2,683.55  0.04
Code = Number Quantity Price oD Quantity Quantity B8 oirect Cost Escalaton $0.00 $21,068.32 $21,068.32  0.32
B 200 . ®|  SITEWORK &ROADWAY - % Business Overhead Items £0.00 $0.00 $0.00 0.0
+ 11 8410100 Mobilization 100 1 « A Totsl Cost $5,485,362.52  §376,493.87 $5,861856.45 87.68
+ 12 2010102 Clearing & Grubbing 10.00 10 ~ A IndrectCost $0.00 $375,993.97 $375,493.97 5.62
+ 13 2020183 Undassified Excavation 50,000.00 50,000 ¥ 4| Job Overhead S0 00} B8 $573, 2957 | 575, 5 07} 5.52
P ey = R prm 58 Prime Bond $0.00 $47,148.68 $47,148.68  0.71
: B8 Indirect Cost Add-On $0.00 $6,851.25 $%,85125  0.10
+ 15 3034263 Asphalt Cancrete Hot Mix Type A 38,000.00 35,000 =
= 58 Direct Cost Add-On $0.00  $109,727.25  $109,727.25 164
2 o = - WATER & SEWER i.'. Job Overhead Items $0.00 $211,766.79 $211,766.79 3.17
+oat 413) 0364 36 Inch RCP Culvert Class I 1,000.00 1,024 « am DirectCost $5,485,362.52 $1,000.00 $5485,3%52.52 8205
+ 22 8000220 10 Inch PVC Force Main (SDR21) 12,000.00 12,000 @4 Direct Cost Items $5,485,362.52 $1,000.00 $5,486,362.52 B2.06

LESSON 8 — ALTERNATES
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8.1 ALTERNATE SCENARIOS

The Alternate scenarios feature allows a contractor to effectively evaluate multiple approaches to an
estimate, and quickly identify the most cost efficient way of performing the proposed work. Both
owners and contractors need more visibility to see the impact of changes made to the assumption
made on the cost model.

For example, a contractor might want to estimate the cost of hauling excavation material using a
scraper hauling machine(s). Alternatively, a contractor may want to compare the cost of loading and
hauling that same excavation material with a loader truck(s). You should be able to estimate both
approaches quickly and switch between various scenarios.

Owners are increasingly requiring contractors to provide alternative items within the bid proposal.
Contractors should consider the cost impact of alternative estimate approaches, while also
contemplating how to effectively price their work.

The primary purpose for using Alternate Scenarios is to create ‘What If’ type of scenarios to gain a
better view of estimating ‘like’ situations. By defining Alternates, you have the ability to compare
multiple scenarios within an estimate, in which you can suspend or unsuspend various records.

TIP Manually suspending and unsuspending items can be time consuming and error prone,

and can require maintenance of several versions of the estimate. Creating Alternate
Scenarios is a solution to this problem.

8.1.1 BASE ALTERNATE

Base Alternate refers to your base or anchor estimate and is part of the estimate’s cost.

CBS Forecast Suspended

oo = ot o T & R e R T s
= JoB 20,00 Mie $298,546.40 $5,970,927.99 | BASE BASE ] u
Prime Bond 1.00 Lump Sum §47,745.51 $47,745.51 | BASE BASE
Price % Add-On 1.00 Lump Sum $301,009.62 $301,009.62 | BASE BASE
Job Financing 1,00 Lump Sum $0.00 §0.00 | BASE BASE
Indirect Cost Escalat... 1.00 Lump Sum $0.00 $0.00 | BASE BASE
Direct Cost Escalation 100 Lump Sum $11,026,79 $11,026.79 | BASE BASE
Indirect Cost Add-On 1.00 Lump Sum £0.00 €0.00 | BASE BASE
+ Job Management & ... 100 Lump Sum $157,096.28 $157,096,28 | BASE BASE
ar General Expense 1.00 Lump Sum £4,200.00 £4,200,00 | BASE BASE
Direct Cost Add-On 1.00 Lump Sum §106,459.21 $106,459.21 | BASE BASE
+ Mobilization 100 Lump Sum §75,000.00 £75,000.00 | BASE BASE
e Clearing & Grubbing 10.00 Acre $0.00 §0.00 | BASE BASE
| Unclassified Excavati... 50,000.00 Cubic Yard $6.36 $317,915.81 | BASE BASE
+ 3.1 Excavation, scrapers 50,000.00 Cubic Yard §3.00 $145,922.88 | BASE BASE
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8.1.2 ALTERNATES RECORDS

Alternate records are used to define alternate scenarios so that you can assess the impact of those
scenarios.

To access the Alternates form select the Estimate tab. Under the Alternates section, select Alternates.

Execution System

e Setup Quote e Actions More
'ﬂ Account Code Utlization a Resource Rates = — == fi§ Diract Markup Alternate Scenario: r
— ]

E ‘Work Breakdown Structures E; Resource Utilization % Indrect Markup BASE
Cost Breakdown — ‘Workbook Schedule CashFlow | Price Breakdown N Reports
Structure (CBS) £ Resource Cost Details - - Structre (PES) = DataMap 4 Alternates

Breakdown Structures Resources Workbook schedule Owverhead and Profit Alternates Reports

This action opens up the Alternate Record Details form.

T

1. Code Code of Alternate Scenario.
2. Description Description of Alternate Scenario.
3. Active Determines if Alternate Scenario is active

within CBS or not.

4. Total Cost When Alternate is set to active, it will not be

(Added) suspended, and its CBS Total Cost will be
added to the estimate’s Total Cost Forecast.
Below example shows the full $84,000 will be
included in the estimate.

5. Total Cost When Alternate is set to active, Total Cost
(Suspended) Suspended will be $0 because alternate is
active part of bid.

6. Total Cost (Net Difference between Total Cost Added and
Change) Total Cost Suspended.
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Training Job - Estimate

Estimate Quote Execution System m
*
B # B &L % a B B
L - 23 Equipment
Job Properties  Foundation  PayItem & Bid Wizard | Resource __ ) Resource = CostItem Standard Reports
- Setup Data ~ Proposal Rates ~ = Materials Assemblies = Assemblies  Tables
Initialize Resources Assemblies Reports -

Job Properties ©

Job Folder Tags l Competitors l Pricing l Schedule l Cash Flow l Equipment Maintenance l Benchmarking Alternates a
Drag columns here to group Find: | [Search For...] | Saved views: | Previous View -
d . } Total Cost, Total Cost Total Cost

e o D 9 “‘“"Eo (Added) o (Suspendedo (Net Change)o

BASE BASE [v]

ROCK1 Rock Excacation [v] $84,000.00 $0.00 $84,000.00

test 1 testing 1 |_ £0.00 £0.00 £0.00
> .

3

| 0K | ‘ Cancel

8.1.3 ALTERNATES RECORD DETAILS

Drill down into an Alternate Record to view and edit its attributes. The Alternate Record details form
provides you with a way to setup rules for auto suspending and unsuspending groups of cost items.

| Nemes | Desarpion

1. Assigned to Code of Alternate Scenario.
Alternate

2. Suspended by Description of Alternate Scenario.
Alternate
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Comt ek [CB%) Regist Job Prope Altemate Record O

Cade: " |ROCED Description | Rodk Bacavation sere [

Pay Bemw  Tost lbems

Azsigredioditeraie o Totsl Costikdded  ELT9F50.75
Find; | [Baarch Far. ] + | Saved wiend: | v ew
TR Desripbon Dl:l-‘ﬂ'-ﬂ Forecast Hourg Fwn Hourg
Poastion Code (TA0) Quandty [Duration driven] ion }.-u-c-cr ven] (Fotal) l]:va:nnd' )

+ [22 Excavaten, buds __——_—__
a .
Sasarded by BRgmals e Total Codt [Seagended):  LAI31EN

L Find: | [sewdFor...] —  Swved wiews | Previous vew .
[a:3 F—— sl Farerasl ] Haurs Hrs s
Bomtion Code S Code (T 0] GQuansty [Turabior drreen] ftion irabon drrven] (Total) {Duration draver)
=+ (&l Excavabion, STapes il 50,000, 00 125.00 .0 13500

STEP BY STEP — CREATE ALTERNATE SCENARIO IN CBS

1. From the Ribbon, select the Estimate tab.
2. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.
3. Using the Unclassified Excavation cost item, type in Rock Excavation as a new subordinate.
4. Then type in 3000 in the Forecast T/O Quantity column.
5. Under the Unit of Measure column, select Cubic Yard.
= 3 Undassified Excavation 50,000.00 Cubic Yard

+ 3.1 Excavation 50,000.00 Cubic Yard

EEREEEL Embankment 50,000.00 Cubic Yard

+ 33 | RockExcavation 3,000.00 CubicYard |

6. Double click the Rock Excavation cost item to open the cost item's record.

7. Select the Plug tab. Under the Subcontract section click into the Unit Cost field for the

Subcontract Price.

8. Type $28.00 in the Plug Unit Cost column for the Subcontract Price. Once done, click OK.

InEight Inc. | Release 24.7
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Cost Item Summary < Detail: $0.00 &4, Plug:s2so00 | (]

Cost Category Linit Cost Total Cost
v Total $23.00 £84,000.00
» Labor £0.00 $0.00
» Owned Equipment £0,00 £0.00
» Rented Equipment £0.00 £0.00
¥ Supplies £0.00 £0.00
» Materials $0.00 $0.00
» Subcontract £28.00  £34,000.00
Subcontract Price §28.00] $84,000.00
Subcontract Conditions £0.00 £0.00
Subcontract Taxes $0.00 $0.00
Subcontract Bond £0.00 £0.00
Undefined Subcontract £0,00 £0.00
» Fees £0.00 £0.00

9. On the CBS Register, change your Saved Views to Alternates View.

10. Select the Rock Excavation cost item. Under the Alternate column, select the drop down arrow,
and then select the Add icon. This will open up a new form to create a new Alternate record.

t#h Code  Description Active
BASE BASE Yes |
X

11. Type ROCK1 in the Code field, and type Rock Excavation in the Description field. Once done, click
OK.
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()
e

Code: * IRDCI":I Description: IRDCkEICﬂCﬂﬁ'EI'II

Pay Items Cost Items

12. An Attention message will appear alerting you the item will be suspended once you move off the
field.

Attention

You are ordering a scheduled cost item to be suspended. If you
continue, this cost item and any subordinates will be removed from
the schedule. If you later decide to un-suspend the cost item, it wall
return to the schedule beginning on the project start date, and any
scheduling logic will be lost. Do you want to continue?

[] Never ask me this question again

Yes No

13. Select Yes. You see the Rock Excavation item is now in suspended status.

. Forecast - Total Cost Suspended by
Desaription Unit Cost Currency Alternate Al te Suspend

(T/Q) Quantity (Forecast)

Rock Excavation 3,00000 | §28.00 |  $84,000.00 US.Dolar  BASE v

e =0 Suspended status is the default status for alternate items.

14. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

15. Then select the ROCK1 scenario. Once done, click OK. The Suspend check box fields is no longer
checked for Rock Excavation.
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Alternate Scenario:
BASE -
B (Select All)

L")

1)

test 1: testing 1

QK Cancel

Alternate Scenario’s BASE and ROCK1 are now both included in the Total Cost

Forecast in your estimate. This is also known as additive type of alternate, meaning
that when it’s active it will be added to the estimate. When Alternate Scenario Base
+ ROCK1 are both checked, the cost item assigned to the ROCK1 alternate is
included in the Total Cost (Forecast).

ggfmm code = Y | Descripton ?E;aﬂ;imhw ;';::UL Unit Cost ?ﬂ;“:é Currency Alternate ;L'SE;:;” i}‘t‘gf‘:?:db* Suspend
a3 Unclassified [cavation 50,000.00 Cubic Yard $9.95  $497,466.56 U.S.Dollar  BASE - BASE
+ 31 Excavation, scrapers 50,000.00  Cubic Yard $3.00  $149,922.88 U.S.Dolar  BASE BASE
+ 32 Excavation, trucks 50,000.00  Cubic Yard $3.59  §179,550.75 U.S.Dollar  BASE BASE
L 3.4 Rock Excavation 3,000.00  Cubic Yard §28.00  $84,000.00 U.S.Dolar  ROCKL Rock Excacat...
= .
4 103,000.00

16. When only the Base Alternate Scenario is checked, the cost item assigned to the ROCK1
alternate is NOT included in the Total Cost (Forecast). Only base alternates are including the
estimate’s cost.
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CBS Forecast Total Cost Alternate Suspended by

Position Code  — T | Desaiption (T/0) Quantity Unit Cosk (Forecast) Altemate Description Alternate Suspend
=3 Unelassified ation 50,000.00 $8.27  $413,466.56 BASE - BASE
+ 31 Excavation, scrapers 50,000.00 $3.00 514552288 BASE BASE
+ 3.2 Excavation, trucks 50,000.00 $3.59  $179,550.75 BASE BASE
Css RockExcvaton somoo (1806 [ Seas0e] oot Redkesesen I T
O 0
4 100,000.00

TIP When a cost item is assigned to an alternate, it’s then considered an alternate item
in the estimate and does not contribute to the job’s cost until the alternate is
‘activated’.

8.1.4 ASSIGNING MULTIPLE COST ITEMS TO ONE
ALTERNATE

Any number of cost items can be assigned to a single alternate item. The alternate feature can be used
to quickly suspend and unsuspend groups of items. Another manner in which alternates can be used
would be to consider two different approaches to completing the same scope of work. In this case the
activation of an alternate would replace the preselected cost items.

Imagine you are a contractor and want to assign an Alternate Scenario to your 3.2 Excavation Trucks
cost item, and at the same time automatically suspend your 3.1 Excavation Scrapers cost item. You
need an Alternate Scenario view showing what would happen when you suspend Excavation Scrapers,
but want to keep your Excavation Trucks active. You’d like to evaluate this pricing scenario, especially
your Total Cost Forecast.

STEP BY STEP — MULTIPLE COST ITEMS TO AN ALTERNATE

From the Ribbon, select the Estimate tab.
Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.
Create a copy of cost item Excavation and rename it Excavation, scrapers.

Rename the original Excavation cost item to Excavation, trucks.

o k 0N~

Under the Unit of Measure column, select Cubic Yard.
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2 3 Unclassified Excavation 50,000.00
+ 3.1 Excavation, scrapers 50,000.00
+ 3.2 Excavation, trucks 50,000.00
e A Embankment 50,000.00

3.4 Rock Excavation 3,000.00

6. Double click to open the cost item Excavation, trucks.
7. Add a new Construction Equipment Resource: code ETDT Dump Truck, then select OK.
8. Add a new Construction Equipment Resource: code EL950 Loader 950, select OK.
9. Change the quantity of ETDT Dump Truck to 5.
10. Add a new Labor Resource: code LT1 Teamster, then select OK.
11. Change the quantity for LT1 Teamster to 5.
12. Remove resources ES621 Scraper 621, ES623 Scraper 623, LO1 Operator Class 1.
13. Change the quantity for LO2 Operator Class to 5.
14. Change the Cubic Yard/Day to 2800 on the Production tab.

15. Your results should look like this:

Rumber e e B Gty hdgon Qe QNI TR TR e | Uecst
1| ETWT Water Truck 1.00 Each 1.00 44.00 44.00 $29.60
2 ED8 Dozer D8 1,00 Each 100 14286 14286 $173.60
3 ECOMP1 Compactor Smooth ... 1,00 Each 100 14285 14286 $36.40
4 ECOMP2 Compactor Sheeps ... 100 Each 1.00 142.86 14286 $61.60
5 12 Labaorer 1.00 | Each 1.00 142.86 142.86 $26.37
6 04 Operator Foreman 100 Each 100 142.86 7143 $35.72
7 EG14G Grader 146 1,00 Each 100 14286 14286 $60.20
8 Loz Operator Class 2 5.00 Each 1.00 71429 714.29 $28.07
9 EL950 Loader 950 1.00 Each 1.00 142.86 14235 $60.38
10 ETOT Dump Truck 5.00 Each 100 71429 71429 $102.20
11T Teamster 5.00 Each 100 71429 714.29 $30.62

16. The Unit and Total Cost are now recalculated. Once you are done with all your changes, click OK
to return to the CBS register.
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Unit of Measure: Unit Cost: Total Cost: Currency:

Cubic Yard £9.95 §497,466.56 | U.S. Dollar

Cubic Yard - | I £3.59 I| 51?9,55[].?5' .5, Dollar -
Cast Segment: Pay Quantity: Cost Source: Alternate:

Direct Cost 50,000.00 | Detail = | | BASE -

Mides Mimissme

17. Your Excavation, truck cost item is now worth $3.59 a Cubic Yard, while your Excavation, scraper
cost item is worth $3.00 a Cubic Yard.

Postion Code & | Desrton (/o) Quentty  Massure Unecost | (ERLCEy Cureny
= Undlassified Excavation 50,000.00 Cubic Yard $9.95  $497,466.56 U.S.Dolar
+ 3.1 Excavation, scrapers 50,000.00  Cubic Yard $3.00  $145,922.88 U.S. Dolar
+ 3.2 Excavation, trucks 50,000.00 ' Cubic Yard [ $3.59  $179,550.75 | U.S. Dolar

Meyg= In order to make these two cost items mutually exclusive, meaning that you want
one or the other in the bid, you can set this up via an alternate item. You can set

this up so that one is automatically suspended, while the other is active

18. For Excavation, truck, add a new Alternate by click on the Alternate field and selecting the new

icon.
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¢ Code Description Active

ALT 3 ALT 3 Yes
BASE BASE Yes
ROCK1 Rock Excacation Yes

19. Type ROCK2 in the Code.
20. Type in Trucking Excavation for the description.

21. Click on the Cost Items tab. In the CBS Position Code field, select the Excavation, scrapers.
Excavation, scrapers will now be suspended when Alternate Excavation, trucks is active.

=)

Code: * IRD’:KE I Descripkian

Pay [tems Cost Thems

Assigned bo AlTemate

CBS Optiona
Position Code Desicion Code

-

Suspended by Alternate
CRS Optiona
Pasition Cade - Code

............ Excavation, sorapers 3.1

22. An Attention message will appear alerting you the item will be suspended once you move off the
field. Select Yes to continue. On the CBS Register, you now see that Excavation, trucks is
suspended while Excavation, scrapers is activated.
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Attention

You are ordering a scheduled cost item to be suspended. If you
continue, this cost item and any subordinates will be removed from
the schedule. If you later decide to un-suspend the cost item, it will
return to the schedule beginning on the project start date, and any
scheduling logic will be lost. Do you want to continue?

[] Never ask me this question again

Yes hNo

23. In order to activate this alternate item, select the Estimate tab in the Ribbon and go the
Alternate Scenario drop down in the Alternates section.

24. Then select the ROCK2 scenario. Once done, click OK.

Alternate Scenario:
11
BASE+ ROCK2: Rock ... -

B (Select All)

| BASE L
ALT 3

ROCK1: Rock Excacation

ROCK2: Rock Excavation
test 1: testing 1

oK Cancel
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25. The trucks cost item is now active and scrapers has automatically been suspended. Now the
Suspended by Alternate column is checked for cost item Excavation, trucks.

CBS Forecast Unit of Total Cost Alternate

Position Code =52 (T/0) Quantity Measure Cdes: (Forecast) Y Qtoie Desaription
] Undlassified Excavation 50,000.00 Cubic Yard $6.95  §347,543.68 US.Dolar  BASE BASE

+ 31 Excavation, sorapers 50,000.00  Cubic Yard £3.00 $149,922.88 U.5. Dolar BASE

+ 32 Excavation, trucks 50,000.00  Cubic Yard $3.59  $179,550.75 US.Dolar  ROCK2 Rock Excavat...
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8.1.4.1 CRITICAL THINKING - ALTERNATE SCENARIO (OWNER)

SCENARIO: Carla, an estimator at Genco Power is developing an estimate for upcoming maintenance
work at one of Genco’s power plants. She wants to explore two different options for removing and
replacing a feed water system.

In one approach, she assumes that crews will be able to increase access to the work area by cutting
a large access way through the wall of the metal building. This would allow for easier access to the
feed water system that needs replacing. Parts and materials could be staged nearby outdoors and
hoisted into position as they’re needed. Also, crews would be able to access the work area more
readily, streamlining operations.

She also uses another approach, in which Engineering won’t approve plans for increased access by
cutting through the building’s wall. In this case, the replacement of the feed water system will be
more tedious, as workers will need to wind their way through existing plant infrastructure to access
the area in which they will be working. This has a pronounced effect on the crews’ productivity and
their ability to transport and stage materials to the area where the work will be performed.

WHICH OF THE FOLLOWING WOULD BE THE BEST WAY FOR
CARLA TO ESTIMATE BOTH OPTIONS IN INEIGHT ESTIMATE?

A. Create cost items for both options and use the Suspend feature to toggle between them.

B. Use the Snapshot feature to create a second version of the estimate with the second option
estimated. You can compare the original estimate to the snapshot copy of the estimate
containing the alternate option.

C. Create the second option in the same estimate and assign different alternate scenario records to
each option respectively. Control whether the pay item is included using the Alternate Scenario
drop-down.

View the following page for feedback.
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8.1.4.2 CRITICAL THINKING - ALTERNATE SCENARIO (OWNER)

Feedback

WHICH OF THE FOLLOWING WOULD BE THE BEST WAY FOR
CARLA TO ESTIMATE BOTH OPTIONS IN INEIGHT ESTIMATE?
A.

Suspending cost items removes it from the estimate effectively, but this process is more
cumbersome, since you have to suspend each item manually and re- price each time.

This gives you nice visibility of the two versions of the estimate side by side but is a bit laborious
to develop and manage.

This is the most efficient approach. The Alternate Scenarios drop-down makes it easy to select
and de-select alternates, with a few clicks.
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8.1.4.3 CRITICAL THINKING - ALTERNATE SCENARIO
(CONTRACTOR)

SCENARIO: James, an estimator at ADOT, is about to send a project he estimated out for proposal
when he receives word from the environmental technician that the site being developed includes
contaminated soil. He decides to include “Removal of contaminated soil” as an alternate to see if he
can get the cost covered by the contractor.

YOU ARE THE CONTRACTOR SEEKING TO WIN THE
CONTRACT. WHICH OF THE FOLLOWING WOULD BE THE BEST
OPTION FOR DEVELOPING AN ALTERNATE ESTIMATE FOR
THE CONTAMINATED SOIL?

A. Add the “Removal of contaminated soil” pay item, then estimate the contaminated soil in the
CBS and assign it to the pay item. Use the Suspend feature to toggle the pay item on and off,
repricing the estimate each time.

B. Use the Snapshot feature to create a second version of the estimate with the “Removal of
contaminated soil” pay item and estimate included. You can compare the original estimate to
the snapshot copy of the estimate containing the alternate.

C. Add the “Removal of contaminated soil” pay item, then estimate the contaminated soil in the
CBS and assign it to the pay item. Control whether the pay item is included using the Alternate
Scenario drop-down.

View the following page for feedback.
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8.1.4.4 CRITICAL THINKING - ALTERNATE SCENARIO
(CONTRACTOR)

Feedback

WHICH OF THE FOLLOWING WOULD BE THE BEST OPTION
FOR DEVELOPING AN ALTERNATE ESTIMATE FOR THE
CONTAMINATED SOIL?

A.

Suspending the pay item removes it from the estimate effectively, but this process is more
cumbersome, since you have to suspend each item manually and reprice each time.

This gives you nice visibility of the two versions of the estimate side by side but is a bit laborious
to develop and manage.

This is the most efficient approach. The Alternate Scenarios drop-down makes it easy to select
and deselect alternates, and the pricing updates automatically. This is the easiest way to toggle
between scenarios with a few clicks.
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EXERCISE 8.1 — ALTERNATE SCENARIO

SCENARIO: You are a contractor estimating a job for the owner, DECK Corp. Along with the base
items of the proposal, DECK Corp has decided to include a security guard toll booth as an alternate
item in the award of the contract as well.

The request for the alternate, as indicated below, is more of a “would like to have”, to give DECK
Corp the option if it falls within their budget.

¢ Using the Training Job, create an alternate scenario for the Toll Both.
¢ Assign the alternate scenario to your Toll Booth cost items.
¢ Assign the alternate scenario to your Toll Booth pay item.

e Establish pricing for your Toll Both alternative scenarios.

Congratulations, you have completed this exercise!

8.2 PAY ITEM ALTERNATES

An Alternate Scenario is a set of active Alternates that can also be used with Pay Items. It’s reasonable
for the owner to include pay items as alternates within a job. The owner will most likely base the bid
selection criteria primarily on the base bid items, but may also include alternate items in addition.

The contractor will want to understand the cost impact of an alternate if it is awarded. Contractors
may not know ahead of time which combination of alternates an owner may choose to award. This
feature will help the contactor understand how to spread markup to various bid item prices using
different scenarios. This permits easy comparisons between different scenarios.

Imagine you are a contractor and bidding a job where the owner has included a security guard booth
pay item as an alternate item in the job. The owner bases the base bid selection criteria on the base
bid items, however, the owner elects to include alternate items in the award of the contract too. You
as the contractor need to add the new security guard toll booth pay item to analyze the cost impact of
adding this alternate, among other scenarios.

TIP Suspending an item is the same as ‘Deducting’ an item.

The owner’s bid could look like this below, where the first eight pay items are base pay items. The last
Toll Booth pay item is the owner’s Alternate. All items the owner is requesting to see in the
contractor’s bid.
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The one Alternate Construction item below represents a bid item the owner would like to have as part
of the bid as well. However, this one alternate is more of a ‘would like to have’. The Alternate item(s)
help to give the owner the option to accept the Alternates if it still falls within the owner’s budget.

SCHEDULE OF UNIT PRICES

Pay Item#®  Description Qty Uofm Unit Price Amount
503(A) 1313 Retaining Wall 850 cY s 5
600 0300 Paint Existing Steel Bridge Structure 1 s 5 S
700 Process Equipment 1 EA s <
1000 Remowal of Underground Storage Tanks 2 EA S Efﬁ
1010 Disposal of Contaminated Soil 800 CY s 5
15000100  Guardrail Type 2 1,000 LF s s
15000200  Guardrail Type 3A 200 LF 5 5

16000230  Type 4 Signs

TOTAL AMOUNT OF BID: $

SCHEDULE OF UNIT PRICES
Qty Unit Price Amount

TOTAL AMOUNT FOR ALTERNATE CONSTRUCTION: 5

ALTERNATE CONSTRUCTION ITEMS

Pay tem & Description
12000100 8 yard Toll
Booth

STEP BY STEP — CREATE PAY ITEM AND PROPOSAL ALTERNATE

SCENARIO

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. Select the Saved Views drop down arrow and select Alternates View.
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Saved views:

Alternates View

Alternates View

Balanced Price Comparison View

Breakdown Cost Comparison View

Previous View

Price Comparison View

Price Unbalancing View

Profit Comparison View

Quantity Variance Comparison View
Simple View
Standard View

8.2 Pay ltem Alternates

4. Atthe bottom of the register, create a new pay item labeled as Security Guard Booth in the

Description field. Then in the Pay Item Number field, type in SG1.

Hber it | Wamber Mmber  Descrvtion Cuariiy Voaye Gy Mwnaw  pERE |
[+ 210wz | W E Clearing & Grubbing BASE h5E
+ 020183 3 Undlagsified Excavation 5000000 Cubicfard  US.Dolar  BASE BASE
+ 3035912 4 4 Aggregabe Base 40,000.00 Ton U.5. Dolar BaSE BASE
+ 303 4263 5 =0 Asphalt Concrete Hok Mux Type A 38,000.00 Ton U5, Dolar BASE BasE
+  413(B) 0464 & B0 36 Inch RCP Cubvert Class I 100000 Linear Feet  U.S.Dollar  BASE BASE
+ 8000220 7™ 10 Irveh PVC Feree Main (SOR21) 12,000.00 LiresrFest  U.S.Delar  BASE BASE
+ 8000330 - 24 Inch PVC Gravity Sewer (SDRIS) 300000 LinearFeet  U.S.Dolar  BASE BASE
+ BO00 0400 9 w0 4 Foot Diameter Manhole 16.00 Each us, Dollar  BASE BASE
+ SON{A) 1306 10 100 Struchural Excavation & Badkfil B0O.00 CublcYard  U.S.Dolar  BASE BASE
4+ GOErA) 1322 11| 110 Gseel Renforcement 30,000.00  Pound U.5. Dolar BASE BASE
+ 503(8) 1313 12 120 Retaining Wal BS0.00 CubicYard  US.Dolar  BASE BASE
+ 000300 13 130 Paint Existing Steel Bridge Struct.. 100 LumpSum US. Dollar  BASE BASE
+ 70 14 140 Process Equpment L.00 Each U.S.Dolar  BASE BASE
+ 1000 15 150 Remaval of Underground Storage Tanks .00 Each U.5.Dolar  BASE BASE
+ 1010 16 160 Disposal of Contaminated Soil B00.00 CublcYard US Dollar  BASE BASE
+ 12000100 17 170 Toll Booth 100 Each U.S. Dollar  BASE BASE
+ 1500 0100 13 180 Guardrad Type 2 1,000.00  Lincar Feet U.5. Dolar BASE BASE
+ 1500 0300 19 180 Guardral Type 34 20000 Linear Feet U.5. Dolar BASE BASE
+ 16000230 20 200 Type 4 Signs 100000 SquareFe.. US Dollar  BASE BASE
+ 001 21 1 Resbgrment of Water Line 100 Each 1.5. Dolar  BASE BASE
|+ sar 12 2 Security Guard Boath 100 Each U5 Dolar  BASE BASE |
L]
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5. Now create a new Alternate for the Security Guard Booth pay item using the same steps for your
new cost item.

6. Click in the Alternates field for the Security Guard Booth Alternate. Select the add icon. An
Alternate Record opens.

7. Inthe Code field, type in code ALT3.

8. In the Description field type in Security Guard Booth Alternate.

Alternate Record ©

Code: ™ |ALT3 Description: |Security Guard Booth

9. Gointo the CBS and copy all of the subordinate cost items for the existing Toll Booth cost item.
(We will assume the same Toll Booth resources are needed for a Security Guard Booth).

= 17 Toll Booth 1.00 Each §25,264.55
+ 17.1 Site Preparation 1.00 Lump Sum £3,664.55
+ 17.2 Concrete Reinforcement 1.00 Lump Sum $1,500.00
+ 17.3 Castin Place Concrete 1.00 Lump Sum £3,500.00
+ 17.4 Concrete Masonry Units 1.00  Lump Sum £2,900.00
+ 17.5 Paneling 1.00 Lump Sum $2,100.00
+ 17.6 Wood Doors 1.00 Lump Sum €1,000.00
+ 17.7 Wood Flooring 1,00  Lump Sum $1,800.00
+ 17.8 Office Furniture 1.00 Lump Sum $2,100.00
+ 17.9 Fire Protection Piping 1.00 Lump Sum $3,300.00
+ 172,10 Interior Luminaires 1.00 Lump Sum §3,400.00

10. Paste the copied cost items into the new Security Guard Booth cost item you just created in the
PIP.
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8.2 Pay ltem Alternates

1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00
1.00

Each

Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum
Lump Sum

$25,264.55
43,664.55
$1,500.00
$3,500.00
§2,900.00
$2,100.00
$1,000.00
$1,800.00
$2,100.00
$3,300.00
$3,400.00

11. The cost items have all been automatically suspended in the CBS. This is because the Security

Guard Booth pay item is suspended as well

Security Guard Booth

Forecast

(T/0) Quantity

Unit Cost

Total Cost
(Forecast)

Suspended by
Alternate

Sl << fl<HHH<H<J<] g

12. In the Pay Item & Proposal Register, activate alternate pay item Security Guard Booth by
selecting Alternate Scenario Base + ALT3 at that top of the form.
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File Setup Estimate Quote Price Execution System Actions
@ v | Lock Cost Items to Pay Items = Epél Direct Markup 2 PBS Changes Alternate Scenario: @
[T1] Pricing o ) Indirect Markup | LogPBS Changes | | BASE+ALT 3 -
PayItem& , | Price Breakdown | [ —ts
Proposal g2 Competitors Structure (PBS) = Data Map u | (Select All)
Pay Items Overhead and Profit Audit Log
Cost Breakdown Structure (CBS) Register Pay Item & Proposal Register ©
ROCK1: Rodk Excacation
Proposal Recap - Training Job ROCK2: Rock Excavation
, Y test 1: testing 1
Current Target Forecast Variance
OK Cancel
Price: | $6,337,826.19 | $6,834,120.16 | $6,279,104.35 | $496,293.97 |ADD

13. The Security Guard Booth is now activated. You can now see that all of the pay items have been
priced including the Security Guard Booth Alternate pay item.

o= You may need to establish your pay item price first if a price does not yet exist
14. From the register, select the Actions tab. Then under the Auto Price section, select the Balance
Bid drop down.

15. Select the option Hit Target Goal in order to auto price the job. Now all of the pay items have
been priced, including the Security Guard Booth Alternate pay item.

- [ SR W - o =
+ W10102 F ] Cearing & Grubbing 0,00 $0.00 $0.00 0.00
+ 2020133 3 30 Undassified Excavabion £0.00 £0.00 £0.00 0.00
+ 303 5912 4 40 Aggregate Base £19,52 £780,800.00 £78,216.54 .0z |
+ 3034263 5 = Asphal Corerete Hot Mix Typs & §52.80 $2,006,400.00 | 200,601.14 10.00 |
+ 413(B) 0464 & 60 36 Inch RCP Cubvert Class I S86.59 §86,5%0.00 58,665.56 10001
+ 8000220 ra 10 Inch PYC Force Main (SOR21) §29.80  §357,600.00 $35,731.53 3.99
+ 9000330 a a0 24 Inch PYC Gravity Sewer (SDR35) $63.73 £191,190.00 19,149,592 10.02
+  BOO 0400 9 90 4 Fool Diameter Manhole &4,557.94 S72.927.04 $7,297.96 10,01
+ SO1(A) 1306 10 100 Structural Excavation & Badkfil §27.88 §22,304.00 $2,235.53 10.02
+ B0&(A) 1322 11 118 Sieel Reinforoement £1.7 £03, 70000 g5, 25572 2,80
+ 505(A) 1313 12 12 Fetaining Wal $336.21 $455,775.50 345,675.%0 10,02
+ 600 0300 13 130 Faint Existing Steel Bridge Struct... $100,279.27  $101,279.27 £10,163.56 10,04
+ 0 14 140 Process Equipment $1,949,552... $1,949,552.96 5194,662.95 9.99
+ 1000 15 180 Remowal of Underground Storage Taniks $13,363.93 $26,727.85 $2.710.77 10.1%
+ 1010 16 160 Disposal of C d Soil $30.51 §24,408.00 §52,475.23 10,16
+ 1200 0100 17 170 Toll Booth $31,068.28 $31,068.28 $3,103.76 9.99
+ 1500 0100 13 180 Guardral Type 2 $28.96 £28,950.00 §2,636.42 2.97
+ 1500 0200 19 180 Guardral Type 34 537.41 £7,482.00 $746.33 9.98
+ 1600 0230 0 200 Type 4 Signs 51569  515690.00 $1,566.81 9.99
+ Q01 21 Realignment of Waber Line $0.00 $0.00 $0.00 0.00
+ [Enter Pay I... 2 22 Security Guard Booth £31,068. 28 £31,068.28 $3,103.76 9,99
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8.2.1 COMPARE ALTERNATE SCENARIOS

You can price and analyze the impact of each Alternate Scenario to the estimate’s Total Price on the
Pay Item & Proposal Register. This is after the Alternate Scenarios have been defined, assigned, and
activated.

Each Alternate and combination of Alternates represents a different scenario, and prices need to be
established for every scenario that you want to compare.

For example, if you have defined Alternate Scenarios 1, 2 and 3, you may wish to price each of them
separately, and price any combination of them, and/or you may wish to price the combination of all
three.

TIP Be sure to establish bid prices for every alternate or combination of alternates.

STEP BY STEP — COMPARE ALTERNATE SCENARIOS

1. From the Ribbon, select the Price tab.

2. Under the Pay Items section, select Pay Item & Proposal. The Pay Item & Proposal Register
opens.

3. On the Pay Item & Proposal Register, select the Actions tab. Under the View section, select
Compare Alternative Scenarios. This action performs a comparison among the various
Alternative Scenarios you’ve priced so far.

_

[0] Assgned Direct Cost Only |+ | Owverwrite Locked Pay Items /’ Default Data Blodks
-~

d | 4& Balanced Bid ~ == Custom Auto Price

| Compare Alternate Scenarios

Expand [
=1 Unbalanced Bid Collapse =

Auto Price View

4. After selecting Compare Alternative Scenarios, new columns appear on the pay item form. These
columns show a comparison of the base bid, plus Alternate Scenarios that have been priced so
far.

InEight Inc. | Release 24.7 Page 193 of 236



8.2 Pay Item Alternates

Estimate Intermediate User Guide

et R R &
+ 2010102 [ F - ] Clearing & Grubbing

+ 2020183 3 0 Unclasified Excavation

+ BOD 020 7 om 14 Inch FC Force Man (SDR21)

+ 80002 8 = 24 Inch PYC Grawity Sewer (SDR3S)

+ B0 0400 9 90 4 Foot Dismeter Manhoke

+ SOL{A) 130 1 W0 100 Structural Excavabon & Backfil

+ S05{A) 1322 1 11w Stee R Ceant

+ S03{a} 1313 | 1212 Retaining Wal

+ 6000300 [ 13 130 Faint Existing Steel Bridge Struct...
+ 0 | 4 140 Progess Equpment

+ 3000 1 15 1% Semaval of Underground Storage Tanks
+ 100 1 16 160 Disposal of Contaminated Soil

+ 1200 0100 | 17 170 Toll Baoth

+ 1500 0100 ] 18180 Guardral Type 2

+ 15000200 | 19190 Guardral Type 3A

+ 1680 6230 | 0 200 Type 4 Siges

+ £o1 H n Seabgnment of Water Line

o+ Ewerwyn.  ma

e T

.00

§23.81
=L

&4, 55881
§27.88

$1.79%
536,35
$101.314.33
1,949,581,
§13,367.94
$30.53
531407132
§28.97
$37.41
S15.69
50,00

Tartal Price IUinét Price: Total Price

farend | [EASEWATI | (EASEAT)
$0.00 $0.00 $0.00
.0 000 $L.00
| SBRE1000  $BESH 655000
$357, 7H.00 §25.80 $357,600.00
$191,330.00 72 $191, 190.00
ST25A0.96 4. 557.94 STLO3T.04
§32,304.00 §27.88 §22,304.00
§53,700.00 $1.79 53, 700000
455,857, 50 §536.21 455, 778,50
£101,31433 $101,279.27 $101.279.37
£1,949 550,16 $1,949, 55295 $1.043, 552 .05
£, 7158 §1%31a% 528, T2T.06
$24.415.00 $30.51 534.408.00
$31,071.32 $3068.26 FI0ER. 28
S28.570.00 S0, 54 §28,560.00
4§70 $£37.41 §7,452.00
$15,690.00 $15.6%9 515,6%50.00
50,00 §0.00 §0000

Total Profit
(urrenit)

$0.00
#0000

§35,736.91
$19, 14205
7,299,856
§2,231.24
$5,257.72
45,685,189
$10,167.93
$194.655. 74
$2.71180

5. The current scenario base price Total Price is $6,307,253.15, however the Alternate Price
scenario for the additional Security Guard Booth is $6,337,826.19

ik e s [m, | oseoe
+ 2010102 (| 2 m Clearing & Grubbing
+ 2020183 [l 3 30 Undassified Excavation
©
+ 8000220 [l 7 M 100 Inch PYC Force Main (SDR.21)
+ 000330 ] 8 80 24 Inch PVC Gravity Sewer (SDR.3S)
+ 800 0400 (| 9 90 4 Foat Dismeter Manhale
+ S01A) 1306 1 0100 Structural Excavation & Backsil
+ 508{A) 1322 1 11| 110 Steel Reinforcement
+ S03A) 1313 ] 1210 Retaining Wall
+ §00 0300 1 13 130 Painkt Existing Steel Bridge Struct...
+ 00 [l 14 140 Process Equipment
+ 1000 ] 15 150 Removal of Underground Storage Tanks
+ 1010 ] 16 160 Disposal of Contaminated Soil
+ 1200 0100 1 17 170 Toll Booth
+ 1500 0100 1 18| 180 Guandrall Type 2
+ 1500 0200 ] 15 190 Guardral Type 34
+ 1600 0230 1 20 200 Type 4 Signs
+ CO1 D 21 21 Realigrenent of Waber Line
+ Eeerayl. 22 seanyewdSeh
[w]
X

§29.81
§61.74
$4,558.81
$27.83

5179
$536.35
$101,314.33
£1,949,68L...
$13,367.54
$30.52

Total Price Unit Price: Total Price

{ourrent) BasE+ALT 3 BASE+ALT 2y
£0.00 $0.00 £0.00
0,00 $0,00 $0,00
$357,720.00 $29.50 £357,600.00
$191,220,00 $3.73 $191,190,00
%72,940.96 54,557.94 $72,927.04
$22,304.00 £27.88 $22,304.00
$53, 700,00 $L79 $53,700.00
$455,897.50 §536.21 $455,778.50
$101,314.33 £101,279.27 £101,279.27
£1,943,681. 16 $1,943,552,96 $1,943,552.96
§26,735.98 $13,363.93 §26,727.86
$24,416.00 $30.51 $24,408.00
£31,071.32 $31,068.28 $31,068.28
$28,970,00 £28.96 $28,960.00
§7,482.00 $37.41 §7,482.00
$15,690.00 $15.69 $15,690.00
£0.00 £0.00 $0.00
46,307,253, 15 $5,337,826.19

Total Profit
(ourrent)

£0.00
£0.00

£35,796.91
§19,142.05
§7,299.86
$2,231.24
£5,257.72
$45,689.19
£10,167.93
£194,688.74
$2,711.80
$2,481.93
£3,104.28
£2,395.65
74513

£0.00

$630,442.67
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EXERCISE 8.2 — ALTERNATE SCENARIO

SCENARIO: You are a contractor estimating a job for the owner, DECK Corp. Along with the base
items of the proposal, DECK Corp has decided to include a security guard toll booth as an alternate
item in the award of the contract as well.

The request for the alternate, as indicated below, is more of a “would like to have”, to give DECK
Corp the option if it falls within their budget.

Using the Training Job, create an alternate scenario for the Toll Both.

Assign the alternate scenario to your Toll Booth cost items.

Assign the alternate scenario to your Toll Booth pay item.

Establish pricing for your Toll Both alternative scenarios.

LESSON 8 — BILLING RATES

8.1 BILLING RATES

In Estimate, the Billing Rate is defined as how much the Contractor is charging your client to utilize one
of your resources within the Resource Rate Register. The billing rate can also be viewed as how much
money that your client is expected to pay for utilizing one of the resources for a specified amount of
time. It's important for you as a contractor to have a way to more quickly see your charge rate to
compare against what you will ultimately bill your client, also known as your Billing Rate.

Contractors need a reliable way to price projects utilizing various markup strategies with clear visibility
into various costs that drive the markup amounts. It's important for contractors to be able to:

» Apply various costs that drive markups

» Apply billing rate gains (difference between contractor’s cost vs billing rates/client cost)
» Have clear visibility into the true margin based on both cost and billing rates

e Compare the cost and billing rates within the CBS

As a result of properly pricing projects, contractors can now create and view various Billing Rate
Reports showing:
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» A summary of billing rates in lieu of the cost rates for a client to see, Estimate Summary
reports

» Cost item breakdown that shows associated cost categories, billing unit rates, and total
billing amounts, Billing Rate Summary

» An analysis of reources and their margins, utilization counts and billing amounts, Margin
Analysis report

8.1.1 CHARGE RATE

The Charge Rate is the contractor’s cost for a resource. These costs include actual labor, any types of
fringes, labor taxes plus insurances, and more. These costs are all tracked within the Charge Rate’s Cost
Category Breakdown in a resource rate. The charge rate is not a cost to the client and does not include
any profit, markup or overhead. Charge Rates can be setup for a resource by going to the Setup tab
and selecting Resource Rates. Then opening a resource rate record, and selecting the Charge Rate tab.

Resource Rate Register

Labor Rate Record ©

Code: * |LC1

| Description: |Carpenter Apprentice

Setup ﬁ, Charge Rate | Billing Rate

Scale 3

Scale 1 | Scale 2 All Scales
Cost Category Breakdown Amount
v Total §27.48
» Labor §27.48
» Materials £0.00
Undefined $0.00

8.1.2 BILLING RATES SETUP

Billing Rates have 3 scales where you can determine the appropriate billing and markups rates.
e Scale 1-regulartime
e Scale 2-overtime

e Scale 3-double time
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You can enter a billing rate markup as a dollar amount in the Billing Rate Markup field or as a

percentage in the Billing Rate Markup % field. After double clicking a resource rate, you will see the

resource record.

Estimate Quote Price Execution System

B

o s . Labor A
B 5 & A

£= Equipment
Job Properties Foundation PayItem& Bid Wizard ||Resource | __ ] Resource
- Setup Data = Proposal Rates ~ | i Materials  Assemblies
Initialize Resources
Congt Eque
Resource Rate Register Labor Rate Record © ortuction Eoumpmant

Code: * |LC1

Setup | 44, Charge Rate | Biling Rate

Charge Rate:

Rented Construchon Equepment

w o I

Description: |Carpenter Apprentice Installed Materiale

Billing Rate:

|
Billing Rate Markup: |
|

Billing Rate Markup %%:

Qg Ingtalled Equipment
- Supplics
Scale 1 Scale 2 Scale 3 & Unique
$27.48 $41.22 £54.96
£30.34 | | £57.70 | | £76.94 |
§12.37 | $16.49| [ $21.98 |
45.uu| < | -1n.uu| < | 4u.nu| <

The Billing Rate tab includes the following fields.

| Neme | Desapion

1. Charge Rate

2. Billing Rate

3. Billing Rate
Markup

The amount of money it costs a contractor to
occupy a resource. Also known as the
contractor’s cost.

The amount a contractor charges a client to
utilize a resource rate. The billing rate can
also be viewed as how much money the client
is expected to pay for utilizing one of those
resources for a specified amount of time.

The dollar value amount of profit added to the
charge rate that a contractor generally
determines. This can include certain
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| Neme | Desapion

contractor fees that the contractor has
deemed to include.

4. Billing Rate The percent dollar value amount of profit

Markup % added to the charge rate that a contractor
generally determines. This can include
certain contractor fees that the contractor has
deemed to include.

The below example shows a contractor’s Charge Rate of $27.48 in Scale 1. The Billing Rate Markup is
45% of the $27.48 Charge Rate, which is a $12.37 Billing Rate Markup. The total Billing Rate is $39.84,
which is the price the contactor would charge a client.

Resource Rate Register Labor Rate Record ©

Code: * [LC1 Description: |Carpenter Apprentice

Setup ] ¥, Charge Rate | Biling Rate

o | Scale 1 | Scale 2 Scale 3
Charge Rate: $27.48 S$41.22 $54.96
Billing Rate: $39.84 $41.22 $54.96
Billing Rate Markup: $12.37 $0.00 $0.00
Billing Rate Markup %:o 45.00( < 0.00| « B «

STEP BY STEP — BILLING RATE SETUP

1. Use the Training Job for this example. From the Ribbon, select the Setup tab.

2. Under the Resources tab, select the Resource Rates drop down arrow. Then select Labor. The
Resource Rate Register opens to the Labor tab.
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& . Labor ﬁ
p— 23 Equipment

Resource __ ) Resource
Rates = &= Materials  Assemblies

o Labor %

Construction Equipment

iw 1B

Rented Construction Equipment

Installed Materials
Installed Equipment

Supplies

N §

Unigue
3. Select the LW WELDERD Welder Resource Code from the list. Then select the Actions tab. Under

the Edit section, select Open.

4. After the Labor Rate Record opens, select the Billing Rate tab.

Resource Rate Register Labor Rate Record ©

Code: * |LW WELDERD Description: |Welder

Setup | $4, ChargeRate | Biling Rate

5. Change the Billing Rate Markup % to 15 for Scale 1, then tab out of the field.

« The system automatically calculates the Billing Rate Markup field to $6.38.
» This represents 15% of the Charge Rate.
» The Billing Rate is now equal to the Charge Rate plus 15%.
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Resource Rate Register Labor Rate Record ©

Code: * |LWD Description: |Welder

Setup | ¥, ChargeRate | Biling Rate

Scale 1 Scale 2 Scale 3
Charge Rate: 542.56 $63.83 $85.11
Billing Rate: 548.94 $89.37 §119.15
Billing Rate Markup: £6.38 $25.53 £34.04
Billing Rate Markup %: I 15-UUI < 40.00| < 40.00| <

6. Change the Billing Rate Markup to $14.68 for Scale 2.
» The Billing Rate Markup % is now 23% and the Billing Rate is now $78.51.
« Scale 1 Charge Rate of $42.56 plus (half of $42.56) $21.28 equals a Scale 2 rate of
$63.83.
 Scale 2 rate of $63.83 plus 23% equals a billing rate of $78.51

Scale 1 Scale 2 Scale 3
Charge Rate: £42.56 £63.83 585.11
Billing Rate: $48.94 $78.51 $119.15
Billing Rate Markup: $6.38 $14.68 || 4 §34.04
Billing Rate Markup %: 15.00( « 23.00 40.00| <

8.1.3 COST VS. BILLING VIEW

The Detail tab in a Cost Item record lets you compare the Unit Cost (charge rate) against the client’s
Billing Unit Rate.
To view the Cost vs. Billing View within a Cost Item record, select a cost item record, click on the Detail

tab, then select the Billing Rates View.
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The Detail tab includes the following fields.

T

This is the contractor’s cost for this resource
rate, also known as the Charge Rate.

1. Unit Cost

2. Billing UnitRate  The amount a contractor charges a client to

utilize a resource rate, also known as the

Billing Rate.
3. Total Cost This is the Unit Cost multiplied by the number
(Forecast) of hours utilized.
4. Total Billing This is the Billing Unit Rate multiplied by the
Amount number of hours utilized.

» Below is an example of how to view the Cost vs. Billing View when the Production Days
are equal to 1.

» The Unit Cost (Charge Rate) and the Billing Unit Rate values both values derive from your
Resource Rate.

Cost Item Summary | S, Detai: $219.83 | & Phg:$0.00 | [JQuote: $0.00 | Allocation Production X
Drag columns here to group Find: | [Search Fer...] Saved views: | Cost vs. Billing View Customize Display
: o 000 10
Row = Productivity Work Pay Unit Cost Biling Unit Rate Total Cost Total Biling <
Number Factor Hours Hours " (Forecast) Amount Shifts: 1.00 0.00 1.00
1 1.00 .00 8.00 $27.48 $39.84 $219.83 $318.75 Hours: 8.00 0.00 500
- o e e o Man-Hours: 3.00 0.00 8.00
tquipHours:| 1§ 0.00 0.00
Each/Day: 1.00 0.00 100
Eachy/Shift: 1.00 0.00 1.00
Each/Hour: 0.13] 0.00 013
$219.83 $318.75 —_—
.| E=E.. PN [Fc. Zr. | 2R, =5, U 8

STEP BY STEP — CBS COST VS. BILLING VIEW

. From the Ribbon, select the Estimate tab.

. Select Cost Breakdown Structure (CBS). The Cost Breakdown Structure (CBS) Register opens.

1
2
3. Create a cost item called Fabrication Work. Double click on the new cost item to open it.
4

. Select the Detail tab. Then select LWD Welder from the Code field.

InEight Inc. | Release 24.7
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Cost Item Summary afgetail : €0.00 # Plug : £0.00 D Quote : 0.00 Allocation

Drag columns here to group

Row .
Nurmber Cod

Py 1jLtwoa 2 Welder Apprentice 1.00

m

Resource Assembly Description Quantity

5. Go to the Production default data block. In the Days field, enter in 1.

Production b
Qty Driven *

Hourly Cost ]

Duration Driven Resources Resources Sumi

Customize Display
| 1.00] 4 0.00

Shifts: 1.00 0.00

Days:

Hours: 8.00 0.00
Man-Hours: 8.00 0.00

Equip-Hours: 0.00

6. You are now able to compare your Total Cost against the Billing Rate. Your Total Cost is $226.96
for 8 hours, while you Total Billing rate to the client is $317.74.

CostItem Summary | S Detail:$226.95 | & Plug: $0.00 ‘ () Quote : §0.00 ‘ Allocation

Drag columns here to group
Row - . Unit of Productivity . ) Total Cost Total Billing
Number = Coce Deacption Quantity Measure Factor g Uik Rare (Forecast) Amount
1 LWDA Welder Apprentice 1.00 Each 1.00 £39.72 $226.96 $317.74
s i
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8.1.4 BILLING RATE REPORTS

There are several reports you can run to view resource costs, billing rates, and mark-ups. Some of
these reports you may choose to provide to your customer. Other reports, you may choose to use only
as a way to view your markup margins prior to submitting to your customer.

To locate these reports, select the Setup tab. Then select Reports. From the Reports window, select
Billing Rate Reports.

8.1.4.1 BILLING RATE SUMMARY REPORT

The Billing Rate Summary report shows cost items including cost category details.

ownaed fentsd cusiom Totsl Biing |

Labor Equipment Equipmant Mztsnae Supphes Subconfract Foss Apwance Catsgonyi Biling Unit Rate Amount |
31875 000 000 .00 0.00 0.00 Q.00 0.00 400 31875 31875
HETS 000 [T 0.0 0.00 L] Qo 0.00 a0
NI 000 000 0.0 200 0.00 000 0.00 200 NN NI
NI 000 000 0.0 200 000 a0 0.00 200
63640 (1] LT 1] o000 0 1] L1 ] a0 B354

The end of the report shows you a total of your Direct and Indirect cost markups, and also includes a
Total Billing Amount at the bottom far right.

c8s Gened Rented Caviam Total Biling
PomSon Code Deseripan Labe Equipman! Equipment [TEET Suppies Suboontast Fob ABIEENSE Calgany Billing Uait Rate Amount
-3 Z3mame” woN HETE [r1xx] 20 220 000 0o o 000 000 31875 31875
MeTe am am =] 009 LT am am am
x Faoacanon Wos TS o0 am 00 0.00 0o o uls s 000 T4 SITE
37T am 2w ] ood o am bla] L]
Ingirect Tots 63645 [1] a0 .00 000 LT am o L1 (L]
et Costva | 8547550 TEANRE2 5293 ToeLs 2maEt 1544500 1350313 Lol &Hm 455,088 92
BsaTsss TRA0882 52958 e 208488 15,448.00 1350813 B, am
moiect Cost Mamp | 1072002 556275 #50.00 552 600 000 3535 50.00 54000 17565
1070 555275 ok 552 %o LT ) E0 sam
Fesa Totl 95,504 50 307137 539,35 270,158,085 2160054 15,445 00 13,555.41 24000 E33.00 4E3 645 45
| nnpm'renl 24100 BT 53958 270,158.08 216054 1544300 13,585.41 0.0 220 sz

8.1.4.2 ESTIMATE DETAILS WITH BILLING RATE REPORT

The Estimate Details with Billing Rate report shows a selection of resources with associated billing rates

and utilization counts.
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GBS Resource Biling Unitol Ut lizaiean Biling |
Position Cote Descripon UnitRae IMeasure Count Tmlnm'li
i} Carpenter work |
LC1 Carpenter Appremics Houw $31875)

TOTAL 0 2187

TOTAL - Carpenter work LX) §318.75!

el Fabrieation Work !
LWOA Welder Aprenice $3972 How &m $317.74

TOTAL 50 31778

TOTAL - Fabricaion Werk am 5311'.?-!;

| GRAND TOTAL 150 $5%.0|

8.1.4.3 MARGIN ANALYSIS REPORT

The Margin Analysis report is beneficial for displaying both mark-up and margin values for selected
resource rates.

‘oS Resoure Uit Biling Unitof Utilizzon Totd Totd Marklp | Markup Wargin

[Posifon  Code Descrigtion Cos  UnitRae Messure Count Cot Billing Amount Amount % %

|28 Carpenter work

i Lct Campenter Arprenmo 7.4 $39.8 Hor 80 2198 8187 wma | som H.09%
TOTAL 8.00 2190 $318.75 e 45.00% 31.00%|

TOTAL - Carpenter vork X 1.8 187 sae | a0 || stom
B Fabrication Work
LViDA Vielder Apprenice T $3872 Hox 800 $25.% $37 7 som | oo 2857

TOTAL -Ri1) 25.% $37.H $30.78 40.00%% 28.57%|

i TOTAL - Fabricaion Wark 8.0 25.% 2174 s | som | | 2

| GRAND TOTAL 150 457 #w8 sieon Lapass | | zesm]
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EXERCISE 8.1 — BILLING RATES

SCENARIO: You are an estimator working for Hexco Civil, and your company has started work on the
excavation and grading portion of a project for Health Choice hospital campus.

During this phase, the crew runs into underground storage tanks that have contaminated the soil.

Robert, the Health Choice engineer, requests “rather than detail out an estimate, we’ll just do a time
and materials agreement for this portion.”

You agree on a 20% markup on your going rates for labor and equipment.

IN THE TRAINING JOB:

1. Make a copy of the Training Job.

2. Inthe new job, apply billing rates to the resources employed on the subordinates of the
“Removal of Underground Storage Tanks” and “Disposal of Contaminated Soil” cost
items.

3. Inthe PBS, select the Charge Rate and Billing rate Saved View to compare your rates.

4. InJob Properties > Pricing, change the setting to Calculate Balanced Pay Item Prices using
Billing Amount.

5. Inthe Pay Item & Proposal Register, note that your Target Price is now based on billing
rates.

6. Decide if you want to spread any addition overhead or profit to your “Removal of
Underground Storage Tanks” and “Disposal of Contaminated Soil” pay items (or just leave
them with their current billing rates.

Congratulations, you have completed this exercise!
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8.2 BILLING RATES REPORTS OVERVIEW
8.2.1 COST ITEM SUMMARY

The Cost Item Summary tab in a Cost Item Record, allows the estimator to add additional costs to the
Resource Billing rates by a percentage or amount. For example, there may have been extra work that a
percentage would apply that the owner approves. The Billing reports then lists these for the owner.

The following screen shot shows cost item 3.1 with the adjustment. To see the adjustment, select the
Actions tab and under the View section, use the Display Billing Rate toggle to display the Billing Rate
columns.

Review the two columns Total Billing Amount and Unadjusted Total Billing Amount.

[ 7:| "= Display Parent Information 2, Highlight Unique: (Delta) Resource Fiekds 7= Insert Subordinate T3] Trench Calauator
T5 Display Biling Rate B righlight Unique (Delta) Cost Item Fields | - Edit Resource Periods £5] shift / Rate Calaulator
Split Default
Data Blodks
Edit View Tools
Cost Breakdown Structure ((BS) Register Cost Item Record ©  Dependent Cost Item Record Price Breakdown Structure Ma
CBS Code: Optional Code:  Description:
[ E] 202 0183 Undassified Excavation
El 31 31 [Excavation
PI Assignment: PILine Number: PI Description:
2020183 30 Unclagsified Excavation

“YCgst Item Summary | S Detal: $3.05 | ¥ Pug:$0.00 | (OQuote: $0.00 | Alocation

tad Cost Cost Uinit Total g:&d]usred
Cost Category Unit Cost Total Cost Unadjus Adjustment &< Adjustment Bling Biling
Total Cost Percent A t Rate Aot E::g.m
w Total $3.05 $152,320.48 $152,320.48 0.00 £0.00 $3. $194,604.65 $176,913.32
» Labor $0.65 $33,170.48 $33,170.48 0.00 $0.00 $0.
»  Owned Equipment $2.38 $115,150.00 $119,150.00 0.00 £0.00 $3.02 $150,819.62 $137,108.75
»  Rented Equipment £0.00 £0.00 £0.00 0.00 £0.00 £0.00 £0.00 $0.00

The following screen shot is the estimate details with Billing Rates report for the 3.1 cost item.
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Heports -
Settings: | Previous v
» [E] Job Properties
= Foundation Setup Data Print | CostItem Selecton | Detais | Layout | Header [Footer
» & Resources
; (@) Print a contiguous range of cost items:
» l‘ Resource Assemblies
v @b Cost Breskdown Structure Ero 31 -
CBS Summary To: 3.1 - []Roll-up to cBS Level [-1
» €8S Detals )
» CBS Qutiine \'
(O Select cost items to print umther%lsrerbelow:
Estimate Summary
CBS Currency Comparison Find: | [SearchFor...] Saved views: | Previous Viey
» ‘Ea Quotes

» T = Price Breakdown Structure
» E) Pay Item & Proposal
~ [&] Biling Rate Reports
Biling Rate Summary
/.r Estimate Detaids with Billing Rat
Margin Analysis
Resource Price List
» 8+ Job Tradkng
Estimate Comparison Report

PR,
Job Code: Copy of Training Job
Description:  Training Job - Maricopa County No, TM2924

CBS Resource Biling Unttol Utilization Biling
Positon Code Descrighon UnitRae Measure Count Total Amunt
ER | Excavaton
LL2 Laborer 33158 Howr 150
LMECH Mechat $780 How 75.00
Lo Oparator Class 1 5128 How 500.00
Lo2 Operator Class 2 $3368 How 500.00
LO4 Oparator Foraman HLE Howr [-~E 1] $2670.15
ECOMP Compactor Smooh Dum $41.% How 150 $5,2325%0
ECOMFZ Compactor Shaes Fodt 57054 How 1250 $8,855.00
EDS Dozer D8 $199.84 How 150 $24,85500
EGHMG Grader 143 8.2 How 1250 s
ESSM Scraper 6 $185.0 How 250.00 $48,57500
ESs2 Scrper 62 $145.05 How 250.0 $36.5129
ETWT Vimter Truck $34.04 How 15.0 $4.25500

Adusime [IHETE
TOTAL $154, 604 55
GRAND TOTAL B S,

8.2.2 DEPENDENT COST ITEMS

You can use dependent cost items with billing work. For example, the Contractor may have an
agreement with the Owner to add additional overhead costs as a percentage of the work or the Owner
allows a contingency for unknown work.

The following screen shot is an example of using a dependent cost item with billing work.
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Cost Item Record ©

e (CBS)

Price

Estimate Intermediate User Guide

Total Cost:

$102,676.52 BASE

Descption | Dependency | CostCategorization | Alocation Billing Breakdown
Drag cobumns here to group Find: | [Search For...] == Saved vif Cost Category mh Rate Blng
Descripbon Total Cost (Forecast) P Tag 1 Tag| | Total $5,762,525.20 L4 $84,307.07
»  Labor $843,070.69 10.00 $84,307.07
3 Rented Equpment $7,303.47 0.00 $0.00
» Supphes $26,971.87 0.00 $0.00
s Materiais $3,572,899.79 0.00 $0.00
» Subcontract $107,115.00 0.00 £0.00
» Fees $180,021.76 0.00 0,00
»  Alowance $1,000.00 0.00 $0.00
Custom Categoryl $1,660.00 0,00 € £0.00
Undefined $0.00 000 € .00
o 4 Costoreskdofn 4+ Bffpg Ereskdonn [ costitemSetip  [5) Motes = Schedule

The following screen shot is a sample report that includes the dependent cost item with billing work.

© = Settings: | Previous -
» Job Properties
_-_" Foundation Setup Data Print | CostItem Selection | Detais | Layout | Header Footer
s q
T = O Print a contiguous range of cost items:
Resource Register
R e} From: 3.1
Resource Rate Detals To: 3.1
Resource Utlization
Resource Utlization (Excel)
(®) Select cost items to print from the register below:
Resource Currency Comparisor
¥ ﬁ Resource Assemblies Drag columns here t group Find: | [Search Fer...]
» -'i Cost Breakdown Structure cBS
» b Quotes Indude  posibon Code = DA =
» E Price Breakdown Structure Job Management & Equipment
» B Pay Item & Froposal e
~ [ Biing Rate Reports - | v Direct Cost Add-On
Bilkng Rate —
ik Mobilization
| Estimate Detads with Biling Rat] = e =
Marnin Analuecic L
Job Code:  Copy of Training Job
Description:  Training Job - Maricopa County No. TM2924
Resoure Biling Unitol
Code Description UnitRae Measure
(5] Direct Cost AddOn
Dependert
TOTAL
TOTAL - Direct Cost AddOn
- GRAND TOTAL
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Roll-up to CBS Level -1

Saved views: | Previous View

Optional Unit of

Code Measure  CUTENSY

JOBMANAGEMENT SEQUIPMENT LumpSum  U.S.Dolar *
GENERAL EXPENSE lumpSum .S, Dolar
DIRECT COST ADD-ON umpSum .S, Dolar
6410100 lumpSum  U.S. Dolar
2010102 Ace U.S. Dolar

r— Total Amout.

$84 30700

$54,207 7

84,3070 !

42070
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8.2.3 ADDITIONAL MARKUP IN THE PBS FORM

8.2 Billing Rates Reports Overview

Depending how the Resource Billing Rates are determined, to accommodate the Owner, a fee can be

applied using the PBS form.

The screen shot is a sample markup for Direct Costs in the PBS form.

Cost Breakdown Structure (CBS) Register Price Breakdown Structure  Markup Cost Item Record ©

CBS Position Code: Description:
Direct Cost Markup

Description Dependency Alocation
Bescription (Forecast) Account

5 Direct Cost Markup $620,483.29

ed views:

Previous View

Cost
Curve

Linear

Billing Breakdown

Cost Category

Total Cost: Alternate:

$620,483.29 | BASE

Subject Billing

Total Biling Amount ~ | Total $5,813,390.77
sml,m-ﬂﬂ‘l > Labor $838,467.83
> Owned Equipment $1,024,251.65

» Rented Equipment $7,279.00)

> Supples $26,971.87)

> Materisls $3,624,066.54

» Subcontract $107,115.00]

» Fees $182,578.87]

> Alowance $1,000.00)

Custom Categoryl $1,660.00)

Undefined $0.00)

4 Cost Breakdown

4 Biling Breakdown

10.00
10.00
10.00
10.00
10.00
10.00
10.00
10.00
10.00

$102,425.17
§727.80

$2,697.19
$362,906.65
$10,711.50
$18,257.89

$100.00

« $166.00
€ $0.00

[ costItem Setup  [5] Notes

The following screen shot is of a sample report that includes that fee total of the additional markup.

Job Code: Copy of Training Job
Description: Training Job - Maricopa No. TM2924

ces Forecast Unitol Qwned Rented Cusiom Tota Bang
Posian Code Dwecripion (110) Quantty Maasure Labar Equipment Equipment aterian Suppies  Subconkact Fosn asowance Cafsgoryl  Billing Unit Rats amount
T Excavation 50,000.00 Cutic Ya ass e a0 00 a0 a0 000 000 200 1] 184,504.88
4378508 15081962 000 200 200 20 200 000 200

Direct Totm 278 150,819 62 [t am (1] (1] am am am 194,504 65

Divect Cost Mav nuET 0242817 0 32,408.85 28T 1071150 1825708 10000 18800 81,805.08
Fosa Tow LTS 10282517 1% 25240568 268719 nns 1825788 1w %60 551.339 08
Report Totsl 1Zps =Ty IS0 240665 285719 1071150 1825789 10000 166.00 TIEMITY
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LESSON 8 REVIEW

1. In what form do you apply sub totals, fixed final price, and rounding precision?

a.

b
C.
d

Pay Item & Proposal Register

. Cost Breakdown Structure Register

Job Properties

Price Breakdown Structure

2. Where do you go to activate an Alternate scenario?

a.
b.
C.
d.

Customize section of the System tab
Initialize section of the Setup tab
Overhead and Profit section of the Estimate or Price tab

Alternates section of the Estimate or Price tab

3. Where do you go to set pay items to be based on billing rates?

a.

b
C.
d

Pay Item & Proposal Register

. Cost Breakdown Structure Register

Job Properties

Foundation Setup Data

LESSON 8 SUMMARY

As a result of this lesson, you can:

¢ Use advanced pricing options including: alarm limits, subtotals, rounding precision, and Fixed

Final Price

¢ Create and compare alternates for cost items and pay items

¢ Use Billing Rates
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LESSON 9 — BENCHMARKING

LESSON DURATION: 40 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:

e Set up and use benchmarking to compare your job to past projects

9.1 BENCHMARKING OVERVIEW

Benchmarking is used to validate an estimate's cost and productivity values by comparing them to
relevant historical data, specifically as-built and as-estimated information captured from past jobs in
Estimate. Unit cost and unit man-hour benchmark data points are displayed graphically in relation to
the current estimate.

o= When using the Estimate in the Cloud benchmarking feature, it requires the installation
of Connected Analytics.

9.1.1 BENCHMARKING MASTER JOB PROPERTIES
FORM

The Master Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the current job, and to define the default benchmark graph display and calculations.

The Master Job Properties - Benchmarking form includes:

» Historical Data Source - Select As-Estimated and As-Built data from the Data
Warehouse.
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» Default Cost Item Matching Criteria, Default Account Code Matching Criteria and
Default Jobs Filter - Define which cost items, account codes and jobs should be included.

» Benchmark Graph display Options - Define the data to be represented on both the X-
Axis and the Y-Axis of the graph.

» Calculate "Average" as- Define the calculation method as either Average or Weighted
Avg (weighted by current Qty).

» Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units /
Man-Hour.

» Flag an item's variance relative to the benchmark data when - Define the breakpoints for
low, medium and high variance ranges.

* Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

The data in the Master Job Properties - Benchmarking form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same rules,
defining the data in the Master Job Properties form will save time when you create new
job folders in Estimate.

In addition to the primary Forecast (T/0O) Quantity and Unit of Measure on each cost item, Secondary
Quantity and Secondary Unit fields in the Cost Item Record can be used to capture a meaningful,
alternative quantity and unit on which to analyze As-estimated data.

You can establish the historical data to be used for benchmarking the current job, define the default
benchmark graph display, and define high, low and medium variance ranges on the Job Properties -
Benchmarking form.

STEP BY STEP — BENCHMARKING MASTER JOB PROPERTIES FORM

1. From the Backstage View, select Library from the left pane navigation.

2. From the Ribbon, select the Setup tab. Under the section Master Initialization, select Job
Properties. The Job Properties register opens.

3. On the Job Properties form, select the Benchmarking tab.

4. The Historical Data Source defaults to Data Warehouse. Select the historical data to use: As-
Estimated, As-Built, or both.

5. To define Default Cost Item Matching Criteria, click the Edit button and define your criteria for
matching cost items. You can select one or many fields and relate them using AND/OR logic.
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6. To define Default Account Code Matching Criteria, click the Edit button and define your criteria

10.

11.

for matching cost items. You can select one or many fields and relate them using AND/OR logic.

\[e3g =0 A matching benchmark data point will be excluded if its unit of measure type (e.g.,
area, length, etc.) is different than the unit of measure type of the matching item in

the current estimate.

To filter the jobs to include, click the Edit button on the Default Jobs Filter and define your job
filtering criteria.

Choose your Benchmark Graph Display Options:
» Select the data to be represented on the X-Axis:
o Date
° Item Quantity (Primary)
° ltem Quantity (Secondary)

[¢]

Ratio (Primary / Secondary)

[¢]

Ratio (Secondary / Primary)
» Select the data to be represented on the Y-Axis:
° $/Primary Unit
° Man-Hrs / Primary Unit
° Primary Units / Man-hr
o $/Secondary Unit
° Man-Hrs / Secondary Unit
o Secondary Units / Man-hr

Define your average calculation method as either Average or Weighted Avg (weighted by
current Qty).

Define the Benchmark values that will be calculated from the historical data set by selecting Cost
per Unit, Man-Hours / Unit and Units / Man-Hour.

Define the variance ranges to be used for flagging an item relative to the benchmark data:

» Toflag an item's variance from the average, select Ilts % variance from the average
exceeds and choose the Low, Medium, and High percentages to flag (values are
incremented by 1%).
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12.

13.

e Toflag an item's standard deviations from the norm, select Its standard deviations
from the norm (using SSTDEVP method) exceeds and choose the Low, Medium
and High values to flag (values are incremented by .1).

To customize the display colors for the Low, Medium and High ranges, click on a color block and

choose a different color.

To set a minimum number of benchmark data points required for an item to be benchmarked,
select a number in the Don't benchmark items with fewer than historical data points field.

o= NOTE: The data in the Master Job Properties form is automatically copied to any
newly created jobs. If all of the jobs that you create in Estimate will use the same

data, descriptive information and rules, defining the data in the Master Job
Properties form will save time when you create new job folders in Estimate.

Library - Estimate

Estimate Execution System
A o
B » 2] B W K L @ Al B @ B
HH tH
A ! £3 Equipment
Job Propertes  Foundation  Address  Trench  ShiftRate  Resource Resource CostItem  Standard User Roles  Access Reports
= Setup Data - Book Calculator  Caloulator Rates ~ B¢ Materials Assemblies Assemblies  Tables Control
Master Initialization Master Resources Master Assemblies Roles and Permissions Reports

Job Properties ©

Overview | Seaurity | CoverSheet | CostBasis | Minority Setup | FuelCost | JobTracking | JobFolder Tags | Competitors | Pridng | Schedule | CashFlow | EquipmentMaintenanc Benchmarking

As-Estimated As-Built

Historical Data Source: Data Warehouse - Historical Data Source: None

Default Cost Ttem Matching Criteria: [Account Code] EQUAL Default Cost ltem Matching Criteria: Edit ...

Default Account Code Matching Criteria: | Edit... Default Account Code Matching Criteria: | Edit ..

Default Jobs Filter: Edit.. | ALL JOBS Default Jobs Filter: Edit.. | ALLJOBS
Benchmark Graph Display Options: ¥-Aods: | [tem Quantity (Primary) ~|  Y-Axis: | Cost/Primary Unit -
Calculate "Average” as: (8) Average () Weighted Avg (weighted by current Qty)
Benchmark: [Jcostperunit  []Man-Hours fUnit ] Units [ Man-Hour

Flag an item’s variance relative to the benchmark data when: Low Medium High

(@ Its % variance from the average exceeds: 0 =[5 o

O Its standard deviations from the norm 0.0 = [0.5 [&] |10
(using STDEVP method) exceeds:

Dont benchmark items with fewer than 0 =1 historical data points

9.1.2 BENCHMARKING JOB PROPERTIES FORM

The Job Properties - Benchmarking form is used to establish the historical data to be used for
benchmarking the job, and to define the default benchmark graph display and calculations.

The Job Properties - Benchmarking form includes:
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o Historical Data Source - Select As-Estimated and As-Built data from the Data Warehouse.

e Default Cost Iltem Matching Criteria, Default Account Code Matching Criteria and Default
Jobs Filter - Define which cost items and which jobs should be included.

» Benchmark Graph display Options - Define the data to be represented on both the X-Axis
and the Y-Axis of the graph.

» Calculate "Average" as- Define the calculation method as either Average or Weighted Avg
(weighted by current Qty).

» Benchmark - Select a benchmark value of Cost per Unit, Man-Hours / Unit, or Units / Man-
Hour.

» Flag an item's variance relative to the benchmark data when - Define the breakpoints for
low, medium and high variance ranges.

» Don't benchmark items with fewer than <number> historical data points - Designate the
minimum number of data points needed to benchmark an item.

STEP BY STEP — OPENING THE JOB PROPERTIES FORM

1. On the Ribbon, select the Setup tab.
2. Under the Initialize section, select the Job Properties drop down arrow.

3. On the drop down list, select Benchmarking.
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Training Job - Estimate

Estimate Quote Price Execution System
B ¥ B o &ai>. ® a 8 B
0 - 22 Equipment
JobProperties  Foundation  Pay Item &  Bid Wizard = Resource Resource CostItem  Standard Reports
- SetupData ~  Proposal Rates » i3 Materials  Assemblies | Assemblies  Tables
Initialize Resources Assemblies Reports

Cost Breakdown Structure (CBS) Register Cost Item Record Job Properties ©

Overview | Security | Cover Sheet | CostBasis | Minority Setup | FuelCost | JobTracking | JobFolder Tags | Competitors | Priing | Schedue | CashFlow | Equipment Maintenance
As-Estimated

AsBuilt

Historical Data Source: Data Warehouse - Historical Data Source: None

Default Cost Item Matching Criteria: Edit... | [Description] EQUAL Default Cost Item Matching Criteria: Edit ...

Default Account Code Matching Criteria: | Edit... | [Account Code] EQUAL Default Account Code Matching Criteria: | Edit ..

Default Jobs Filter: Edit.. | ALLJOBS Default Jobs Filter: Edit... | ALLJOBS
Benchmark Graph Display Options: N-fods: | Ttem Quantity (Primary) = | Y-Auis: | CostfPrimary Unit -
Calculate "Average” as: (@) Average () Weighted Avg (weighted by current Qty)
Benchmark: [ Costperunit [ Man-Hours [ Unit [ Units / Man-Hour
Flag an item’s variance relative to the henchmark data when: Low Medium  High

(@ Its % variance from the average exceeds: 0 B [s B 10 &

Its standard deviations from the norm 0.0 0.5 = 10 &

O (using STDEVP method) exceeds:

Don't benchmark items with fewer than |0 || historical data points

9.1.3 BENCHMARKING GRAPH

The defaults for the benchmarking graph are defined on the Job Properties - Benchmarking form, but
on the Cost Item Record - Benchmarking form you have the ability to override the default criteria in
order to expand or contract the amount of historical data being used to calculate benchmark values for

a specific cost item. This way, you can filter the historical data sources to only the past jobs that are
relevant to that cost item.

Before starting this procedure, make sure to set up your default benchmarking options, as outlined in
the Benchmarking Options topic.

STEP BY STEP — BENCHMARKING GRAPH

1.

From the Ribbon, select the Estimate tab. Under Breakdown Structures, select Cost Breakdown
Structure (CBS).
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2. On the Cost Breakdown Structure (CBS) Register, select the More Actions tab. Under the Tools
section, select Refresh Benchmarks.

%2 wW & -

File Setup Estimate Quote Price Execution System Actions

&&= Schedule Selection 4P Swap ~ ) Bid Wizard > Unit / Total Confirmation

@& Unschedule Selection @ Remove ~ Subtotal Calculator | € Refresh Benchmarks

x| ) = Import [

me Calculate Plug Days C Update ~ Quantity Checking Add Quote Update CBS ~
Schedule Batch Operations Tools Data Source

3. The Refresh Benchmarks dialog shows the Last refresh date and the number of Jobs matching
filter criteria.

« If the number of matching jobs is too large or too small, return to step 1 and expand
or contract your filtering options.

« If the number of matching jobs is acceptable, click Refresh Now to proceed.
4. Open the Cost Item Record of any preferred cost item.

5. Click on the Benchmarking default data block located in the lower right portion of the Cost Item
Record.

6. The benchmarking graph shows the historical benchmark values for this cost item, along with the
Current value, the Average value, and the variance ranges represented by each color. This
information is calculated and displayed as specified on the Job Properties - Benchmarking form.
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Benchmarking

$450—]

0) T T
-67.20 46187 930.53
Linear Feet (Primary Unit)

rage  © As-Estimated ¢ Current

ariance from average [ 0-5% [C5-10% [CJ»10%

Settings... Reset Zoom Last Updated: /15/2020 10:09:34 AM

Zo Erployment Setup  [5) Notes [ CostltemSetup 2o Production 2% MantourFactors 5% Resource Employment Breakdonn = Schedule & UserDefined 2 Benchmarking

7. To refine the values that contribute to this cost item's graph, click the Settings button to display
the Settings dialog:

» To override the job filter for this cost item, click the Edit button in the Override Jobs
Filter field and define the filter to use for benchmarking this cost item.

» To override the Display Options for this cost item, select the desired values from the
X-Axis and Y-Axis drop-down boxes.

» To override the list of jobs that contribute to the Included Historical Data for this cost
item, use the Auto include all matching data points toggle to include all or exclude all,
and select the individual Include check boxes for the jobs you want to include.

» When you have completed your customizations for this cost item's benchmarking,
click OK to save your changes and return to the Cost Item Record - Benchmarking
form.
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Register Cost Ttem Record ©

Deseription: Forecast (T/0) Qty:  Urit of Measure:  Unit Cost:

Cost Item "6.3' Benchmark Settings - Training Job

Estimated AsBult 1,024.00 | | Linear Feet
JI mherited 0bs Fiter: Inhesited Jobs Filter: 1,024.00] [ Linear Feet - :
1 " ALLJOBS 1 ALLJOBS I b
ram Job Properties) Job Prop
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(Primary) Unit Man,
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% varisnce fromaverasge T 0-5% CO50% CO»10%

Reset Zoom | LastUpdated: £/19/2020 10:09:34 AM
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8. To zoom in on a portion of the graph, click and drag across the portion of the graph that you
want to enlarge. To view the entire graph again, click Reset Zoom.
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B Average @ As-Estimated © Current
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Settings.. ] Reset Zoom | | LastUpdated: 6/19/2020 10:09:33 AM Print...
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9. To print a Benchmark Report, click the Print button, change any options as necessary on the
Benchmark Report dialog, and click Run.
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9.1.4 ACCOUNT CODE UTILIZATION REGISTER

The Account Code Utilization Register is used to roll estimate line items into an account code
hierarchy, with the ability to control which cost items contribute quantity to their parent, in order to
benchmark against historical projects in a way that is consistent across projects.

The Account Code Utilization Register is similar to the Cost Breakdown Structure (CBS) and the Master
Cost Breakdown Structure (CBS), with the following exceptions:

» The rows in the Account Code Utilization Register represent Account Codes rather than
individual Cost Items, so the tree structure reflects the Account Code hierarchy rather than

the CBS hierarchy.
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» The detail rows in the Account Code Utilization Register reflect a terminal Account Code's
assigned Cost Items.

» The terminal rows in the Account Code Utilization Register represent each utilized
Account Code in the CBS.

« Ifthe Account Code’s Auto-Quantity setting is set to Yes, then the Quantity of the terminal
row is equal to the Quantity (Primary or Secondary) of all the cost items in the CBS with
that assigned Account Code, and the cost items in the CBS employing resources with that
assigned Account Code, provided that they have the same Unit of Measure type as the
Account Code.

» Detail rows for each terminal row represent the cost items assigned to the terminal
Account Code, including cost items employing resources that are assigned to the terminal
Account Code.

» The Account Code Utilization Register can be filtered to display only terminal items by
clicking the drop down arrow on the Is Terminal column and selecting Checked.

¢ When an Account Code is assigned to an employed resource, the resource's total Cost/Mhrs are
removed from the Account Code associated with the cost item and placed, instead, in the
Account Code assigned to the employed resource.

The parent-child hierarchy for Account Codes is based on the Account Code Hierarchy Separator,
which is located from the Backstage View Settings under the Options drop down labeled as Account
Code Settings. The Hierarchy Separator defines the parent-child relationship within the Account Code
structure.

The Account Code Utilization Register is used primarily for analysis, and most of the columns are read-
only. Most of these columns originate on the Account Codes tab in the Foundation Setup Data
Register and the Master Foundation Setup Data Register. Modifying an editable column on this form
has the same effect as modifying the same field on the Account Codes tab of the Foundation Setup
Data Register or on the Account Record. For further information, see Creating Account Codes.

The Benchmarking portion of the form is similar to the Benchmarking data block on the Cost Item
Record, with the following exceptions:

» The Item Matching criteria is always Account Code.

» Parent account codes will include all matching data points for their child account codes,
based on the Hierarchy Separator.

» Account Code rows can be benchmarked at the terminal row level or at any superior row
level in the Account Code Utilization Register, meaning that both current estimate values
and benchmark values can be compared at any level since both include the values rolled
up from their children.
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9.1.4.1 OPENING THE ACCOUNT CODE UTILIZATION
REGISTER

STEP BY STEP — OPENING THE ACCOUNT CODE UTILIZATION

REGISTER

1. From the Backstage View, select Library from the left pane navigation.
2. From the Ribbon, select the Estimate tab.

3. Under the section Master Breakdown Structures, select Account Code Utilization. The Account
Code Utilization Register opens.
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EXERCISE 9.1 - BENCHMARKING SETUP

Your manager wants you to benchmark costs and man-hours against at least three past projects.
Help set up benchmarking accordingly. Be sure to:
¢ Use Default Account Code Matching Criteria
e Use Default Jobs Filter
e Benchmark Graph Display Options
Hints:
e The “Jobs matching filter criteria” indicates how many jobs it found a match for.

¢ Avalue of “0” means it didn’t find a match and the learner would need to double check their
benchmarking settings.

Congratulations, you have completed this exercise!
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LESSON 9 REVIEW

1. Where do you set up benchmarking matching criteria and display options?
a. Foundation Setup Data
b. Job Properties
C. Cost Breakdown Structure Register
d

. Resource Rate Register

2. How do you make sure benchmarking data is up to date in the CBS Register?
a. Update settings in the Job Properties > Benchmarking tab
b. Select Update Graph on the Cost Item Record
C. Save the job

d. Select Refresh Benchmarks from the More Actions menu in the CBS

3. How can you view the benchmarking graph for a cost item?
a. Select the Benchmarking tab in Job Properties
b. Select the Benchmarking saved view in the CBS register
C. Select the Benchmarking tab on a cost item record
d

. Select the Benchmarking report from the Reports menu

LESSON 9 SUMMARY

As a result of this lesson, you can:

¢ Set up and use benchmarking to compare your job to past projects
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LESSON 10 - CONFORM THE
ESTIMATE

LESSON DURATION: 40 MINUTES
LESSON OBJECTIVES

After completing this lesson, you will be able to:
» Align Estimate data with Platform data in preparation for publishing the estimate
e Conform the estimate to publish successfully
e Publish the estimate to a project in Platform

¢ Review to confirm successful publishing of the estimate

10.1 CONFORM THE ESTIMATE

The project estimate is often used as a starting point for the project budget. The estimate needs to be
conformed in preparation for project execution so there can be effective tracking, forecasting, and
reporting.

When you create a job in InEight Estimate in the cloud, you connect it to a project in InEight Platform.

In Estimate, you can publish the conformed estimate to become the project budget in InEight Control.
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InEight Platform

InEight Estimate InEight Control

Your Estimate Your Budget

To successfully publish the estimate for project execution, you must perform the following:
e Align the Estimate and Platform data.
e Conform the estimate.
¢ Publish the estimate to a project in Platform.
¢ Review the project to confirm successful publishing of the estimate.

For more information, download the following documents from the Integrated Documents page:

Estimate Integration to Cloud Platform and Control for more detailed information about Estimate
integration to Platform.

Prepping Control Budget for Various Interfaces for detailed information about the preparation of a

project budget for implementation in Control.

10.2 ALIGN ESTIMATE AND PLATFORM DATA

You can align the Estimate data with Platform data to prepare the job in Estimate for publishing.
Alignment starts with creating a project in Platform, and then matching your estimate. For more
information about creating a project in Platform, see Project initiation.
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CREATE A PLATFORM PROJECT

1. In Platform > Main menu > All projects & organizations, click the Add project icon to create a
new project.

2. Enter the Project ID and External Project ID.

3. Enter a project name in the Name field. The name does not have to match the ID, or the project
name in Estimate.

4. In Status, select New to execute the Publish Estimate to a New Project status. The budget
becomes initialized when the status is set to New.

5. In Phase, select Execution.

6. Select an organization from the list.

Next, create the estimate (job) in Estimate. You must select the Platform project to associate the
estimate to. Doing this updates the estimate with certain project details, such as notes, and location.

InEight Platform Project InEight Estimate Job

Job Properties ©
Overview | Cover Sheet | CostBasis | Minority Setup | FuelCost | Job Folder Tags | Pricng | Schede | C

Code: 105091 7TA Status: [Biddng | ~| Organization: |¢

Project details

Project ID: |105091 Project Name:  Steel Structure Training Job

L4 Description: [ Steel Structure Training Job

©

o Notes:

After you match the Platform project and the job in Estimate, you must check that the following data
matches between the two applications:

e Currency must match the project base currency for the project in Platform. Make sure the
currency symbol descriptions match in both Estimate and Control. For example, AUS dollars in
Estimate must be AUS dollars in Control.

¢ Units of Measure names must exist in both Estimate and Platform.
e Account Code structure must be finalized to match Platform. Account codes are optional.

¢ Tags and User-defined fields from Estimate need to be configured at the organization or project
level in Platform.

e Cost Categories.

¢ Pay Item related fields.
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The following are key considerations when conforming the estimate:

e Summarizing estimate details into logical work groupings, such as combining costs, quantities,
and work hours for work activities and resources.

¢ Breaking estimate structure into more detail (e.g., to track by area).

¢ Aligning the estimate data with an Account Code Structure.

¢ Conforming major materials from resources to cost items for better tracking.
e Moving, splitting, and combining cost items.

¢ Converting dependent cost items and cost item assemblies into standard cost items and
resources.

¢ Addressing suspended cost items. Suspended cost items do not go over to Control.
e Converting ad-hoc resources to a library resource or a plug value against a cost item.

e Addressing productivity factors by updating in Estimate to reflect the actual budgeted man-hours
that are required for the cost item in Control.

¢ Adding man-hours by creating a labor resource in Estimate or importing man-hours directly to
Control (when necessary).

e Establishing tag values imported from Estimate in Platform at the organization level.
e Configuring key pay item fields to match Control.

For more detailed information about Estimate integration to Platform, see Estimate Integration to
Cloud Platform and Control.

10.2.1 CONVERT DEPENDENT COST ITEM TO PLUG
COST ITEM

You must convert a dependent cost item to plug cost item as part of conforming the estimate. You can
do this in the CBS register of the estimate. For more information about dependent cost items, see
Dependent cost items.

CONVERT DEPENDENT COST ITEM TO PLUG COST ITEM

1. Create a new cost item at the bottom of the CBS, and then enter a description for the dependent
cost item you’re replacing.

2. Select a unit of measure.

3. Open both the dependent cost item and new cost item.
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4. Change the new cost item’s Cost Source to Plug.
5. Review the unit and total values in the dependent cost item’s cost category fields.
6. Copy or enter those values into the same cost category fields of the new cost item’s Plug tab.

o= Make sure contingency is represented on its own cost item. Contingency should not be
directly included in cost items where cost performance is required against budgeted

rates.

10.3 CONFORMING USING OTHER
BREAKDOWN STRUCTURES

It is more efficient to track progress on your projects by organizing your budget in a more consolidated
and potentially different breakdown structure than how the job was estimated. Using account codes,
tag field values, or a work breakdown structure are common ways of viewing the estimate in an
alternate way. Most often one of these alternate views corresponds to the best way to structure the
budget to track the work.

10.3.1 CONFORMING BY ACCOUNT CODES

You can organize your budget by conforming your Estimate CBS structure to match a standard account

code structure.

10.3.2 STEPS

CONFORM YOUR ESTIMATE USING AN ACCOUNT CODE STRUCTURE

1. Open a copy of the job in Estimate job that used for reference.

2. In the CBS register, group by Account Code.

3. Create a new job in Estimate, where items from the original estimate will be copied to.
e Assure that all job properties and settings match the original estimate file.

e Create any initial structure that is needed to organize your cost structure, such as General
Conditions, Direct Labor, Material and Subcontracts.

4. In the job with the grouped account codes, expand the first account code.
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¢ When there is only one cost item, copy and paste it into the applicable location in the

conformance project.

e For account codes with multiple cost items, add a parent cost item to the conformance

project, and then copy and paste the cost items from the original estimate as
subordinates.

DCB00S6-1 - Estimate

Quote Price System Integrations

= print [Aopen 3<cut Do Inde [ spiit +2= Cost Item = Assembly 2 Ve’ W v E CBS Tree Filter Mode:
B Preview ©new oy T Togge Suspended tdent | e Spitby Cost Type f&= subordinate CostItem | = Subordnate Assembly = %5 ” g e -
& BporttoExcel | @) Delete [ Paste ge Cost Items E# Dependent Cost Item CEJ:': 4 L ge': CSFS. :(vee ’
Print Edit Insert View
Cost Breakdown Structure (CBS) Register ©  Cost Item Record Resource Employment Register Cost Item Record
Saved views: | P
Account =
Code o
Account -~ c8s - Desaiplon Account sy Optonal Forecast Unitof R Total Cost
Code Position Code Descripton Ter Code (T/0) Quantity Measure (Forecast)
O Unassigned 21 $81,317,926...
= 1020 (Mobilization) 1 1.00 $12,453.85
- B 0
© 1110 (Clearing and Grubting) 1 10.00 $42,214.43
© 1120.100 (Furn and Haul Base Material) 1 45,000.00 $524,412.32
© 1120.200 (Place Aggregate Base) 2 $114,108.52
© 1122.100 (Excavation) 1 50,000.00 $158,686.22
© 1122200 (Embankment) 1 50,000.00 $91,735.81
1180 (Finegrade Subgrade) 1 400,000.00 $88,540.00
£ 1240.100 (Furnish and Hzul Asphalt Concrete)l 35,000.00 $1,482,144.81
& 1240.200 (Install Asphalt Concrete) 1 35,000.00 $132,493.39
© 1330 (Steel Reinforcement) 2 60,000.00 $44,524.46
© 1340 (Retaining Wall) 6 $0.00
Z 1 = 1.00 3. $12,453.85
96 $86,584,57...
X [Is Terminal] EQUAL True

J{ejg=0 It’s not required to have the account codes in Estimate, but using account codes in
Estimate can help to ensure accurate benchmarking functionality.

10.4 PUBLISH TO PLATFORM PROJECT

When you are ready to publish the estimate, confirm that the project in Platform has the following

settings:
¢ Phase - Execution

e Status - New
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= fat  Steel Structure Training Job | 105091 / Project details

All projects & organizations > Edit project DETAILS INFORMATION ATTRIBUTES

Project details

* Project ID * External project ID @ Notes
105091 105091
+ * Name * Status
Add project image o
Minimum of 5400x x 3600x Steel Structure Training Job New M
*Phase @ * Organization
Execution v C-XYZ A

10.4.1 PUBLISH ESTIMATE TO A NEW PROJECT

To initialize a new control budget, publish the job in Estimate to become the project budget in Control,
click the Publish Estimate to a New Project option in the Integrations tab.

= 101003 - Estimate
File Setup Estimate Quote Price System Developer Tools Integrations ,
o | oF

Publish Estimate § Publish Cost Items Publish Cost Items /
to a Mew Project | to Active Project  for Change Management

InEight Platform / &

&*

When you publish an estimate to a new project, all cost items, pay items, and change orders that may
already exist in the project are removed.

When the integration process is successful, you receive an Import Success email.

10.4.2 PUBLISH COST ITEMS TO AN ACTIVE
PROJECT

After an estimate has been published and progress is being tracked against a budget, it’s not
uncommon for new scope to be added to a project as the work progresses.

You can estimate the cost of this new scope using Estimate, and then publish the newly estimated
costs to a project in execution by using the Publish Cost Items to Active Project option.
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Publish Cost Items
for Change Management

InEighf Platform

Al = Prior to publishing the cost items, change the status of the Platform project to Active.

10.4.3 UNSUCCESSFUL IMPORTS

When there are errors during the import, the import is unsuccessful. An InEight Notification email is
sent to you with a link to view the list of errors. Click the link shown under Summary to view the list of
errors. You can also access the App Logs in Estimate > Integrations > App Logs.

[ Export to excel

Lev.. Time Domain Area Message ExceptionMessage ExceptionType Route Correlationld
Details Error 2024/09/04 12:07:34 PM Core AccountingLedgerAsy. [DEADLETTER] Syntax Syntax error at position 13 in“ineightsuit Microsoft.OData.ODataException 92¢99f07-6¢86-48h6-ad1 c-7d372a76
Details Error 2024/09/04 11:58:43 AM Control SchedulerWorker Sche. Failed to initiate Proce. The added or subtracted value results in ArgumentOutOfRangeException TacT0fde-7267-402d-97c5-d7h5f4219
Details warn 2024/09/04 11:47:12 AM Core DynamicentityRefresh . The Entity Refresh Req cffff563-07b6-4240-88ad-21558a743
Details Warn 2024/09/0411:47:12 AM Core DynamicEntityRefresh..  The Entity Refresh Reg cffff563-07h6-4240-88ad-21552a743...
Details Warn 2024/09/0411-4712 AM Core DynamicEntityRefresh The Entity Refresh Req cffff563-07h6-4a40-88ad-2155aa743
Details Warn 2024/09/0411:47:08 AM Core DynamicEntityRefresh..  Initiating the EntityRefr... cffff563-07b6-4a40-88ad-2155aa743...
Details Warn 2024/09/04 11:47:08 AM Core DynamicEntityRefresh Initiating the EntityRefr. cffff563-07h6-4a40-88ad-21552a743
Details Warn 2024/09/04 11:47:07 AM Core DynamicEntityRefresh..  Initiating the EntityRefr... cffff563-07b6-4340-88ad-2155aa743...
Details Error 2024/09/0411:43:33 AM Control SchedulerWorker Sche. Failed to initiate Proce. The added or subtracted value results in ArgumentOutOfRangeException 087cc3fa-ccbf-4b0f-bbc7-1816cel21f
Details Warn 2024/09/04 11:41:17 AM Core InEight Core Services: Imported 0 of 1 Accou 321ed968-e41e-4dc7-a711-cfh72df7d
Details Warn 2024/09/0411:41:17 AM Core InEight Core Services. Ignoring AccountingLe 321ed968-e41e-4dc7-a711-cfh72df7d
Details Error 2024/09/0411:28:31 AM Control SchedulerWorker Sche. Failed to initiate Proce The added or subtracted value results in ArgumentOutOfiangeException 3141105-426d-4c08-969f-f6799e0b5

Examples of failed import causes are:

e When a resource has more than 11 characters in front of the decimal. Cloud Platform only
accepts 11 numeric character places before the decimal, and 11 numeric character places after
the decimal.

¢ An account code assigned in Estimate that is not in the corporate list in project suite. The full
import might fail because there is nothing to roll up into the account code.

J[el 2 To access the app logs, you must have the DevOps Admin role.

After resolving errors, you can republish the estimate. Republishing the estimate also removes all cost
items, pay items, and change orders that were imported previously.
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10.5 REVIEW PUBLISHED DATA IN CONTROL

After a successful import, you can review the published data in Control. To review the data, go to
Control > Workspaces > Audit Log > Import history. You must manually refresh the import history to
see the newly updated import history data.

REVIEW PUBLISHED DATA IN CONTROL

In your project’s homepage, navigate to Control > Workspaces > Audit Log tab.
Select Import history in the left pane.
Select the Pending status for the newly imported line item.

Select the cost items you want to keep in Control.

a w0 o=

Select Import.

o= You can’t add any cost items in the CBS or activate any syncs during the import
process.

6. Go to the Import history to view the import in process.

An email is sent to you that informs you whether the import succeeds or fails .

LESSON 10 REVIEW

1. Where would you go to review account codes and units of measure in InEight Estimate?
a. Pay Iltem & Proposal Register
b. Price Breakdown Structure
C. Job Properties

d. Foundation Setup Data

2. Which of the following needs to be converted when conforming the estimate?
a. Labor resources

b. Ad-hoc resources
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C. Equipment resources

d. Supply resources

3. What phase does the project in InEight Platform need to be changed to prior to
publishing the estimate?

a. Initiation

b. Construction
C. Pre-execution
d

Execution

LESSON 10 SUMMARY

As a result of this lesson, you can:
¢ Align Estimate data with Platform data in preparation for publishing the estimate
e Conform the Estimate to publish successfully
e Publish the Estimate to a project in Platform

¢ Review to confirm successful publishing of the estimate
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